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INTRODUCTION
1.0 INTRODUCTION

The Curriculum of Technical Education should invariably provide for knowledge, attitudes and skills
required by the technicians /technologists in the country. In this context the laboratory courses form a
vital portion in the entire curriculum of technician education. The laboratory courses shall therefore be
so designed and delivered that they help the students acquire attitudes and motor skills that are
essential to function effectively as technicians/technologists.

The planning, organization and implementation of lab courses need a detailed description of tasks to be
performed by the students. Well thought out instructional objectives to a large extent give these
descriptions. The analysis of tasks (by identifying the activities the students are expected to do) help
prepare the objectives meticulously. In other words the objectives would be clearer, when the task
analysis is done to spell out the sub tasks for each objective.

A survey of the practices currently followed in the technical/technician education shows an urgent need
to plug in gaps in instructional procedures. The reasons for these gaps are ambiguity in the minds of the
teachers regarding tasks to be performed, levels of competency to be achieved by the students and the
weightage to be allocated for each task. This aids in scientific design of instructional plan (optimizing
the resources, budgeting the time & content).

The task analysis, teaching points and the structured scheme of evaluation are very important in
focusing the instruction on specific skill of desired outcome and in evaluating the same. The Instruction
and evaluation in Laboratory courses are different from that of cognitive lessons in the sense that
adequate importance and hence weightage needs to be given for all three domains of learning viz.
cognitive, psychomotor and affective. Since both training and evaluation of traits of affective domain are
practically difficult, a few traits (called values) most relevant and essential to occupations/professions
after the Course may be identified for the purpose. It is imperative to integrate these values during
instruction and evaluation and also overtly notify the same to the students.

A technician, in addition to performing a skill needs to prepare a report of testing that includes the
description of procedure, details of measurements made, reasoning based inferences and so on.,. The
current practice of record writing has failed to achieve this purpose as most of the time students end up
with making copies of available material.

Therefore, for sensitizing the need for the changes in laboratory instruction, the present hand book has
been prepared to meet the above requirements. As such the hand book comprises four parts that
intend to :

e Present task analysis, teaching points which can be used for effective design of instruction

e provide a scheme of evaluation with rationally allocated weightage to each significant skill
component

e offer a set of questions designed at different levels of competencies for assessment enabling the
teacher to set the question paper with balanced levels of competencies

e present pre set worksheets that cultivate the habit of systematic recording of observations and
writing the technical report.

e Provide all important data related to particular laboratory activity at one point in the form of
annexure
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1.1. STRUCTURE OF THE BOOK

The hand book is presented in four parts viz., Laboratory sheets, Worksheet, Experimental Methodology
and Annexure. The description of each part is given in the following sections

Part I. Laboratory Sheet

The information provided in this part is useful for the teacher for designing the instruction,
planning & organization of the experiment and for scientific evaluation of the students. The major
features of the Laboratory sheet are further explained below.

1. Objective

It indicates the Task to be performed and completed by the student during the specified
duration of time.

2. Task Analysis

It is the process of identifying the component activities (sub tasks) to be carried out by the
student in order to achieve the stipulated objective. As the task analysis aim at fitting the
instructional objectives into various classes of behaviour, it would help the teacher to
determine any particular type of behaviour the student has learnt / failed to perform.

The task analysis would help the teacher in identifying the specific activities to be performed
by the students. This could also be used as some kind of check list to compare with activities
planned for the laboratory. Further it would give clue to the teacher to make students think
originally & act independently. It includes both psychomotor learning and the related
cognitive information and hence the task analysis is presented as Knowledge and skill parts.

A. Knowledge Part: That includes the cognitive aspects of the task.
B. Skill Part: That includes Psychomotor & Affective aspects of the task.
3. Teaching Points:

This includes the points based on the SKILL identified with suggested duration for each
point and total duration which helps the teacher for the time and content budgeting during
instruction.

4. Need and Scope:

The purpose, application and scope of the task to be performed are normally included in
this sub section.

5. Planning and Organisation:

It lists actions to be taken to perform various activities and hence useful in planning the
instruction and organizing the resources and equipment

6. Scheme of Valuation:
The information provided in this section helps the teacher to devise a tool for rational

measurement assessment of the competencies accomplished by the student.
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Part Il. Work Sheet

It is designed for the student, where in the student enters his personal data of identification,
details of the experiment, stepwise procedure, observations made during experiment, a sample
calculation, free hand typical graph, graph from experimental data and inference with discussion.

Part lll. Experimental Methodology

This section furnishes information with regard to standard procedure to conduct the experiment
along with the description of equipment/apparatus and the basic theory/concept involved in the
conduct of the experiment. Thus this section is very useful for both teacher and student as well to
conduct the experiment systematically. Thus this section is presented in four sub section as
described below:

» Description

It gives the detailed description of apparatus / tools / equipment / materials to be
used for the task.
» Theory / Concept

It gives the concept of the task to be performed with formulae and units.

> Procedure

It provides the idea of step wise procedure to perform the task.

> Observation and Calculation

It includes sample observation, sample graph, sample calculation for reference
Part IV. Annexure

All important and useful information that may help in accomplishment of tasks like conversion
tables for units, technical & scientific data like material properities, standard trend or
characteristic curves (graphs) etc are compiled and presented at one place in this section.

1.2, WHO IS TO USE AND HOW TO USE.

The hand book is so designed that it can be beneficially used by different sections of the technical
education viz., the teacher, the student, the examiner and the administrator convenient to
individual’s requirements. A few uses of this hand book each stakeholder could make is outlined
in the following sections.

1. Teacher

A. The laboratory sheet is designed keeping the teacher in mind for the teacher has key
responsibility of imparting the skills to the student and hence the information given in the lab
sheets may be useful for planning & organizing the experimental set up and designing an effective
instruction. Thus the teacher may
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Plan and organize as per section 4,

Instruct the students as per section 2,

Demonstrate each sub task as per section1.B.and

Evaluate the students as per section 5, according to the level of competency.

Values: The values in a person are an important personality trait that needs to be nurtured in
the learning environment. Further it is also a driving component in any individual to deliver
the best and hence this component is also included in the evaluation. However only five key
dimensions, that are important in the teaching-learning environment, are taken into
consideration for nurturing and evaluation. A little information about these five dimensions is
given below as a guideline for the teacher while assessing students.

1. Co-operation: It is the voluntary arrangement in which two or more students engage
in a mutually beneficial exchange, instead of competition. Cooperation can happen
where resources adequate for both students exist or are created by their interaction.

2. Co-ordination: It is the unification, integration, synchronization of the effect of group
members so as provide unity of action in the pursuit of common goals. It is an integral
element and required in each & every function and at each & every stage & therefore it
cannot be separated.

3. Communication; Communication skill is the set of skills that enables a student to
convey information so that it is received and understood.

4. Sharing: A part or portion belonging to, distributed to, contributed by, owed by a
person or a group Or To participate in, use, enjoy or experience jointly or in turns.

5. Leadership: Students with the following leadership qualities are almost always the
ones that rise above the crowd.

1. Trustworthiness: This refers to integrity.

2. Inspiration: Guides, leads and inspiring others to want to participate in the
process of moving towards the vision.

3. Self awareness: It is the individual awareness of him or her self — their abilities
and the impact that they have on others.

4. Acceptance of responsibility: True leaders are accepting responsibility for all that
comes their way and taking ownership and responsibilities for getting things back on
track. Blaming, justifying and excuse making just is not in their responsibility.

B. The Experimental methodology is designed for both teacher and student. The teacher can
refer the experimental methodology for the details of equipment/apparatus/ materials/tools,
procedure to be followed, observations to be made, graphs to be drawn and calculations to be
done for the task to be performed
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2. Student

The Worksheet is designed keeping in view the needs, deficiencies and the adolescent
characteristics of the student for student.

The students submit the filled in work sheet given by the teacher on the day of experiment
after referring to experimental methodology and listening to instructions of teacher. The
design of the worksheet is made user friendly and the contents are so logically sequenced that
the student finds it easy to understand and develop the skill of recording and report writing
skill. It also helps the student to actively participate in skill learning. More importantly the
student gets immediate meaningful feedback of his performance since the competency wise
assessment is done and that too on the same day.

3. Examiner

The examiner may find this hand book very useful as Laboratory sheets and Scheme of evaluation
provides information with regard to various competencies (skills) the students is expected to acquire
during the course of study and the relative weightages of each competency. This information helps him
to design a well balance question paper/measurement tool for assessment.
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2.1 LABORATORY SHEEET 2.1 LOGIC GATES
LOGIC GATES
1. OBJECTIVE
To verify the truth tables of AND, OR, NOT NAND, NOR, XOR Gates.
2. APPARATUS

Digital IC trainer kit

ICs 74LS00, 74LS02, 74LS04, 74L.S08, 74LS32, 74L.S86
Breadboard

Connecting wires

el NS =

3. TASK ANALYSIS

A. KNOWLEDGE

Definition of logic gates, Basic gates and Universal gates
IC names and pin configuration of I1Cs

Truth tables of basic gates and universal gates
Applications of logic gates

Precautions

agrwNE

B. SKILL

Category of skill Sub task

¢ Identifying the various ICs

e Identifying the pins of ICs

Handling of Apparatus e Selecting the correct ICs for various
functions

¢ Identifying the connection points on the kit

Trnctinn nf IO vninvlizina annditinn

Making the connections as per the circuit
diagram

Connect the inputs to correct pins of ICs
keeping all the inputs must be low
Checking the connections

Switching on the power supply

Varying the inputs HIGH or LOW as

Manipulation of Apparatus

Applying the proper logic input signals
Observing the outputs for different inputs
e Interpreting the logic levels for output

Precise Activities of operations
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4. TEACHING POINTS

S.NO | TEACHING POINT SUGGESTTED TIME-15min
1 Definition of logic gate, basic and universal gates 2
2 ICs for different logic gates 2
3 Pin configuration of different ICs 2
4 Truth table & logic for all logic gates 4
5 Truth tables of all logic gates 5

5. PRECAUTIONS

ok wnE

6. SCHEME OF EVALUATION

Disconnect all the Equipment from Mains before giving connections
Ensure Correct ICs were chosen.

ICs are to be inserted with great care.
Loose connections should be avoided
Power supply for ICs should be 5V DC.
Switch ON the supply after checking the connections.

CATEGORY | SUB TASK WEIGHTAGE WITH
OF SKILL COMPETENCY LEVEL TOT
INDIVIDUALLY AL
A. ldentifying the various ICs
B. ldentifying the pins of ICs A|B|C|DJE
Handling of C. Selecting the correct ICs 11111 5
Apparatus D. Lcjentifying the connection points on the
it
E. Testina of IC working condition
A. Making the connections as per the
circuit diagram AlB |[C|D|E
Manipulatio B. Connect the inputs to correct pins of 5[5 [2]11]2
n of ICs 15
Apparatus C. Checking the connections
D. Keeping all the inputs low
E. Varvina the inouts HIGH or | OW as
Precise A. Applylng the proper logic input s_|gnals
Activities B. iCr)]giet;vmg the outputs for different A |B C o5
foperations C._Interoret the loaic levels for outout > 10 10
A. Co operation
B. Co-ordination A |B |C |D |E
Values C. Communication 1 |1 11 |1 |1 5
D. Sharing
E. leadership
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7. ASSESSMENT QUESTIONS
1. Draw the logic diagram of NOT gate using NAND gate?(middle order)
2. connect AND gate using universal gates?(middle order)

3.1

dentify the different pins of IC 7400(lower order)

4. Draw the truth table of NOR gate(middle order)

5.

Observe the outputs of OR gate(higher order)

6 .Observe the output for the given circuit(higher order)

8. VIVA QUESTIONS

1.
2.
3.

o

Why the NAND and NOR gates are called as universal gates

What happens when only one input is given to the both the inputs of NAND gate

What happens when one of the input of AND gate is connected to 1 and another input is
connected to the clock

Which gate will have high or 1 at its output when any one of its input is high

How many NOT circuits are contained in IC 74LS04

Write the Boolean expression for NOR gate
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LABSHEET 2.2(a)

REALISATION OF AND,OR and NOT GATES USING 2 INPUT NAND GATES

REALISATION OF AND, OR, NOT and XOR GATES USING 2 INPUT NAND GATES

1. Objective: To implement basic gates using NAND gates and verify their truth tables.

2. Apparatus: IC 7400, Digital logic trainer kit, connecting wires.
3. Task analysis:

A. Knowledge
Basic gates
DeMorgan’s theorem

1.

NoUswN

AND gate and its truth table
OR gate and its truth table.
NOT gate and its truth table

Pin configuration of IC 7400(NAND gate)
Construction of basic gates using IC 7400

B. Skill

Category of Skill Sub task
1. Handling of e ldentifying components
apparatus e Identifying the PINs of ICs
¢ Identifying the connection points on the kit
2. Manipulation of e Testing ICs using digital IC tester
apparatus e Connecting the circuit
e Handling ICs

Precise activities

Feeding the logic signals from the logic input

switches.

Observing the logic outputs on the logic level LED

indicators.

4. Teaching Points:

S. No Teaching Point Time allocation
1 Basic gates
2 DeMorgan’s theorem 5 min
3 AND logic operation
4 OR logic operation 3 min
5 NOT logic operation
6 Pin configuration of IC 7400(NAND gate)
2 min
7 Construction of basic gates using 1C 7400 5 min
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5. Precautions:

o kr~wbdpE

Disconnect all the Equipment from Mains before giving connections
Ensure Correct ICs were chosen.
ICs are to be inserted with great care.
Loose connections should be avoided
Power supply for ICs should be 5V DC.
Before turning ON the power to the trainer review the wiring for errors
Scheme of Evaluation
Category Sub task Weightage with | Total
of Skill Competency level
Individually
1.Handling of A. Identifying components
apparatus B. Identifying the PINs of ICs A |B |[C|T 5
C. Identifying the connection ||2 |2 |1 |5
points on the kit
2.Manipulation of A. Handling ICs
apparatus B. Testing ICs A B |C |T
C. Connecting the circuit 5 |5 [10 |20 20
3.Precise activities A. Applying proper logic input
signals A |B |T
B. Observing logic output and || 10 |10 |20 20
interpreting its logic level.
4.Values A. Co-operation
B. Co-ordination A|/B|C|D|E|T
C. Communication 1{1(1(1|1]|5 5
D. Sharing
E. Leadership

7. Assessment Questions

1.

&

Draw the logic diagram for a two-input NAND gate using one 2-input OR and one NOT

gate. Include the pin numbers on the gate inputs and outputs. (Middle Order)

Build the NAND gate circuit using the 7432 and 7404 ICs on the trainer. Toggle the
inputs by using the Level Switches. (Middle Order)
Draw a circuit to prove Universality of NOR Gate (Middle Order)

Verify the Truth tables to prove Universality of NAND Gate (Higher Order)
Given connected circuit, fill the following tabulations.(Higher Order)

AND

Y=(AB)

= =P

ROk, O|®

OR

Y=(A+B)’

R Rlolo|>
RO~ oOo @
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8. Viva questions

1.

No o s wN

What happens when both the inputs are low for a NAND gate?

How to place the I1C on bread board?

What happens when ground pin and supply pin connections are interchanged?
How do you identify the given IC?

What happens when one of the input pin is left unconnected?

How do you test the 1C whether it is working or not?

What happens if you make the logic switches of inputs in off condition?
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LABORATORY SHEET 2.2(b)

2.2(b) REALIZATION OF AND, OR, NOT USING 2 INPUT NOR GATE

REALIZATION OF AND, OR, NOT, XOR Gates USING 2 INPUT NOR GATE

1. Objectives:

2. Apparatus Required:

o

Digital Logic Trainer
NOR Gate IC 7402
Patch cords

Single Strand wires

3. Task Analysis

A. Knowledge

ok wbdE

IC Number of NOR Gate

Truth tables of AND,OR, NOT Gates
PIN Configuration of NOR Gate IC
Working of NOR Gate

Precautions during Connections

B. Skill

To understand the behavior and demonstrate the operation of the NOR gate
To demonstrate the universality of the NOR gate
To build a combinational logic circuit using all NOR gates

Handling of Apparatus

Identifying NOR Gate IC

Selecting NOR Gates in a Quad NOR IC
Testing IC using Digital IC Tester
Inserting the 1C on Breadboard of Trainer
Selecting the required patch cords & wires

Manipulation of Apparatus

Drawing the Circuit Diagram

Making the Connections as per the circuit diagram
Keeping all the data inputs to low

Switching ON the Power Supply

Varying the inputs to HIGH or LOW as required.

Precise Operations/ Activities

Changing the logic signals from the input switches.
Observing the logic outputs on the LED indicators.
Noting the Logic outputs for corresponding Inputs.
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4. Teaching Points:

SI.No

Teaching Point

Suggested Time — 15 Min

IC Number of NOR Gate

1

Truth Tables of AND, OR,NOT Gates

PIN Configuration of NOR Gate IC

Working of NOR Gate

Breadboard Connections

NININUT|W

(NP W|IN |-

Precautions during Connections

5. Precautions:

ok wnpE

6. Scheme of Evaluation:

Disconnect all the Equipment from Mains before giving connections
Ensure Correct 1Cs were chosen.

ICs are to be inserted with great care.
Loose connections should be avoided
Power supply for ICs should be 5V DC.
Before turning ON the power to the trainer review the wiring for errors.

Category Weightage with | Total
of Skill Sub task Competency level
Individually
A. ldentifying NOR Gate IC
1.Handling of B. Selecting NOR Gates ina Quad NOR IC A|/B|C|D T 5
apparatus C. Testing IC whether it is Good or Bad 1(1(1|1 5
D. Inserting the IC on Breadboard of Trainer
E. Selecting the required patch cords & wires
A. Drawing the Circuit Diagram
2.Manipulation | B. Making the Connections as per circuit A/B |C|D T
of apparatus diagram 51 |11 20 20
C. Keeping all the data inputs to low 0
D. Switching ON the Power Supply
E. Varying the inputs to HIGH or LOW as
required.
3.Precise A. Applying proper logic input signals
operations / B. Observing logic output and interpreting logic || A | B C T
activities level. 5 [10 | 5 | 20 20
C. Noting the Logic outputs for corresponding
Inputs
A. Co-operation
B. Co-ordination A/B|C|D T
4.Values C. Communication 1111 5 5
D. Sharing
E. Leadership
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7. Assessment Questions:

1. Draw the logic diagram for a two-input NOR gate using one 2-input OR and one NOT
gate. Include the pin numbers on the gate inputs and outputs. (Middle Order)

2. Build the NOR gate circuit using the 7432 and 7404 ICs on the trainer. Toggle the inputs
by using the Level Switches. (Middle Order)

3. Draw a circuit to prove Universality of NOR Gate (Middle Order)

Verify the Truth tables to prove Universality of NOR Gate (Higher Order)

5. Construct the following circuit using only NOR Gates (Middle Order)

&

A A+B
A+B
DD
6. Given connected circuit, fill
the following tabulations.(Higher Order)
AND OR

Y=(ABY Y=(A+B)’

= =2p
N =1 =1

==
R OO l@

8. Use the equivalent NOR gate logic to convert the logic diagram below to only contain NOR gates.
Redraw the logic diagram with input/output labels. (Higher Order)

‘ i I
B o f —
7 T40B 7408 l\ =
. & | 2 T
I
7406 7408
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9. Viva Questions:

1. Why do we short the 2 input terminals of NOR while realizing NOT Gate?

2. What do you do, if results during the experiment do not match the theoretical or expected
result?

3. Under what conditions the output of a 2- input AND gate will be one?

4. Can we use AND gate to realize OR Gate?

5. How do we complement the given input?

6. Does the use of 7425 (Dual 4-input NOR gate) in place of 7402 (quad 2-input NOR gate)
IC increase or decrease no of ICs?

7. What happens if a power supply of more than +5V is given to any digital IC

8. Name the device/implement to test a given IC
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2.2c LAB SHEET 2.2c EX-OR GATE USING NAND AND NOR GATES

EX-OR GATE USING NAND AND NOR GATES

OBJECTIVE: To implement the EX-OR gate using NAND and NOR gates.

APPARATUS: 7400 IC, 7402 IC, Digital Trainer kit, Patch cards.

1. TASK ANALYSIS

A. KNOWLEDGE

1. Universal gates
2. Symbols of gates
3. 1C 7400, IC 7402 Pin diagrams
4. EX-OR Gate
5. Truth tables of gates
6. Boolean laws, Demorgan’s theorem
B. SKILLS
Category of skill Sub task
1. Handling of apparatus e Identifying the IC’s
e Identification of pins of IC’s
¢ Identification of components in the trainer
Kit
2. Manipulation of apparatus e Analysing the circuit diagram
e Connecting the circuit inputs and outputs
properly
e Testing of IC’s
3. Precise operations/activities e Give the power supply to the circuit.
e By applying the inputs to the circuit and
observing the output
e Verify the truth tables
e Simplify the expressions
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2. TEACHING POINTS

SINo

Teaching point

Time allocation
(suggestive) 15 min

Functions of NAND and NOR Gates

I

Why NAND and NOR gates are called as universal
gates

Function of EX-OR gate

Truth tables of gates

5 min

Boolean laws

Demorgan’s theorem

Designing EX-OR Gate using NAND Gate

Designing EX-OR Gate using NOR Gate

5 min

® No kAW

Applications of EX-OR Gate

2 min

Make the connections according to the circuit
diagram.

10.

The connections should be tight.

11.

The Vcc and ground should be applied carefully
at the specified pins only.

3 min
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3. SCHEME OF EVALUATION

CATEGORY OF
SKILL

SUBTASK

WEIGHTAGE WITH
COMPETENCY LEVEL
INDIVIDUALLY

MARKS
AWARDED

Handling of
apparatus

Identification of
IC’s

Pin description of
IC’s

Identification of
components in the
trainer Kit.

Manipulation of
apparatus

O w

Drawing the circuit
diagram

Circuit connections
Testing of IC’s

Precise
operations/activities

A. By applying the

inputs to the circuit
and observing the
output

B. Verifying truth

o

tables

Simplify the
expressions
Symbols of gates

. Values

moow>» O

Co operation
Co-Ordination
Communication
Sharing
Leadership

Total

50

4. ASSESSMENT QUESTIONS

Ll A

Perform an exercise to prove NAND & NOR gates are universal gates.
Realize the EX — OR gates using minimum number of NAND gates?

Give the truth table for EX-NOR (EX-OR+NOT) and realize using NAND gates.
Realize the given logic function using NAND gates?

f= AB+AB+AB, verify the result by using IC.
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5. VIVA-VOCE

N e

© N UA W

Does EX-OR gate act as a buffer or inverter? Justify.

What happens if the output by connecting extra NAND gate at the output side of
figl?

How many minimal number of NAND gates are required to design EX-OR Gate.
How many minimal number of NOR gates are required to design EX-OR Gate.

Can you construct EX-OR gate without using NAND and NOR?

What happens to the output by connecting extra NOR gate at the output side of fig2?
What happens to the output when both inputs are short?

What happens to the output when one of the inputs is force to triggered clock signal
with 1hz?
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2.3 LAB SHEET HALF ADDER AND FULL ADDER
HALF ADDER AND FULL ADDER

OBIJECTIVE: To design and construct the half adder, full adder and verify truth table using logic
gates.

APPARATUS:

Digital IC Trainer Board
Patch chords/connecting wires
IC7408

IC7486

IC7432

arwpnE

1. TASK ANALYSIS
A) KNOWLEDGE:
1) Combinational circuits
2) Half adder and Full adder
3) Truth table for both combinational circuits
4) Understanding of K-Maps
5) Details of 1C7408, IC7486, and IC7432

B) SKILL:
Category of Skill Sub Task
. e ldentifying the components required.
Handling of o Identifying the pins of IC7408,1C7486 and IC 7432
apparatus

e Identifying the input and output sections on the board.

e Reading and understanding the circuit diagram.
Manipulation of e Selecting channel on IC for connecting circuit.

apparatus e Selecting appropriate inputs on the board to verify truth table.
e Selecting appropriate outputs on the board to verify truth table.
e Drawing the circuit diagrams neatly.

Precise e Drawing the truth tables for Half adder and Full adder.
Operations/ e By changing the inputs to get all possible outputs.
Activities e Observing truth table for all cases.
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2. TEACHING POINTS:

Sl. Teaching boint Time allocation
No ep (15 mins Suggestive)
1 Half adder )
6 mins
2 Full adder
3 K-map 4 mins
4 Details of ICs )
B 5 mins
5 Precautions

A. PRECAUTIONS:
e Disconnect all the equipment from mains before making connections.
e Connect the circuit as per circuit diagram.

e Loose connections should be avoided.

e Get the connections checked by the concerned staff member.

e Give required supply voltage to the circuit.

3.

4. PLANNING AND ORGANISATION:

NEED AND SCOPE OF EXPERIMENT
e This experiment helps to understand the designing of Half adder and Full
adder using EX-OR, AND & OR Logic Gates.
e It also helps to know the addition of two bits by Half adder and addition of

three bits by Full adder.

ACTION

ACTIVITY

Check for

e Working of ICs

e Loose Connections if any

e Functioning of Input switches and
output logical Indicators

e Student entry behavior

For Design of Instruction

e Half adder and Full adder circuits
must be known
e Details of ICs must be known
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5. SCHEME OF EVALUATION:

WEIHTAGE WITH TOTAL
Category of Skill SUB TASK COMPETENCY LEVEL (50)
INDIVIDUALLY
. A) ldentification of correct components.
L aHan::;?SSof B) Identification of input & output A B T 5
P sections. 3 2 5
. . A) Placement of components A|B C T
2. g/lar;:f)aliLa;tlon of B) Circuit connections. 55| 10 | 20 20
P C) Output Observations.
i e . A B T
3. gl;)e::;iions A) ldentification of logic gates. 0 1 10 1 20 20
Activities B) Verifying truth table.
A) Co-operation
B) Co-ordination AlB|C|DE
4. Values C) Communication 11|11 (1]|5 5
D) Sharing
E) Leadership

6. ASSESSMENT QUESTIONS:

1. Identify the pins of IC 7408, IC 7486, IC 7432(Lower).

2. ldentify the input and output sections on the kit(Lower).

3. Identify the Supply and Ground on the Kit (Lower).

4. Draw Full adder circuit diagram with two half adder circuits(Medium)?

5. Is it possible to design Full adder circuit with alternative 1Cs(Medium)?

6. How do you know the final result is correct (Higher)?

7. How can you get the result in the form of waveforms(Higher)?

8. How can you fix the the problem of erratic result if any(higher)?

7. VIVA QUESTIONS:

1. What happens if ground of IC is not connected?

2. What happens if supply voltage applied to IC is more than the rated voltage?

3. Suggest an alternative ICs for Half adder and Full adder?

4. What happens if clock signal is applied as one of the inputs for EX-OR Gate in
Half adder?

5. What happens if two adjacent wires are short circuited when giving connections
on bread board?

6. How can you design 4 bit adder with the same 1Cs that you used in Full Adder?

7. What happens if one broken wire was used during connecting the circuit
diagram?

8. If AB and C are the inputs of Full adder, then what would be its sum?

9. If A,B and C are the inputs of Full adder, then what would be its carry?

10. What happens to the output of Full adder when one of the three inputs is inverted

?
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2.4 LABORATORY SHEET

2.4 4-Bit MAGNITUDE COMPARATOR

4-BIT MAGNITUDE COMPARATOR

2.7.1 OBJECTIVE: To verify the function of 4 bit magnitude comparator(IC 7485)

2.7.2 APPARATUS: 1.Comparator IC 7485

2. IC trainer kit
3. Patch cards

2.7.3 TASK ANALYSIS:

A) KNOWLEDGE :
1. Whatisanl.C

2. What is a comparator
3. WhatisM.S.B&L.S.B

4. Explain single bit comparator operation

B) SKILL:

CATEGORY OF SKILL

SUBTASK

1. HANDLING OF
APPARATUS

Identify the IC 7485 and major parts in the kit. (Like
LEDs, Switches, Power supply)

e Identify the test points in the kit
2. MANIPULATION e Connect pin 16 to supply and pin 8 to ground
OF APPARATUS e Connect the inputs and outputs as per the pin diagram
e Connect the cascade input (A<B) and (A>B) to ground
e Connect the cascade input (A=B) to Vcc
3. PRECISE e Check the connections
OPERTAIONS/ e Switch on the supply
ACTIVITIES e Apply different input combinations

Interpreting the results with truth table

2.7.4 TEACHING POINTS:

S.No TEACHING POINT TIME ALLOCATION
1 Function of comparator 3 Min.
2 Truth table of 7485 IC 5 Min
3 IC pin diagram Explanation 5 Min
4 Precautions 2 Min

2.7.5 PRECAUTIONS:

1. Ensure that pin 16 connected to supply (5V)
2. Ensure pin 8 connected to ground

3. Avoid loose connections
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2.7.6 SCHEME OF EVALUATION:

CATEGORY OF SUB TASK WEIGHTAGE WITH TOTAL(50)
SKILL COMPETENCY LEVEL
INDIVIDUALLY
A. Identify the IC 7485 and major 5
1.HANDLING OF parts in the kit. (Like LEDs, A 5 T
APPARATUS Switches, Power supply)
B. Identify the test points in the 3 2 >
Kit
A. Connect pin 16 to supply and 20

pin 8 to ground
B. Connect the inputs and outputs || A | B | C | D | T
2.MANIPULATIO as per the pin diagram 4 | 416|620
N OF APPARATUS C. Connect the cascade input
(A<B) and (A>B) to ground
Connect the cascade input
(A=B) to Vcc

o

Check the connections 20
3.PRECISE Switch on the supply
OPERTAIONS/ACT Apply different input A|B|C|D|T
IVITIES combinations 2 |2| 6 |10]20
Interpreting the results with
truth table

Ow>

©

cooperation 5
coordination
communication 5
sharing

leadership

4 Values

moow>

2.7.7 ASSESSMENT QUESTIONS:

Identify the major sections in trainer board and record the IC Nos., (Lower order)
Make connections as per circuit diagram of IC 7485 (Middle order)

Give the necessity of cascading inputs & pin diagrams of 7485 IC. (Higher order)
Verify the truth table of IC7485 (Higher order)

Check the voltage levels of Trainer kit (Higher order)

ok wbdPE

2.7.8 VIVA QUESTIONS:
1. What happens if the cascade inputs are not connected to supply or to the ground
2. What do you do if the IC 7485 is not working properly
3. What happens if the ground is not connected properly
4. How do you test the IC 7485
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2.5 LAB SHEET

Objective

Apparatus Required

Task Analysis

A) Knowledge:

MULTIPLEXER

MULTIPLEXER

: To verify truth table of Multiplexer using IC 74153

: a) Digital Trainer Board,

b) Patch chords,

c) IC 74153

6) Multiplexing
7) Truthtable of 4:1 MUX
8) Details of IC 74153

B) Skill :
Category of Skill Sub Task
. e |dentifying the components required.
Handling of . .
e |dentifying the pins of IC74153.
apparatus

e |dentifying the select, input and output sections on the board.

Manipulation of
apparatus

e Reading the circuit diagram.
e Selecting channel (A or B) on IC for connecting circuit.

e Selecting appropriate input and select lines to verify truth table.

Precise Operations
Activities

e Varying select lines to get all possible outputs.
e Observing the outputs.
e Observing all cases of truth table.

C) Teaching points:

Sl. Teaching boint Time allocation
No ep (15 mins Suggestive)
1 Multiplexing definition 5 mins
2 4:1 MUX Truth Table 5 mins
3 Details of IC 74153 )
- 5 mins
4 Precautions
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D) Scheme of Evaluation:

Weightage with
Category of Skill Sub Task Competency Level TOTAL
Individually (50)
1. Handling of C) Identification of correct components.
apparatus D) Identification of select, input & A B T 5
output sections. 3 2 5
2. Manipulation of D) Circuit connections. A|B | T
apparatus E) Equipment handling. 10 | 5 | 15 15
3. Precise C) Varying Select lines & Enable inputs. A B C T
Operations D) Output Observations 10| 10| 5 |25 25
Activities E) Verifying truth table.
F) Co Operation
G) Co- Ordination A|B|IC|D|E|T
4. Values L
H) Communication 11111011115 5
1) Sharing
J) Leadership

E) Assessment Questions:

1. Identify various sections in the trainer board. (Lower order)

2. Make connections as per the circuit diagram. (Middle order)

3. Verify the output for any one of the cases in accordance with the truth table. (Higher
order)

4. What happens at the output (Zg) if we give data lines to A channel and enable pin low
in IC74153.

5. What happens if selection line pins (S1 and Sp) are connected in opposite direction?

F) Viva Questions:

Why is MUX called as “Data Selector”? (Middle order)
What do you mean by Multiplexing? ( Lower order)
What is Digital Multiplexer? ( Lower order)
What is the function of Enable input to any IC? ( Lower order)
How many 4:1 MUX are available on IC74153? ( Lower order)
How many select lines are necessary for a 16:1 MUX? (Middle order)
What are the applications of Multiplexers? (Middle order)
How many 4:1 MUX are required to make 16:1 MUX? ( Higher order)
What is the Boolean expression for a 2:1 MUX when S is a select line and A0 and Al
are input lines? ( Middle order)
. To perform Multiplexing enable pin should be connected to logic-0, Why is it so? (
Higher order)

© oo N O~ wdPE

[EEN
o
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2.6 LAB SHEET

BCD TO 7 SEGMENT DECODER 7448 IC

BCD TO SEVEN SEGMENT DECODER USING IC 7448

OBIJECTIVE: To verify the truth table of BCD to Seven Segment Decoder.

APPARATUS: i)IC 7448,

ii) Seven Segment Display,
iii) IK Resistor,

iv) Digital trainer kit,

v) Power supply,

vi) Connecting wires.

1. TASK ANALYSIS:

A. KNOWLEDGE
1. 1C 7448 pin diagram.
2. The idea of seven segment display
3. Truth table of Decoder and seven segment display.
4. Working of LED.

B. SKILL

CATEGORY OF SKILL SUB TASK

1. Handling of e Connecting of Input /Output pins of IC 7448
apparatus e Connecting of IC 7448to seven segment display

through connecting wires
e Power supply connections and GND connections

2. Manipulation of e By applying different BCD inputs, the seven
apparatus segment display is observed

3. Precise e The seven segment display outputs are noted
operations/Activities according to the decoder inputs.

2. TEACHING POINTS:

S. No Teaching Point Time allocation
1 Pin Diagram of IC 7448 3 min
2 Decoder outputs 2 min
3 Seven Segment Display 4 min
4 Circuit Diagram Connection 4 min
5 Precautions 2 min

3. PRECAUTIONS: 1.Circuit diagram is connected without loose connections.
2. Power supply is switched-off while connecting the circuit

diagram.

3. Do not Power ON for long time as ICs may get damaged.
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4. SCHEME OF EVALUATION

CATEGORY SUB TASK WEIGHTAGE TOTA
OF SKILL WITH L
COMPETENCY 50M
LEVEL
INDIVIDUALLY
1.Handling of a) ldentification of components
apparatus b) ldentification of correct circuit A |B |C 5
c) Selecting proper wires 2 |2 |1
2.Manipulation of | @) Placing the components
apparatus b) Circuit connections A |B
5 |10 15
3.Precise activities | @) Identification of pin no of IC’s
b) Application of inputs 25
c) Observation of outputs A |[BC|D
d) Tabulation of Input/output values |10 |5/ 5 |5
4.Values a) Co-operation
b) Co-ordination
¢) Communication '16‘ lB f lD 5
d) Sharing
e) Leadership

5. ASSESMENT QUESTIONS:

1. Identify various sections in the trainer board. (Lower order)

2. Make connection as per circuit diagram. (Middle order)

3. Verify the output by replacing 7448 with another IC. (Higher order).

4. Conduct the necessary exercise and state diodes in seven segment display are ON, when

display 7 is shown as output? (Middle order)

Common Cathode

a f Gnd a
1 [1 [1 Il

o
O
- |
I b
q

i

& C
d
s 3 | @
—
] Iaj 1 0
5] Gnd < ddp
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5. Write the output by observing the LEDs (Lower order)

b C d e f g

OUT PUT

OFF

ON ON OFF OFF ON ON

?

6. Show the power PIN in IC7448. ( Lower order).

5. VIVA QUESTIONS

1.

2.

How do you test IC is working or not?

Why do we place current limiting resistors?

. How does the decoder works?

. Function of seven segment display?

. Identification of IC pins and their function?
. Applications of seven segment display?

. Different colors of LEDs and their purpose?
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2.7a LABORATORY SHEET 2.7a1C74138 DECODER
VERIFY THE TRUTH TABLE OF IC74138 DECODER
1. Objective: To Verify the Truth table of IC 74138 Decoder
2. Apparatus: 1C 74138
Digital Trainer Kit with Bread board
Patch card
Power supply
3. Task Analysis:
A. Knowledge:
1. Study of Bread board
2.3 To 8 Decoder
3. Need of Enable Input
4. Pin Diagram of IC 74138

5. Pin Description of IC 74138

B. Skills:

Categories of skills Sub task
Handling of A. Identifying the components in the trainer kit
Apparatus B. Identifying the Pin configuration of IC
Manipulation of A. Drawing the logic circuit
Apparatus B. Connecting the logic circuit

C. Appling the Enable inputs
Precise operations A. Applying Inputs and Observe outputs
/Activities B. Verify the truth table
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4. Teaching Points:

Time allocation

S. No Teaching pOint (Suggestive) 15 min
Decoder
1
Types of decoder
2 » 3 min
3 Enable inputs
Pin diagram
) 5 min
5 Pin description
6 Truth table
Identify the different sections in trainer Kit
Power supply
7 | Ground _
Input logic levels 4 min
Output logic (LED’s)
8 | Applications of decoder
Precautions to be taken while during the 3 min

Experiment

Precautions:

1. Ensure that IC 74138 Pin 14 connected to power supply.
2. Ensure that IC 74138 Pin 7 connected to ground.

3. Make connections in proper way.

4. Connect the circuit as per circuit diagram.
5. Loose connections should be avoided.

6. Get the connections checked by the concerned staff member.
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5. Scheme of Evaluation:

Weightage with
) Marks
Category of skill Sub task computency level
C g Awarded
individuly
A. Identification of IC’s A B T
Handling of Apparatus B. Identification of components in 2 3 5
the kit
Manipulation of A. Drawmg'loglt': CIFFUIt A B C T
Apparatus B. Connecting circuit 3 10 |2 15
C. Appling enable input
e [Ny [ E Lo o
operations/activities B. Checking the enable inputs.
A. Co operation
B. Co-ordination A|B|C|D|E|T
C. Communication 1 (1|11 ]1|5
Values .
D. Sharing
E. Leadership
Total 50

6. Assessment Questions:

1. Identify various pins in IC 74138? (Low order)

2. ldentify major section in Trainer kit? (Low order)

3. Draw the logic diagram of 74138 IC? (Middle order)

4. Give the Enable input G is low and Gza, Gasare X, X then by changing inputs what the outputs
is? (Middle order)

G1 | Goa | Gas | A B C |Yo | Y1 Y, Y3 A\ Ys Ye Y7

0O | X [X | X |[X [X [? [? |? [ A A s
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5. Given a readily made circuit to verify truth table of IC 74138 Decoder? (Higher order)

DMWVI7TAaSAL S138
DATA OUTPUITS

Al = ™~ R ~ = v = <3 s v
Loae 1= | i == 1-= |-~ | 2o =

> T Srer>
OUIT PuT

G1 | Goa | G | A B C |Yo | Y1 Y, Y3 Ys Ys Ye Y;

6. Design a De multiplexer circuit by using IC 741387 (Higher order)

7. Design a 3 to 8 Decoder, by change IC 74138 to IC 741567 (Higher order)

7. Viva Question:

1. What happens the Enable input G is low and G2a,G2s are X,X then by changing inputs what is
the outputs?

2. Suggest the IC 74138 used for De multiplexer what are the connections?

3. What happens the Enable input G1is high and G2a, Gzs are low then by changing inputs what
is the outputs?

4. What happen in 3 to 8 decoder IC 74138 changes to IC 741567
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2.7b LAB SHEET 2.7b ENCODER USING IC 74148
Function of Encoder Using IC 74148

Objective: To verify the function of Encoder using IC 74148 with truth table
Apparatus: IC 74148, Digital Trainer kit, Bread board, Patch cords, power supply

1. Task Analysis
A.KNOWLEDGE

1. Study of Bread board

2. Encoder

3. Need of enable input

4. Pin diagram of IC 74148

5. Pin description of IC 74148
6. Truth table of encoder

B.SKILLS
Category of skill Sub task
Handling of apparatus e ldentification of the IC
e Identification of components in the trainer kit
Manipulation of apparatus e Placement of components on breadboard
e Circuit connections
e Testing of IC
Precise e |dentifying the pin numbers of IC
operations/activities e Verify the truth tables
e Observing different logic states

2. Teaching Points

SI No Teaching point Time allocation
(suggestive) 15 min

Encoder

Types of encoder 3 min

Enable inputs

Pin diagram

Pin description 5 min

Truth table

oV ke IRIWwWINIE

Identify the different sections in trainer kit
Power supply

Ground

Input logic levels 4 min
Output logic (LED’s)

9. Applications of encoder

10. Precautions to be taken while during the
experiment 3 min
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A. Procedural Precautions:

1. Ensure that pin 14 connected to supply.

2. Ensure that pin 7 connected to ground.

3. All connections should be made properly.

4. IC should not be reversed.

B. Safety precautions:

1. Power supply should not exceed 5V.

2. Never work on a circuit while power is applied.

3. Always keep your work area dry.

3. Need and Scope of Experiment

1. This experiment helps to understand the process of encoding.

2. Encoders are used to translate mechanical motion into a digital signal.

4. Scheme of Evaluation

CATEGORY OF
SKILL

SUBTASK

WEIGHTAGE WITH
COMPETENCY LEVEL
INDIVIDUALLY

MARKS
AWARDED

1. Handling of apparatus

A. Identification of IC
74148

B. Identification of
components in the trainer Kit.

2. Manipulation of
apparatus

A. Placement of Components
B. Circuit connections
C. Testing of IC

20

3. Precise
operations/activities

A. ldentifying pin numbers of
IC’s

B. Verifying truth tables

C. Observing different logic
states

20

4. VValues

A. Co operation

B. Co-Ordination
C. Communication
D. Sharing

E. Leadership

Total : 50

50
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6. Assessment Questions

o s~ wbh e

7.V

©COoN kR WNE

Identify the major sections in a digital trainer Kit.
Make the connections as per the circuit diagram.
Verify the truth tables of encoder.

Identify the pin no. of enable inputs in the IC 74148.
Draw the logic circuit of 4*2 binary encoder.

va - Voce

What is the purpose of notch on IC?
How many pins are there in IC 741487
What is the difference between encoder and decoder?
What happens if the enable pin is HIGH in IC 74148?
What is the purpose of GS pin in 1C74148?
How many inputs are there for a 2™*n encoder?
How many 4 * 2 encoders will be required to design a 8 * 3 encoder?
What are the applications of encoder?
If n=1, n=2, n=3 how many inputs and outputs for encoder?
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2.8a LAB SHEET 2.8a Clocked RS Flip Flop using NAND gates

Construct clocked RS FF using NAND gates and Verify its truth table

1. OBJECTIVE: Design and construct a clocked RS flip flop using NAND gates and
Verify its Truth table.

2. APPARATUS: 7400 IC, Digital Trainer Kit, Patch cards

3. TASK ANALYSIS
A.KNOWLEDGE

1. Latches ,NAND latch

2. Flip flops, Types of flip flops
3. RS Flip flop and its truth table
4. Need of clock

5. 1C 7400 Pin diagram

B.SKILLS
Category of skill Sub task
1. Handling of e Identifying the IC’s
apparatus e Identifying pin numbers of IC’s
e |dentification of components in the trainer kit
2. Manipulation of e Analysing the circuit diagram
apparatus e Connecting the circuit inputs and outputs properly
e Testing of IC’s
3. Precise'z o e Give power supply to the circuit
operations/activities e By applying the inputs to the circuit and observing the
output
e Verify the truth tables
e Observing different states

4. TEACHING POINTS

. . Time allocation
SI No Teaching point (suggestive) 15 min

1. Latches and its types _
5min

2. Flip flops and its types

3. Difference between latch and flip flop

4, RS Flip flop 5 min

5. Truth table of RS Flip flop

6. Need of clock
2 min

7. Applications of flip flops

9 Make the connection s according to the circuit

) diagram.
10. The connections should be tight. 3 min
11 The Vcc and ground should be applied carefully at
) the specified pins only
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5. SCHEME OF EVALUATION

CATEGORY OF
SKILL

SUBTASK

WEIGHTAGE WITH
COMPETENCY LEVEL
INDIVIDUALLY

MARKS
AWARDED

1. Handling of

apparatus G.

Identification of
IC’s

Identifying pin
numbers of IC’s
Identification of
components in the
trainer Kit.

2. Manipulation of
apparatus H.

Placement of
components
Circuit connections
Testing of IC’s

3. Precise l.
operations/activities

. By giving clock to

the circuit from
pulsar.

By applying inputs
to the circuit and
observe the outputs
Verifying truth
tables

Observing different
states

4. Values

ozgrx

Co operation
Co-Ordination

. Communication

Sharing
Leadership

Total

50

6. ASSESSMENT QUESTIONS

1. Identify major sections on the Digital trainer Kit.

2. Draw the pin configuration of IC 74007?

3. Perform an exercise to find out the output for SR clocked flip flop if the values for

S=0 and R=1, are given.

4. Perform an exercise to find out the output for SR clocked flip flop negative edge

triggered clock of 1 H; is given to the circuit?
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7.VIVA - VOCE

N o oA W N

What happens if a D Flip flop or inverter is placed at input of SR flip flop?
What happens when two AND gates are augmented with clocked SR flip flop?
How can we call a SR flip flop as a memory device?

What happens if both S and R are given 1 as input?

When RS flip-flop is said to be in a RESET state?

What happens when different frequency clock signal is given to a flip flop?

What may be the applications of flip flops?
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2.8b LAB SHEET JK FLIP FLOP
JK FLIP FLOP USING IC 7476

1. Objective  : To implement J K flip flop using 7476 and verify their truth tables.
2. Apparatus : IC 7476, Digital logic trainer kit, connecting wires.

3. Task analysis:
A. Knowledge
1. Truth table
2. Clock signal
3. J-K Flip flop and its truth table.
4. Pin configuration of IC 7476(J-K Flip Flop)

B. Skill:
Category of Skill Sub task
1. Handling of o Ident!fy!ng comp_onents
apparatus e ldentifying the pins of ICs
e Identifying the connection points on the kit
2. Manipulation of e Testing I_Cs using dlg_ltal IC tester
apparatus e Connecting the circuit
e Handling ICs
e Feeding the logic signals from the logic input
3. Precise activities switches.
' e Observing the logic outputs on the logic level LED
indicators.
4. Teaching Points:
S. No Teaching Point Time allocation
1 Truth table 5 min
2 Clock signal
3 J-K Flip flop and its truth table 10 min
4 Pin configuration of IC 7476(J-K Flip Flop)
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5. Scheme of Evaluation

Category Sub task Weightage  with | Total
of Skill Competency level
Individually
1.Handling  of A. ldentifying components
apparatus B. ldentifying the pins of ICs A B |[C|T 5
C. lIdentifying the connection||2 |2 |1 |5
points on the kit
2.Manipulation A. Handling ICs
of apparatus B. Testing ICs A |BI|C |T
C. Connecting the circuit 5 [5 |10 |20 20
3.Precise A. Applying proper logic input
activities signals A |B |T
B. Observing logic output and || 10 |10 |20 20
interpreting its logic level.
4.Values A. Co-operation
B. Co-ordination A|/B|C|DIE|T
C. Communication 1]1]1]1]1]5 g
D. Sharing
E. Leadership
50
TOTAL

6. Assessment Questions:

1. Identify various sections in the trainer board. (Lower order)

2. Make connections as per the circuit diagram. (Middle order)
3. Verify the output for any one of the cases in accordance with the truth table. (Higher

order)

7. Viva questions

. How can we differentiate latch and flip-flop

. Where the flip-flops do are used.

. How do we know the level triggering and edge triggering in flip-flops.

. Which type of edge triggering is used in IC 7476 J-K Flip-flop?

1
2
3
4. How can we identify whether it is +ve edge and -ve edge triggering.
5
6

. What happens when we give preset and clear inputs to the flip-flop and why are these

Called asynchronous Inputs.

7. How can we identify toggle and write its significance

8. Where the D-FF’s are used and why it is called a delay flip flop

9. Why JK FF is called as the universal flip flop.
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2.8c LAB SHEET D AND T FLIP FLOPS
D and T flip flops using IC 7476

1. Objective: To implement D and T flip flops using 7476 and verify their truth tables.
2. Apparatus: IC 7404, IC 7476, Digital logic trainer kit, connecting wires.
3. Task analysis:

A. Knowledge
1. Truth table
2. Clock signal
3. NOT gate and its truth table
4. J-K Flip flop and its truth table.
5. D Flip flop and its truth table.
6. T Flip flop and its truth table.
7. Pin configuration of IC 7404(NOT gate)
8. Pin configuration of IC 7476(J-K Flip Flop)
9. Conversion of JK Flip flop into D Flip flop
10. Conversion of JK Flip flop into T Flip flop
B. Skill
Category of Skill Sub task
1. Handling of e |dentifying components
apparatus e ldentifying the pins of ICs

Identifying the connection points on the kit

Testing 1Cs using digital IC tester

Connecting the circuit

Handling ICs

Feeding the logic signals from the logic input
switches.

e Observing the logic outputs on the logic level LED
indicators.

2. Manipulation of
apparatus

3. Precise activities

4. Teaching Points:

92
Z
o

Teaching Point Time allocation

Truth table
Clock signal

NOT gate and its truth table S min

J-K Flip flop and its truth table
D Flip flop and its truth table
T Flip flop and its truth table 5 min
Pin configuration of IC 7404(NOT gate)
Pin configuration of IC 7476(J-K Flip Flop)
Conversion of JK Flip flop into T Flip flop 5 min

olo|wlolo|ln w|l Nkl

[EEN
o

Conversion of JK Flip flop into D Flip flop
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4. Scheme of Evaluation

Category Sub task Weightage with | Total
of Skill Competency level
Individually
1.Handling of A. ldentifying components
apparatus B. Identifying the pinS of ICs A B C T 5
C. Identifying the connection||2 [2 |1 |5
points on the kit
2.Manipulation A. Handling ICs
of apparatus B. Testing ICs A B |C T
C. Connecting the circuit 5 |5 (10 |20 20
3.Precise A. Applying proper logic input
activities signals A |B |T
B. Observing logic output and || 10 |10 |20 20
interpreting its logic level.
4.Values A. Co-operation
B. Co-ordination A|B|C|D|E|T
C. Communication 1{1(1(1|1]|5 5
D. Sharing
E. Leadership
50
TOTAL

6. Assessment Questions:

1. Identify various sections in the trainer board. (Lower order)
2. Make connections as per the circuit diagram. (Middle order)

3. Verify the output for any one of the cases in accordance with the truth table. (Higher

order)

4. What is the purpose of dual JK flip flop 1C7476.

7. Viva questions

1. How can we differentiate latch and flip-flop.

o a0k~ e

Where the flip-flops do are used.

these Called asynchronous Inputs.

© N

How can we identify toggle state and write its significance.

Which type of edge triggering is used in IC 7476 J-K Flip-flop?

Where the D-FF’s are used and why it is called a delay flip flop.

How do we know the level triggering and edge triggering in flip-flops.

How can we identify whether it is +ve edge and -ve edge triggering.

What happens when we give preset and clear inputs to the flip-flop and why are
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2.9 LABORATORY SHEET

RIPPLE COUNTER USING JK FLIP FLOP

2.9 RIPPLE COUNTER

OBJECTIVE : Construct a ripple counter using JK flip flop and Obtain its timing waveforms.

APPARATUS: 1.74761C--- 2 no.

2. Digital Trainer Kit with Bread Board

3. Connecting wires

TASK ANALYSIS:

A. KNOWLEDGE

1. Pin description of 7476 IC

2. Truth table of JK flip flop

3. Logic diagram of ripple counter

4. Operation of ripple counter

5. Truth table of ripple counter

6. Precautions

B. SKILL

CATEGORY OF SKILL

SUB TASK

Handling of Apparatus A. ldentifying the components in the trainer kit
B. ldentifying the Pin configuration of IC
C. Checking the IC
Manupulation of A. Drawing the Logic circuit
Apparatus B. Connecting the Logic circuit
C. Applying the clock pulse
Precise A. Observing the output after applying each pulse
B.

operations/Activities

Obtain the timing waveforms

2. TEACHING POINTS

S.no | Teaching point Suggest time 15 min.
1 Truth table of J K flip flop 3
2 Working of Ripple counter 5
3 Truth table of Ripple counter 3
4 Obtain the waveform 3
5 precautions 1

A. Procedural Precautions:

Disconnect all the equipment from mains before making connections.
Connect the circuit as per logic circuit
Avoid the loose connections

Get the required supply voltage to the circuit
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3. Need and Scope of Experiment:

This experiment helps to understand construction and operation of ripple counter by using

JK flip flop

4. SCHEME OF EVALUATION

CATEGORY OF SKILL SUB TASK

WEIGHTAGE WITH
COMPETENCY LEVEL
INDIVIDUALLY

TOTAL
MARKS

AWARDED

Handling of Apparatus A. ldentifying the
components in the
trainer kit

B. Identifying the Pin
configuration of IC

C. Checking the IC

Manupulation of A. Drawing the Logic circuit
Apparatus B. Connecting the Logic
circuit

C. Applying the clock pulse

10

1 15

Precise A. Observing the output
operations/Activities after applying each pulse
B. Obtain the timing
waveforms

10

15

25

A. Co operation

B. Co-Ordination
Values C. Communication
D. Sharing

E. Leadership

TOTAL

50

ASSESSMENT QUESTIONS:

wn e

(higher order question)

Identifying the components in the trainer kit. (lower order question)
What is the IC used for ripple counter ? (lower order question)
Connect the logic circuit and get the output 1110 by applying pulse input.

4. Connect the logic circuit for decade counter by using 7476 IC and AND GATE.

(higher order question)

5. Construct the Ripple counter by using 7476 IC.(higher order question)

Obtain the wave forms of ripple counter for —ve edge triggering. (middle order gquestion)
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VIVA QUESTIONS:

P owbhE

Why JK flipflop is used in ripple counter application, why not SR flipflop ?
Why do you apply logic 1 to J K inputs

What happened to the counter if you give preset input is low.

What happened to the counter if you give clear input is low.
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LABORATORY SHEET 2.10

1. Objectives:

2.10 Decade Counter

DECADE COUNTER

1. To verify the function of 7490 as decade and modulus counter.

2. To obtain timing waveforms.

2. Apparatus Required:

Digital Logic Trainer
Decade Counter IC 7490
Breadboard

Patch cords

Single Strand wires

gk whE

3. Task Analysis

A. Knowledge

arwdE

B. Skill

IC Number of Decade counter

PIN Configuration of Decade counter
Truth tables of Decade counter
Working of Decade counter

. Precautions during Connections

Handling of Apparatus

Identifying Decade Counter IC
Identifying the pins of ICs

Testing IC using Digital IC Tester
Inserting the 1C on Breadboard of Trainer
Selecting the required patch cords & wires

Manipulation of Apparatus

Drawing the Circuit Diagram

Making the Connections as per the circuit diagram
keeping all the data inputs to low

Switching ON the Power Supply

Varying the inputs to HIGH or LOW as required.

Precise Operations/ Activities

Changing the logic signals from the input switches.
Observing the logic outputs on the LED indicators.
Noting the Logic outputs for corresponding Inputs.
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4. Teaching Points:

SI.No

Teaching Point Suggested Time — 15 Min

IC Numbers of Decade Counter 1

Count Truth table of Decade Counter

PIN Configuration of Decade Counter

Working of Decade Counter

Breadboard Connections

NININUT|W

(NP W|IN |-

Precautions during Connections

5. Precautions:

ok wnE

Disconnect all the Equipment from Mains before giving connections
Ensure Correct 1C was chosen.

IC has to be inserted with great care.

Loose connections should be avoided

Power supply for ICs should be 5V DC.

Switch ON the supply after checking the connections.

6. Scheme of Evaluation:

Category Weightage with | Tota
of Skill Sub task Competency level |
Individually
A. Identifying Decade Counter IC
1.Handling of B. Identifying the pins of ICs A|B|C|D T 5
apparatus C. Testing IC whether it is Good or Bad 1(1(1|1 5
D. Inserting the IC on Breadboard of Trainer
E. Selecting the required patch cords & wires
A. Drawing the Circuit Diagram
2.Manipulation | B. Making the Connections as per circuit A/B |C|D T
of apparatus diagram 51 |1]1 20 20
C. Keeping all the data inputs to low 0
D. Switching ON the Power Supply
E. Varying the inputs to HIGH or LOW as
required.
3.Precise A.  Applying proper logic input signals
operations / B. Observing logic output and interpreting logic [|A |B |C | T
activities level 511 |5 |2 20
C. Noting the Logic outputs for corresponding 0 0
Inputs
A. Co-operation
B. Co-ordination A|/B|C|D T
4.Values C. Communication 1111 5 5
D. Sharing
E. Leadership
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7. Assessment Questions:

1. Construct mod-5 counter using decade counter IC 7490.(higher order)
2. Construct mod-2 counter using decade counter 1C 7490.(higher order)
3. Verify the functioning of 1C 7490 as decade counter. (higher order)
4. Observe the timing waveforms of IC 7490.(higher order)

5. Draw the truth table of IC 7490 as decade counter.(middle order)

6. ldentify different pins of IC 7490. (lower order)

8. Viva Questions:

1. How many flipflops are required to construct a decade counter?

2. How can a MOD-16 ripple counter be modified into a decade counter? Can you show it
with diagram?

3. What are some devices/applications that uses decade counters?

4. Distinguish between synchronous and asynchronous decade counters.

5. How many different states does a decade counter have?
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2.11 LABORATORY SHEET UP/DOWN COUNTER

UP/DOWN COUNTER
OBJECTIVE: To verify the function of UP/DOWN counter using IC 74190/74193.

APPARATUS:

e Digital Trainer Board

e Patch chords

e |C 74190/74193

e Connecting wires(Optional)
TASK ANALYSIS

A) KNOWLEDE:
1) Clock pulse
2) Counter operation
3) Different types of Counters
4) Modulus of a counter
B) SKILL

Category of Skill Sub Task

e ldentifying the components required.
e ldentifying the pins of IC 74190/ IC 74193.

Handling of apparatus
9 PP ¢ Identifying the clock pulse, input and output sections on

the board.
e Reading the circuit diagram.
Manipulation of e Selecting up/down and modulus of counter.
apparatus e Supplying clock pulses.

e Observing the outputs.

e Supplying clock pulses and observing counter stages.

e Changing the mode and observing the counting
procedure.

e Changing the modulus and observing the counting
procedure.

Precise Operations
Activities

TEACHING POINTS:

: . Time allocation
I No-- | Teaching point (15 mins Suggestive)
1 Clock Pulse 2 mins
2 Counter Operation _
5 mins
3 Types of counters
4 Modulus _
5 mins
5 UP/DOWN mode
6 Precautions 3 mins
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SCHEME OF EVALUATION:

WEIHTAGE WITH TOTA
Category of Skill SUB TASK COMPETENCY LEVEL L
INDIVIDUALLY (50)
A) ldentification of correct
1. Handling of comp_o_nen_ts. A B T 5
apparatus B) Identification of control,
. . 2 3 5
clock, input & output sections.
2. Manipulation of A PI_achg the components A|B| C T
apbaratus B) Circuit connections. G 0 1 20 20
PP C) Output Observations.
3. Precise A) Obserylng outputs after mode
Operations changing. Al B T 20
p_ . B) Observing outputs after 10 | 10 | 20
Activities .
modulus changing.
A) Co Operation
B) Co- Ordlr_1at|c_>n AlBlcloD T
4. Values C) Communication 5 5
D) Sharing 1 1 1 1 1
E) Leadership
ASSESSMENT QUESTIONS:

1 Identify various sections in the trainer board. (Lower order)
2 Make connections as per the circuit diagram. (Middle order)
3 Verify the counting procedure in appropriate (UP or DOWN) mode. (Higher order)

VIVA QUESTIONS:
1. What is the difference between decade counter and 4 bit counter?
2. What is meant by a modulus of a counter?
3. How many Flip Flops are necessary to design a counter with mod-12?
4. Differentiate between synchronous and asynchronous counter?
5.  When two counters are cascaded, what is the overall MOD number?
6. How many different states does a 3-bit asynchronous counter have?
7. What is the terminal count of a 3-bit binary counter in the DOWN mode?
8. What does UP/DOWN means?
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2.12 LAB SHEET 2.12 SHIFT REGISTER

SHIFT REGISTER
OBIJECTIVE: To verify the function of shift register (ICs like 7495, 74194).
APPARATUS: IC 7495, Digital trainer kit, Patch cards, Power supply.

1. TASK ANALYSIS:

A. KNOWLEDGE
1) 1C 7495 pin diagram.
2) Truth table of IC 7495.

B. SKILL
Category of Skill Sub task
1. Handling of e ldentifying the input and output pins of IC 7495
apparatus e Identifying the power supply (Vcc) and GND
connections.
e Drawing the circuit diagram.
2. Manipulation of e Making the connections as per circuit.
apparatus e Connection of Input/output pins of IC 7495 for different
modes (SISO, SIPO, PISO and PIPO).
e Checking the connections.
e Switch on the supply.
3. Precise operations / e Applying the data inputs, control inputs and observing
Activities the shifting operation.

2. TEACHING POINTS

S. No Teaching Point Time allocation
1 Pin Diagram of IC 7495 5 min
2 Configuration of IC for different shifting modes. 10 min

3. PRECAUTIONS:

1. Circuit diagram is connected without loose connections.
2. Power supply is switched-off while connecting the circuit diagram
3. Do not Power ON for long time as ICs may get damaged.
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4. SCHEME OF EVALUATION:

Category Sub task Weightage with Total
of Skill Competency level
Individually
1.Handling of A. Identifying the input and output
apparatus pins of IC 7495 A T 5
B. Identifying the power supply 3 5
(Vcc) and GND connections.
2.Manipulation A. Placing the components on
of apparatus breadboard A | B T 20
B. Read IC pin diagram 8 |10 20
C. Observations
3.Precise A. 1C connections for different
activities and modes(SISO,SIPO,PISO,PIPO) A T
operations of shift register 12 20 20
B. Tabulation of values of truth table
A. Co-operation
B. Co-ordination
4.Values C. Communication '16‘ f D E 5
D. Sharing
E. Leadership

5. ASSESSMENT QUESTIONS:

M owbdE

(PIPO) mode (Higher Level)
5. Given the pin diagram of IC 7495, connect the IC 7495 in Parallel In Serial Out
(P1SO) mode (Higher Level)
6. Draw the PIN diagram of IC 7495, connect the IC 7495 in Serial In Parallel Out
(SIPO) mode (Higher Level)

7. Draw the PIN diagram of IC 7495, connect the IC 7495 in Serial In Serial Out (SISO)

mode (Higher Level)

6. VIVA QUESTIONS

Identify the serial, parallel input and output pins of IC 7495 (Lower level)

Draw the PIN diagram of IC 7495 shift register (Middle level)

Draw the truth table of shift register (Middle level)

Given the pin diagram of IC 7495, connect the IC 7495 in Parallel In Parallel Out

1. How many clock pulses are needed to serially shift a nibble (four bits) of data into a

shift register?

2. How many clock cycles are needed in order to have first output in SISO
3. How many clock cycles are needed in order to have all the outputs after feeding the

inputs?

4. Mention the IC Numbers used for Shift Register

SBTET-AP




LABORATORY SHEET 2.13(b) 2.13(b) SIMULATION OF AND, OR, NOT and EXOR USING NOR GATE

SIMULATION OF AND, OR, NOT USING 2 INPUT NOR GATE

1. Objectives:

1. Tosimulate AND, OR, NOT and EXOR Gates using NOR Gates
2. To verify the truth tables of AND, OR,NOT and EXOR Gates

2. Apparatus Required:

1. Personal Computer with Windows OS
2. ORCAD PSPICE 9.2 software package.

3. Task Analysis

A. Knowledge

1. 1C Numbers of NOR Gate

2. Truth tables of AND,OR, NOT and EXOR Gates
3. PIN Configuration of NOR Gate IC

4. Working of NOR Gate

B. Skill

Handling of Apparatus

Knowing how to invoke ORCAD Pspice
application S/W

Opening a new project

Selecting proper project for digital simulation
Naming the project and finding the location to save
the project

Adding the required libraries to simulate the project

Manipulation of Apparatus

O w

. Creating the new simulation profile to the project

Adding the required parts, input and output ports to
the work space

Wiring the circuit as per the circuit diagram

Apply Pspice stimulus to all input ports as the truth
table

Precise Operations/ Activities

COw

Running the project and adding input and output
traces to the simulation graph

Observing the output waveforms

Interpreting the simulation results with truth tables
Repeating same simulation with selection of proper
time periods and ON time of inputs such that the
output is clearly understood
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4. Teaching Points:

SI. No

Teaching Point

Suggested Time — 15 Min

IC Numbers of NOR Gate

1

Truth Tables of AND, OR,NOT Gates

PIN Configuration of NOR Gate IC

Working of NOR Gate

Working with ORCAD Pspice

AN W|IN|(E

Precautions during virtual wiring to avoid
overlapping

NININIUT|W

5. Precautions:
Disconnect all the Equipment from Mains before giving connections

Ensure Correct ICs were chosen.

Input ports should be properly selected
Overlapping virtual wiring should be avoided
Traces should be properly selected

1.

ok~ own

6. Scheme of Evaluation:

Category
of Skill

Sub task

Weightage with

Competency level

Individually

Total

1.Handling of
apparatus

>

O 0w

Knowing how to invoke ORCAD Pspice
application S/W

Opening a new project

Selecting  proper project for digital
simulation

Naming the project and finding the location
to save the project

Adding the required libraries to simulate the
project

B|C

D

E|T

[EEN

1|1

1

1|5

2.Manipulation
of apparatus

Adding the required parts, input and output
ports to the work space

Wiring the circuit as per the circuit diagram
Apply Pspice stimulus to all input ports as
the truth table

Creating the new simulation profile to the
project

20

20

3.Precise
operations /
activities

O w

Running the project and adding input and
output traces to the simulation graph
Observing the output waveforms

Interpreting the simulation results with truth
tables

Repeating same simulation with selection of
proper time periods and ON time of inputs
such that the output is clearly understood

o>

20

4 Values

moow2>

Co-operation
Co-ordination
Communication
Sharing
Leadership

[EEN
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7. Viva Questions:

[

. Why do we short the 2 input terminals of NOR while realizing NOT Gate?
. What do you do, if results during the experiment do not match the theoretical or expected
result?

N

3. Under what conditions the output of a 2- input AND gate will be one?

4. Can we use AND gate to realize OR Gate? If Can’t, why?

5. How do we complement the given input?

6. Does the use of 7425 (Dual 4-input NOR gate) in place of 7402 (quad 2-input NOR gate)
IC increase or decrease no of ICs?

7. What happens if a power supply of more than +5V is given to any digital IC

8. Name the device/implement to test a given IC
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2.14 LAB SHEET

HALF ADDER AND FULL ADDER SIMULATION USING PSPICE

HALF ADDER AND FULL ADDER

OBIJECTIVE: To design and construct the half adder, full adder and verify truth table using

ORCAD Pspice 9.2 software package.

APPARATUS: 1. Personal Computer.

2. OS of Winows 07/XP/10.

3. ORCAD Pspice 9.2 software package.

1. TASK ANALYSIS

A) KNOWLEDGE:
1) Combinational circuits.
2) Half adder and Full adder.
3) Truth table for both combinational circuits.
4) Understanding of K-Maps.
5) Details of 1C7408, 1C7486, and IC7432.

B) SKILL:
Category of Skill Sub Task
A. Knowing how to invoke ORCAD Pspice application S/IW
] B. Opening project and saving the project in appropriate location.
Handling of C. Selecting proper project for digital simulation.
Software D. Adding the relevant libraries to simulate the project
A. Adding the required parts,input and output ports in the workspace.
. . B. Wiring the circuit as per the circuit diagram.
Manipulation of | ¢ ,stomising the label names of all the inputs and ouputs of logic
Software gates.
D. Creating the new simulation profile to the project
A. Running the project and adding input and output traces to the
Precise simulation graph
Operations/ B. Observing the output waveforms
Ap_ . C. Interpreting the simulation results with truth tables
ctivities D. Repeating same simulation with selection of proper time periods

and ON time of inputs such that the output is clearly understood
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3. TEACHING POINTS:

Sl. Teaching boint Time allocation
No ep (15 mins Suggestive)
1 | Half adder )
6 mins
2 | Full adder
3 K-map 4 mins
4 | Details of ICs .
- 5 mins
5 | ORCAD Pspice software package

4. PRECAUTIONS:

e Install the software by following the instructions carefully.
e Get the installation checked by the concerned staff member.

5. NEED AND SCOPE OF EXPERIMENT
e This experiment helps to understand the designing and implementation of Half
adder and Full adder using ORCAD Pspice 9.2 software package.
e It also helps to know the addition of two bits by Half adder and addition of
three bits by Full adder.

6. PLANNING AND ORGANISATION:

ACTION ACTIVITY

Check for e Working of ORCAD Pspice
software package.

e Working of Windows OS.

e Functioning of Input switches and
output logical Indicators

e Student entry behavior

For Design of Instruction e Half adder and Full adder circuits
must be known.
e ORCAD Pspice must be known.
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5. SCHEME OF EVALUATION:

Category of Skill

SUB TASK

WEIHTAGE WITH
COMPETENCY LEVEL
INDIVIDUALLY

TOTAL
(50)

1. Handling of
Software

Knowing how to invoke ORCAD
Pspice application S/W

Opening project and saving the
project in appropriate location.
Selecting proper project for digital
simulation.

Adding the relevant libraries to
simulate the project

N

2. Manipulation of
Software

Adding the required parts,input and
output ports in the workspace.
Wiring the circuit as per the circuit
diagram.

Customising the label names of all
the inputs and ouputs of logic gates.

. Creating the new simulation profile

to the project

20

20

3. Precise Operations
Activities

Running the project and adding input
and output traces to the simulation
graph

Observing the output waveforms
Interpreting the simulation results
with truth tables

Repeating same simulation with
selection of proper time periods and
ON time of inputs such that the
output is clearly understood

20

20

4. Values

moow>>

Co-operation
Co-ordination
Communication
Sharing
Leadership

A. ASSESSMENT QUESTIONS:

O wnN B

gates?(Medium)

(o3}

a signal? (Higher)

8. How can you perform simulation of the designed circuits using ORCAD

Pspice?(Higher)

. How can you edit the logic diagram when it is required ?(Medium)
7. How can you apply clock signals and how can you set Time period & On time for

. Identify Menu Bar and various tabs under it when software is opened.(Lower)
. How do you create a project and save it in appropriate location?(Lower)
. Identify the various symbols which are used to design circuit(Lower)

. Draw Full adder circuit diagram with two half adder circuits?(Medium)
. How can you customise label names for all the inputs/outputs of logic
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B. VIVA QUESTIONS:

1. Where do you see the output waveforms?

2. What happens if the run to time is less than the largest time period ?

3. What do you do if the required library files are not available in the given software
2

4. What happens if you don’t add library files ?

5. What happens if you don’t add traces ?

6. What would happen if input traces are added but ouput traces are not added ?
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LABORATORY SHEET 2.15

2.15 SIMULATION OF MULTIPLEXER

SIMULATION OF MULTIPLEXER USING PSPICE

1. Objectives:

1. To simulate Multiplexer Using PSPICE
2. To verify the truth table Multiplexer

2. Apparatus Required:

1. Personal Computer with Windows OS
2. ORCAD PSPICE 9.2 software package.

3. Task Analysis
A. Knowledge

IC Number of Multiplexer
Truth table of Multiplexer
PIN Configuration of 1C74153
Working of Multiplexer

o

B. Skill

Handling of Software

Knowing how to invoke ORCAD Pspice
application S/W

Opening a new project

Selecting proper project for digital simulation
Naming the project and finding the location to save
the project

Adding the required libraries to simulate the project

Manipulation of Software

. Wiring the circuit as per the circuit diagram

. Creating the new simulation profile to the project

Adding the required parts, input and output ports to
the work space

Apply PSPICE stimulus to all input ports as the
truth table

Precise Operations/ Activities

UOow

. Repeating same simulation with selection of proper

Running the project and adding input and output
traces to the simulation graph

Observing the output waveforms

Interpreting the simulation results with truth tables

time periods and ON time of inputs such that the
output is clearly understood
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4. Teaching Points:

SI.No Teaching Point

Suggested Time — 15 Min

IC Number of Multiplexer

1

Truth Table of Multiplexer

PIN Configuration of IC74153

Working of Multiplexer

Working with ORCAD PSPICE

AN W|IN|F

Precautions during virtual wiring to avoid
overlapping

NINIUTIN|W

5. Precautions:

1. Disconnect all the Equipment from Mains before giving connections

Ensure Correct ICs were chosen.

Input ports should be properly selected
Overlapping virtual wiring should be avoided
Traces should be properly selected

arown

6. Scheme of Evaluation:

Category Weightage with | Total
of Skill Sub task Competency level
Individually
A. Knowing how to invoke ORCAD Pspice
1.Handling of application S/W A|lB|C E 5
apparatus B. Opening a new project 1111 1
C. Selecting proper project for digital
simulation
D. Naming the project and finding the location
to save the project
E. Adding the required libraries to simulate the
project
A. Adding the required parts, input and output
2.Manipulation ports to the work space A|lB|C T
of apparatus B. Wiring the circuit as per the circuit diagram 555 20 20
C. Apply Pspice stimulus to all input ports as
the truth table
D. Creating the new simulation profile to the
project
3.Precise A. Running the project and adding input and
operations / output traces to the simulation graph A|lB|C T
activities B. Observing the output waveforms 5|55 20 20
C. Interpreting the simulation results with truth
tables
D. Repeating same simulation with selection of
proper time periods and ON time of inputs
such that the output is clearly understood
A. Co-operation
B. Co-ordination A|B|C E
4.Values C. Communication 11101 1 5
D. Sharing
E. Leadership
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7. Assessment Questions:

1. List two advantages of Pspice simulation of Digital electronics circuits?(Lower Order)
2. Between Clock period and ON time generally which is higher?(Middle Order)
3. For what Purpose we use Add Trace in PSPICE Simulation? (Higher Order)

8. Viva Questions
1. How Many 4:1 Multiplexers available in IC74153?(Lower order)
2. How many select lines are necessary for a 16:1 MUX? (Middle order)

3. How many 8:1 MUX are required to make 32:1 MUX? ( Higher order)
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3.1 WORK SHEET

3.1 LOGIC GATES

WORK SHEET
Name of the student: Date of experiment:
PIN: Branch:
Institution: Experiment No:

1. Title of the Experiment:

2. Objective of the Experiment:

3. Equipment Required:

4. Circuit Diagram:
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5. Procedure

6. Results

NAND gate

S.NO AINPUT | BINPUT | OUTPUT
1 0 0

2 0 1

3 1 0

4 1 1

AND gate

S.NO AINPUT | BINPUT | OUTPUT
1 0 0

2 0 1

3 1 0

4 1 1

NOT gate

S.NO | AINPUT | OUTPUT

1 0

2 1

7. Inference and Interpretation:

NOR gate
S.NO AINPUT | BINPUT | OUTPUT
1 0 1
2 0 1
3 1 0
4 1 1

OR gate

S.NO A INPUT | BINPUT | OUTPUT

1 0 0

2 0 1

3 1 0

4 1 1
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8. Scheme of Evaluation:

Category of Skill Sub task Weightage with Total
Competency level
Individually
A. Identifying the various ICs
B. Identifying the pins of ICs 5
1.Handling of C. Selecting the correct ICs
apparatus for _va(ious functions _ _
D. Identifying the connection points
on the kit
E. Testing of IC working condition
A. Making the connections as per the
circuit diagram
2.Manipulation of B. Connect the inputs to correct pins 15
apparatus of ICS_ .
C. Checking the connections
D. Keeping all the inputs low
E. Varying the inputs HIGH or LOW
as required
3.Precise A. Applying the proper logic input
activities/operations signals _
B. Observing the outputs for different
inputs 55
C. Interpret the logic levels for output
corresponding Inputs
A. Co-operation
B. Co-ordination
4. Values C. Communication
D. Sharing 5
E. Leadership
Total | 50
Signature of the Staff Signature of the Student
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WORK SHEET 3.2(a) REALISATION OF AND,OR and NOT GATES USING 2 INPUT NAND GATES

WORK SHEET
Name of the student: Date of experiment:
PIN: Branch:
Institution: Experiment No:

1. Title of the Experiment:

2. Objective of the Experiment:
3. Equipment Required:

4. Circuit diagram:

5. Procedure:
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6. Truth table:

AND Gate:
S. No Switch 1 Switch 2 LED Status Interpretation of Readings in terms of
condition condition (For | (For Output) logic values
(For A input) B input) A B Y
input input Output
1 OFF OFF Doesn’t Glow
2 OFF ON Doesn’t Glow
3 ON OFF Doesn’t Glow
4 ON ON Glow
OR Gate:
S.No Switch 1 Switch 2 LED Status Interpretation of Readings in terms of
condition condition (For | (For Output) logic values
(For A input) B input) A B Y
input input Output
1 OFF OFF Doesn’t Glow
2 OFF ON Glow
3 ON OFF Glow
4 ON ON Glow
AND Gate:
S.No Switch 1 LED Status | Interpretation of
condition (For Output) | Readings in terms of
(For A input) logic values
A Y
input Output
1 OFF Glow
2 ON Doesn’t Glow
7. Results:

8. Discussion on Results (Mandatory):
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9. Scheme of Evaluation:

Category Sub task Weightage with | Total
of Skill Competency level
Individually
1.Handling of A. ldentifying components
apparatus B. Identifying the PINs of ICs
C. Identifying the connection points 5
on the kit
2.Manipulation of A. Handling ICs
apparatus B. Testing ICs
C. Connecting the circuit 20
3.Precise A. Applying proper logic input
activities signals
B. Observing logic output and 20
interpreting its logic level.
4. Values A. Co-operation
B. Co-ordination
C. Communication 5
D. Sharing
E. Leadership
Total
50
Signature of the staff Signature of the Student
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3.2(b) WORKSHEET 3.2(b) REALIZATION OF AND, OR, NOT USING 2 INPUT NOR GATE

WORK SHEET

Name of the student:

PIN: Branch:

Date of experiment:

Institution:

Experiment No:

1. Title of the Experiment:

2. Objective of the Experiment:

3. Equipment Required:

4. Circuit Diagram:
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5. Procedure

6. Readings:
AND Gate
S.No A input B input Y Output
1 0
2 1
3 0
4 1
OR Gate
S.No A input B input Y Output
1 0
2 1
3 1 1
4 1
NOT GATE
SL.NO A Input Y output
1 0
2 0
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7. Inference and Interpretation:

8. Scheme of Evaluation:

Category of Weightage with
SKill Sub task Compgt(_ancy level Total
Individually
A. Identifying NOR Gate IC
B. Selecting NOR Gates ina Quad NOR IC 5
1.Handling of C. Testing IC using IC Tester
apparatus D. Inserting the IC on Breadboard of Trainer
E. Selecting the required patch cords & wires
A. Drawing the Circuit Diagram
B. Making the Connections as per circuit
2.Manipulation diagram 20
of apparatus C. Keeping all the data inputs to low
D. Switching ON the Power Supply
E. Varying the inputs to HIGH or LOW as
required.
3.Precise A. Applying proper logic input signals
activities B. Observing logic output and interpreting
logic level. 20
C. Noting the Logic outputs for
corresponding Inputs
A. Co-operation
B. Co-ordination
4.Values C. Communication 5
D. Sharing
E. Leadership
Total 55
Signature of the Staff Signature of the Student
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3.2(c) WORK SHEET

EX-OR GATE USING NAND AND NOR GATES

Name of the student:

Date of experiment:

PIN:

Branch:

Institution:

1. Title of the experiment:

EX-OR gate using NAND and NOR GATES

2. Objective of the experiment: To implement the EX-OR gate using NAND and NOR

Gates.

3. Equipment required: 7400 IC, 7402 IC, Digital trainer Kit, patch cards

4. Front pa

A

nel/circuit diagram/block diagram:

A
B

((AB)'B)’

4 ): AeB

Fig:1 EX-OR GATE USING NAND GATES

:D_-(;HB}*

(A+{A+B)"Y

AOGB

(B+{A+B)")

Fig:2 EX-OR GATE USING NOR GATES
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Pin diagrams:

NOR 7400 IC: Truth table:
'I"'L,L,
14] [13] [rz] [n] [oe] [o] []
g g A B Y=AB
) 0 0 1
0 1 1
1 0 1
1 1 1 0
GND
NOR 7402 IC: Truth table:

A [ [

== 00
= ORO
(=Ri=RE=R1

LG BB

Fig:3 Pin Diagram of 1IC7400 & 1C7402

5. Procedure:

1.

©ooNo MWD

Take the digital trainer kit and insert the 7400IC at appropriate position on bread
board.

Connect pin 14 to v¢c and pin 7 to ground.

Connect the circuit diagram as shown in figure.

Switch on the trainer Kit.

Apply various input combinations and observe output for each one.

Verify the truth table of EX-OR gate.

Insert the 7402 IC at appropriate position.

Connect pin 14 to v¢c and pin 7 to ground.

Connect the circuit diagram as shown in figure.

10 Switch on the trainer Kit.
11. Apply various input combinations and observe output for each one.
12. Verify the truth table of EX-OR gate.

6. Results:

SBTET-AP




7. Discussion on result:

8. Scheme of evaluation:

CATEGORY OF
SKILL

SUBTASK

WEIGHTAGE WITH MARKS
COMPETENCY LEVEL AWARDED
INDIVIDUALLY

1. Handling of apparatus

Identification of
IC’s

Identification of pins
of IC’s

Identification of
components in the
trainer Kit.

2. Manipulation of
apparatus

w >

Circuit connections
Handling of
apparatus

Testing of IC’s

20

3. Precise
operations/activities

>0

O

By applying inputs
to the circuit and
observe the outputs.
Verifying truth
tables

Simplify the
expressions

20

4. Values

moow>

Co operation
Co-Ordination
Communication
Sharing
Leadership

Total

50

Signature of the staff

Signature of the student
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3.3 WORK SHEET HALF ADDER AND FULL ADDER

WORK SHEET
1. Title of the Experiment:
2. Objective of the experiment:
Name of the student: Date of experiment:
PIN: ’ Branch:
Institution: Experiment No:
3. Equipment:

4. Circuit diagrams:

HALF ADDER:

FULL ADDER:
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5. Procedure:

6. Truth table:

Half adder
Input Output
A B Sum Carry
Full adder
Input Output
A B C Sum Carry

7. Inference & Interpretation:
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8 .Scheme of evaluation:

WEIHTAGE WITH TOTAL
Category of Skill SUB TASK COMPETENCY LEVEL (50)
INDIVIDUALLY
. A) Identification of correct components.
L aHan::;?SSof B) Identification of select, input & output 5
PP sections.
. . A) Circuit connections.
2. gélznlp:::&c;n B) Equipment handling.
P C) Output Observations. 20
3 gl;)e:::liions A) Varying Select lines & Enable inputs.
Activities B) Verifying truth table. 20
A) Co Operation
B) Co- Ordination
4. Values C) Communication 5
D) Sharing
E) Leadership
Total 50
Signature of the staff Signature of the student

SBTET-AP




3.4 WORK SHEET

WORK SHEET

3.4 4-Bit MAGNITUDE COMPARATOR

Name of the student :

Date of experiment:

PIN : ‘ Branch:

Institution:

Experiment No:

3.22.1 TITLE OF THE EXPERIMENT:

3.22.2 OBJECTIVE OF THE EXPERIMENT:

3.22.3 EQUIPMENT REQUIRED:

3.22.4 CIRCUIT DIAGRAM:

SBTET-AP




3.22.5 PROCEDURE:

3.22.6 OBSERVATIONS:

3.22.7 RESULT:

3.22.8 DISCUSSION ON RESULT:
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3.22.9 SCHEME OF EVALUATION:

Category
of Skill

Sub task

Weightage with
Competency
level Individually

Total

1. HANDLING OF A.
APPARATUS

Knowing how to invoke
ORCAD Pspice application S/W
Opening a new project
Selecting proper project for
digital simulation

. Naming the project and finding

the location to save the
project

Adding the required libraries to
simulate the project

2. MANIPULATIO
N OF
APPARATUS B

Adding the required parts,
input and output ports to the
work space

. Wiring the circuit as per the

circuit diagram
Apply Pspice stimulus to all
input ports as the truth table

. Creating the new simulation

profile to the project

20

3. PRECISE A.
OPERTAIONS/
ACTIVITIES

Running the project and
adding input and output traces
to the simulation graph
Observing the output
waveforms

Interpreting the simulation
results with truth tables
Repeating same simulation
with selection of proper time
periods and ON time of inputs
such that the output is clearly
understood

20

4. VALUES

mooOw>

Co-operation
Co-ordination
Communication
Sharing
Leadership

TOTAL

50

Signature of staff

Signature of student
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3.5 WORK SHEET

MULTIPLEXER

WORK SHEET
Name of the student: Date:
PIN: Branch: ECE
Institution: Experiment No:08
1. Title of the Experiment Multiplexer

2. Objective of the Experiment : To verify truth table of Multiplexer using IC 74153

3. Equipment Required

: Digital Trainer Board,
Patch chords,

IC 74153

4. Block Diagram/ Circuit Diagram:

5. Procedure:

6. Truth Table:

Enable

Data Input Lines

Selection
Lines

Output

0A I 1A

I2A

3A

Sy So
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7. Inference and Interpretation:

8. Scheme of Evaluation:

Weightage with Marks
Category of Skill Sub Task Competency Level awarded
Individually

A) ldentification of correct
1. Handling of components.
apparatus B) Identification of select, 5

input & output sections.
. . A) Circuit connections.

2. Manipulation of B) Equipment handling. 15
apparatus

A) Varying Select lines &
3. Precise Operations Enable inputs. ”
Activities B) Output Observations

C) Verifying truth table.

A) Co Operation

B) Co- Ordination
4. Values C) Communication 5

D) Sharing

E) Leadership

Total
50
Signature of the Staff Signature of the Student
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3.6 WORK SHEET BCD TO 7 SEGMENT DECODER7448 IC

BCD TO SEVEN SEGMENT DECODER USING IC 7448

DATE:
NAME OF THE STUDENT:

PIN: BRANCH: DECE

EXPERIMENT NO: 09

POLYTECHNIC NAME:

1. TITLE OF EXPERIMENT: BCD to Seven Segment Decoder
2. OBJECTIVE OF THE EXPERIMENT: To verify the truth table of BCD to Seven Segment
Decoder.

3. EQUIPMENT REQUIRED: i) IC 7448,
ii) Seven Segment Display,
iii) IK Resistor,
iv) Digital trainer kit,
v) Power supply,
vi) Connecting wires.

4.1C 7448 DIAGRAM:

QUTPUTS

||2|| ||4|| LAMP DUT IN "8" ||1|| L
TEST

INPUTS
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5. CIRCUIT DIAGRAM:
|

10 ™48
BV Peseg

5. PROCEDURE:

1. Connect 5V and ground to their indicated position on digital trainer kit.

2. Connect BCD inputs A, B, C, D to the pin of IC 74LS48 as shown in logic diagram

3. Connect +5V to Pins 3, 4, 5 of IC 74L548.

4. Connect pins 13-a, 12-b, 11-c, 10-d, 9-e, 15-f, 14-g of common anode display

respectively.

5. Switch on the power supply.

6. Observe decimal output on common anode display given on the experiment board.

6. TRUTH TABLE:

BCD INPUTS

SEGMENT OUTPUTS

A B C D a b

C

d

e

DISPLAY

7. RESULTS: The truth table of BCD to Seven Segment Display is verified.
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8. DISCUSSION ON RESULTS: IC7448 is a common anode open collector decoder and IC 7448 is
common collector decoder

8. SCHEME OF EVALUATION

CATEGORY SUB TASK WEIGHTAGE MARKS
OF SKILL WITH AWARDED
COMPETENCY
LEVEL
INDIVIDUALLY
1.HANDLING OF a) ldentification of components
APPARATUS
5
a) Circuit connections
2.MANIPULATION | b) Equipment handling
OF APPARATUS 15
3.PRECISE a) Identification of pin no of IC’s
ACTIVITIES b) Application of inputs
c) Observation of outputs
d) Tabulation of Input/output values 25
4.VALUES a) Co-operation
b) Co-ordination
¢) Communication 5
d) Sharing
e) Leadership
Total : 50
SIGNATURE OF THE STUDENT SIGNATURE OF THE STAFF

SBTET-AP




3.7(a) Work Sheet

IC 74138 Decoder

WORK SHEET
Name of the Student: Date of Experiment:
PIN : Branch:
Experiment No:
Institution :

1. Title of the Experiment

2. Objective of the Experiment:

3. Equipment Required

4. Pin Diagram:

SBTET-AP




5. Procedure:

6. Truth Table:

Outputs

G

Gaa

Yo

Y1

Y,

Y3

Ya

Ys

Ye

Y7

7. Results:
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8. Discussion on Results:

9. Scheme of Evaluation:

Category of Skill

Sub Task

Weightage
With Marks Awarded
Competency
Level
Individually

1.Handling of
Apparatus

A. Identifying the components
in the trainer kit

B. Identifying the Pin
configuration of IC

2.Manipulation of
Apparatus

A. Drawing the logic circuit

B. Connecting the logic
circuit

C. Appling the Enable inputs

15

3.Precision Operation
Activities

A. Applying Inputs and
Observe outputs

B. Verifying the truth table

C. Observing the outputs by
changing the enable inputs

25

4.Values

A. Co operation

B. Co-ordination
C. Communication
D. Sharing

E. Leadership

Total
50

Signature of the Staff

Signature of the Student
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3.7(b) WORK SHEET

WORK SHEET

ENCODER USING IC 74148

Name of the student:

PIN: BRANCH:

Date of experiment:

Institution:

Experiment No:

1. Title of the experiment

2. Objective of the experiment

3. Equipment required

4, Circuit diagram/block diagram:

Block diagram:

Pin diagram:
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5. Procedure:

6. Truth Table:

INPUTS

OUTPUTS

El

3

4

A2

Al

AO

7. Results:

8 .Inference and interpretation:
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9. Scheme of Evaluation:

CATEGORY OF SKILLS

SUB TASK

WEIGHATAGE WITH
COMPETENCY LEVEL
INDIVIDUALLY

MARKS AWARDED

1.Handling of apparatus

A. ldentification of IC
74148

B. Identification of
components in the
trainer kit

2.Manipulation of
apparatus

A. Circuit connections
B. Handling of
apparatus

C. Testing of IC

20

3.Precise
operations/activities

A. ldentifying pin
numbers of IC

B. Truth table
verification

C. Observation of
different logic states

20

4 Values

A. Co operation

B. Co ordination
C. Communication
D. Sharing

E. leadership

Total:

50

Signature of the staff

signature of the student
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3.8(a) WORK SHEET Construct a clocked SR Flip Flop using NAND gates

WORK SHEET
Name of the student:
Date of experiment:
PIN: Branch:
Institution:
1. Title of the experiment: CLOCKED RS FLIP FLOP

2. Objective of the experiment: Design a clocked RS flip flop using NAND gates and
Verify its truth table.

3. Equipment required: 7400 IC, Digital trainer kit, patch cards

4. Front panel/circuit diagram/block diagram:

o—
S

ol

D
s |-

Fig: 1 Clocked RS flip-flop using NAND gates

Vee B4 Aa va 83 a3 ¥3

IM 13 12 n 10 9 8

| trsel [
]

Do

1 2 '3 q 3 3 ]7
1

Al B Y1 A2 B2 Y2 GND

Fig: 2 pin diagram of I1C 7400
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5. Truth table of RS Flip-flop:

INPUTS OUTPUT STATE
CLK S R Q | Q
X 0 0 NC NC NO CHANGE
A 0 1 1 RESET
4 1 0 1 0 SET
T 1 1 - - FORBIDDEN

6. Procedure:
13. Take the digital trainer kit and insert the 74001C at appropriate position.
14. Connect pin 14 to vcc and pin 7 to ground.
15. Connect the circuit diagram as shown in figure
16. Give the clock input from pulser,
17. Switch on the trainer Kit,
18. Apply various input combinations and observe output for each one.
19. Verify the truth table of RS Flip-flop.

7. Results:

8. Discussion on result:
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9. Scheme of evaluation:

CATEGORY OF
SKILL

SUBTASK

WEIGHTAGE WITH MARKS
COMPETENCY LEVEL AWARDED
INDIVIDUALLY

1. Handling of apparatus

Identification of
IC’s

Identification of pins
of IC’s

Identification of
components in the
trainer Kit.

2. Manipulation of
apparatus

w >

Circuit connections
Handling of
apparatus

Testing of IC’s

20

3. Precise
operations/activities

>0

By applying inputs
to the circuit and
observe the outputs
Verifying truth
tables

Simplify the
expressions

20

4. Values

moow>

Co operation
Co-Ordination
Communication
Sharing
Leadership

Total

50

Signature of the staff

Signature of the student
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3.8(b) WORK SHEET

WORK SHEET

JK FLIP FLOP

Name of the student:

PIN: Branch:

Date of experiment:

Institution:

Experiment No:

1. Title of the Experiment:
2. Objective of the Experiment:
3. Equipment Required:

4. Circuit diagram:

5. Procedure:
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6. Readings.

S.No | Clock | Preset | Clear Switch condition LED 1 Status LED 2 Status

input (ForJand Kinputs) | (For Q Output) (For'_Q Output)

Interpretation of above Observations in terms of logic values.

S.No | Clock | Preset | Clear Switch condition LED 1 Status LED 2 Status
input (For J and K inputs) | (For Q Output)

(For- Q Output)

7. Results:

8. Discussion on Results:
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. Scheme of Evaluation

Category Sub task Weightage with | Total
of Skill Competency level
Individually

1.Handling of A. ldentifying components
apparatus B. Identifying the PINs of ICs

C. lIdentifying the  connection 5

points on the kit

2.Manipulation A. Handling ICs
of apparatus B. Testing ICs

C. Connecting the circuit 20
3.Precise A. Applying proper logic input
activities signals

B. Observing logic output and 20

interpreting its logic level.

4.Values A. Co-operation

B. Co-ordination

C. Communication 5

D. Sharing

E. Leadership

Total
50

Signature of the staff

Signature of the Student
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3.8(c) WORK SHEET

WORK SHEET

D AND T FLIP FLOPS

Name of the student:

PIN: Branch:

Date of experiment:

Institution:

Experiment No:

1. Title of the Experiment:
2. Objective of the Experiment:
3. Equipment Required:

4. Circuit diagram:

5. Procedure:
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6. Readings.

S.No Clock input Switch condition LED 1 Status LED 2 Status
(For D input) (For Q Output) (For-Q Output)
1
2
3
Interpretation of above Observations in terms of logic values.
S.No Clock input D Q )
input Output Output
1
2
3
S.No Clock input Switch condition LED 1 Status LED 2 Status
(For T input) (For Q Output) (For- 0 Output)
1
2
3
Interpretation of above Observations in terms of logic values.
S.No Clock input T Q ')
input Output Output
1
2
3
7.Results:

8. Discussion on Results:
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9. Scheme of Evaluation

Category Sub task Weightage with | Total
of Skill Competency level
Individually

1.Handling  of A. ldentifying components
apparatus B. Identifying the PINs of ICs

C. lIdentifying the  connection 5

points on the kit

2.Manipulation A. Handling ICs
of apparatus B. Testing ICs

C. Connecting the circuit 20
3.Precise A. Applying proper logic input
activities signals

B. Observing logic output and 20

interpreting its logic level.

4.Values A. Co-operation

B. Co-ordination

C. Communication 5

D. Sharing

E. Leadership

Total 50
Signature of the staff Signature of the Student
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3.9 Work Sheet

WORK SHEET

Ripple counter

Name of the Student:

PIN : Branch:

Date of Experiment:

Institution :

Experiment No:

1. Title of the Experiment

2. Objective of the Experiment:

3. Equipment Required

4. Pin Diagram:

5. Logic diagram and waveforms:
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5. Procedure:

6. Truth Table:

clk

Qo

Q1

Q2

7. Results:

8. Discussion on Results:
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9. Scheme of Evaluation:

Category of Skill

Sub Task

Weightage With
Competency Level
Individually

Marks Awarded

1.Handling of
Apparatus

A. ldentifying the
components in the trainer
kit

B. Identifying the Pin
configuration of IC

C. Checking the IC

2.Manipulation of
Apparatus

A. Drawing the Logic circuit
B. Connecting the Logic
circuit

C. Applying the clock pulse

15

3.Precision
Operation Activities

A. Observing the output
after applying each pulse
B. Obtain the timing
waveforms

25

4.Values

Co operation
Co-ordination
Communication
Sharing
Leadership

moow>

Total

50

Signature of staff

Signature of student
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3.10 WORKSHEET

DECADE COUNTER

WORK SHEET
Name of the student: Date of experiment:
PIN: Branch:
Institution: Experiment No:

1.Title of the Experiment:

2. Objective of the Experiment:

3. Equipment Required:

4. Circuit Diagram:
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5. Procedure

6. Readings:

COUNT TRUTH TABLE:

Inputs Outputs
Ri Rz |S1|S: |Q |Qc| Qs Qa
H H L X L L L L
H H X |L L L L L
X X H|H |H |L |L H
X L X |L COUNT
L X L | X COUNT
L X X |L COUNT
X L L | X COUNT
COUNT Qo Qc Qs Qa
0 0 0 0 0
1 0 0 0 1
2 0 0 1 0
3 0 0 1 1
4 0 1 0 0
5 0 1 0 1
6 0 1 1 0
7 0 1 1 1
8 1 0 0 0
9 1 0 0 1
10 0 0 0 0
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7. Inference and Interpretation:

8. Scheme of Evaluation:

Category of Skill

Sub task

Weightage with
Competency level
Individually

Total

A.

1.Handling of

OOw

apparatus

Identifying Decade Counter IC
Identifying the pins of ICs

Testing 1C whether it is Good or Bad
Inserting the 1C on Breadboard of Trainer
Selecting the required patch cords & wires

2.Manipulation of
apparatus

w >

moo

Drawing the Circuit Diagram

Making the Connections as per circuit
diagram

keeping all the data inputs to low
Switching ON the Power Supply
Varying the inputs to HIGH or LOW as
required.

20

3.Precise activities

O

© >

Applying proper logic input signals
Observing logic output and interpreting
logic level.

Noting the Logic outputs for corresponding
Inputs

20

4 Values

Mmoo

Co-operation
Co-ordination
Communication
Sharing
Leadership

Total

50

Signature of the Staff

of the Student

Signature
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3.11 WORK SHEET

WORK SHEET

UP/DOWN COUNTER

Name of the student :

PIN : Branch:

Date of experiment:

Institution:

Experiment No.

1. Title of the Experiment:

2. Objective of the Experiment:

3. Equipment Required :

4. Pin Diagram & Pin Description:

5. Procedure:
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6. Readings:

Count-UP Mode:

Qo

Q1

Q2

Qs

Clock
pulse

10
11
12
13
14
15

Count-Down mode:

Qo

Q1

Q2

Q3

Clock
pulse

10
11
12
13
14
15

Inference and Interpretation:

7.
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. Scheme of Evaluation:

CATEGORY
OF SKILL

SUB TASK

WEIGHTAG
EWITH
COMPETEN
CY LEVEL
INDIVIDUA
LLY

MARKS
AWARDE
D

1.Handling of
Apparatus

Ow>

o

Identifying the various ICs
Identifying the pins of ICs
Selecting the correct ICs for
various functions
Identifying the connection
points on the kit

Testing of 1C working
condition

2.Manipulation
of Apparatus

mo o

Making the connections as per
the circuit diagram

Connect the inputs to correct
pins of ICs

Checking the connections
Keeping all the inputs low
Varying the inputs HIGH or
LOW as required

20

3.Precise
operations/Acti
vities

Applying the proper logic input
signals

Observing the outputs for
different inputs

Interpret the logic levels for
output corresponding Inputs

20

4 Values

a)
b)
c)
d)

Co-operation
Co-Ordination
Communication
Sharing

Total

50

Signature of the Staff

Signature of the Student
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3.12 WORK SHEET 3.12 SHIFT REGISTER

3.18 WORK SHEET

Name of the student : Date of experiment:

PIN : Branch:

o Experiment No:
Institution:

3.18.1 TITLE OF THE EXPERIMENT:

3.18.2 OBJECTIVE OF THE EXPERIMENT:

3.18.3 EQUIPMENT REQUIRED:

3.18.4 CIRCUIT DIAGRAM:
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3.18.5 PROCEDURE:

3.18.6 TRUTH TABLE:

3.18.18 RESULT:

3.18.8 DISCUSSION ON RESULT:
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3.18.9 SCHEME OF EVALUATION:

WEIGHTAGE WITH

CATEGORY OF SKILL SUB TASK COMPETENCY LEVEL TOTAL
INDIVIDUALLY
A. Identify the major parts in the
1.HANDLING OF kit.(like LEDs, switches, Clock)
APPARATUS B. Identify the input and output
pins of IC 5
A. Read IC pin diagram
2.MANIPULATION B. Equipment handling
OF APPARATUS C. Observations 20
A. IC connections for different
3.PRECISE modes(SISO,SIPO,PISO,PI
OPERTAIONS / PO) of shift register
ACTIVITIES B. Tabulation of values of 20
truth table
A. Cooperation
B. Coordination
4 VALUES C. Communication 5
D. Sharing
E. Leadership
TOTAL
50

Signature of staff

Signature of student
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3.13(a) WORKSHEET SIMULATION OF AND, OR, NOT and EXOR USING NAND GATE

WORK SHEET

Name of the student:

PIN: Branch:

Date of experiment:

Institution:

Experiment No:

1. Title of the Experiment:

2. Objective of the Experiment:

3. Equipment Required:

4. Circuit Diagram:

SBTET-AP




5. Procedure

6. Readings:

AND Gate

S.No

A input

B input

Y Output

OR Gate

S.No

A input

B input

Y Output

NOT GATE

SL.NO

A Input

Y output
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EXOR GATE

S.No

A input

B input

Y Output

7. Inference and Interpretation:
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8. Scheme of Evaluation:

Category of Sub task Weightage with Total
Skill Competency level
Individually
A. Knowing how to invoke ORCAD PSPICE
application S/W 5
1.Handling of B. Opening a new project
apparatus C. Selecting proper project for digital simulation
D. Naming the project and finding the location
to save the project
E. Adding the required libraries to simulate the
project
A. Adding the required parts, input and output
ports to the work space
2.Manipulation | B, Wiring the circuit as per the circuit diagram 20
of apparatus C. Apply PSPICE stimulus to all input ports as
the truth table
D. Creating the new simulation profile to the
project
3.Precise A. Running the project and adding input and
activities/operati output traces to the simulation graph
ons B. Observing the output waveforms 20
C. Interpreting the simulation results with truth
tables
D. Repeating same simulation with selection of
proper time periods and ON time of inputs
such that the output is clearly understood
A. Co-operation
B. Co-ordination
4. Values C. Communication 5
D. Sharing

E. Leadership

Signature of the staff

Signature of the student
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3.13(b) WORKSHEET SIMULATION OF AND, OR, NOT and EXOR USING NOR GATE

WORK SHEET

Name of the student:

PIN: Branch:

Date of experiment:

Institution:

Experiment No:

1. Title of the Experiment:

2. Objective of the Experiment:

3. Equipment Required:

4. Circuit Diagram:
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5. Procedure

6. Readings:

AND Gate

S.No

A input

B input

Y Output

OR Gate

S.No

A input

B input

Y Output

NOT GATE

SL.NO

A Input

Y output
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EXOR GATE

S.No

A input

B input

Y Output

7. Inference and Interpretation:
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8. Scheme of Evaluation:

Category of
Skill

Sub task

Weightage with

Competency level

Individually

Total

1.Handling of
apparatus

e Knowing how to invoke ORCAD Pspice
application S/W

e Opening a new project

e Selecting proper project for digital
simulation

e Naming the project and finding the
location to save the project

e Adding the required libraries to simulate
the project

2.Manipulation
of apparatus

Adding the required parts, input and output
ports to the work space

Wiring the circuit as per the circuit diagram
Apply Pspice stimulus to all input ports as the
truth table

Creating the new simulation profile to the
project

20

3.Precise
activities/
operations

Running the project and adding input and
output traces to the simulation graph
Observing the output waveforms
Interpreting the simulation results with truth
tables

Repeating same simulation with selection of
proper time periods and ON time of inputs
such that the output is clearly understood

20

4 Values

moowx>

Co-operation
Co-ordination
Communication
Sharing
Leadership

Signature of the staff

Signature of the student
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3.14 WORK SHEET

HALF ADDER AND FULL ADDER USING SIMULATION USING PSPICE

WORK SHEET
Name of the student: Date of experiment:
PIN: Branch:
Institution: Experiment No:

1. Title of the Experiment:

2. Objective of the Experiment:

3. Equipment Required:

4. Circuit Diagrams:

Half adder :

Full adder :
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5. Procedure

6. Truth table:

Half adder:
Input Output
A B Sum Carry
Full adder:
Input Output
A B Sum Carry

7. Inference and Interpretation:
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8. Scheme of Evaluation:

Category of
Skill

Sub task

Weightage with

Competency level

Individually

Total

1.Handling of
software

A. Knowing how to invoke ORCAD Pspice
application S/W

B. Opening project and saving the project in
appropriate location.

C. Selecting proper project for digital
simulation.

D. Adding the relevant libraries to simulate the
project

2.Manipulation
of software

A. Adding the required parts,input and output

ports in the workspace.

Wiring the circuit as per the circuit diagram.

C. Customising the label names of all the inputs
and ouputs of logic gates.

D. Creating the new simulation profile to the
project

w

20

3.Precise
activities/operati
ons

A. Running the project and adding input and
output traces to the simulation graph

B. Observing the output waveforms

C. Interpreting the simulation results with truth
tables

D. Repeating same simulation with selection of
proper time periods and ON time of inputs
such that the output is clearly understood

20

4 Values

A. Co-operation
B. Co-ordination
C. Communication
D. Sharing

E. Leadership

Signature of the staff

Signature of the student
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3.15 WORKSHEET 3.15 SIMULATION OF MULTIPLEXER

WORK SHEET
Name of the student: Date of experiment:
PIN: Branch:
Institution: Experiment No:

1. Title of the Experiment:

2. Objective of the Experiment:

3. Equipment Required:

4. Circuit Diagram:
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5. Procedure

6. Readings:

MULTIPLEXER:

Enable

Data Input Lines

Selection

Lines

Output

0A

IlA IZA

3A

Sy

So

7. Inference and Interpretation:
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8. Scheme of Evaluation:

Category of Sub task Weightage with Total
Skill Competency level
Individually
A. Knowing how to invoke ORCAD Pspice
application S/W 5
1.Handling of B. Opening a new project
apparatus C. Selecting proper project for digital simulation
D. Naming the project and finding the location
to save the project
E. Adding the required libraries to simulate the
project
A. Adding the required parts, input and output
ports to the work space
2.Manipulation B. Wiring the circuit as per the circuit diagram 20
of apparatus C. Apply Pspice stimulus to all input ports as the
truth table
D. Creating the new simulation profile to the
project
3.Precise A. Running the project and adding input and
activities/operati output traces to the simulation graph
ons B. Observing the output waveforms 20
C. Interpreting the simulation results with truth
tables
D. Repeating same simulation with selection of
proper time periods and ON time of inputs
such that the output is clearly understood
A. Co-operation
B. Co-ordination
4.Values C. Communication 5
D. Sharing
E. Leadership
Signature of the staff Signature of the student
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. Description

4.1 EXPERIMENTAL METHODOLOGY

LOGIC GATES

This experiment requires the following equipment

4.1 LOGIC GATES

Name Specifications No Purpose
Digital IC trainer kit | Power supply 1 To verify the truth
tables of basic &
universal gates
Quad 2 input NAND | Supply voltage 5v 1 To verify the truth
gate(74LS00) table of NAND gate
Quad 2 input NOR | Supply voltage 5v 1 To verify the truth
gate(74LS02) table of NOR gate
Quad 2 input AND | Supply voltage 5v 1 To verify the truth
gate(74LS08) table of AND gate
Quad 2 input OR Supply voltage 5v 1 To verify the truth
gate(74LS32) table of OR gate
Quad 2 input NOT | Supply voltage 5v 1 To verify the truth
gate(74LS04) table of NOT gate
Bread board 1 To make connections

Connecting wires

As per required

To make connections

. Circuit diagram

Quad 2 input NAND gate(74LS00)

Quad 2 input NOR gate(74LS02)
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Veo Voo

ool
)

5 fi 7
GMD END
Quad 2 input NOT gate(74LS04) Quad 2 input AND gate(74LS08)
Ve
14 13 12 11 in ] 3
.l 1 | ] |
- 1 ] |
i 5 B 7
GMD
Quad 2 input OR gate(74LS32)

3. Theory

Logic gates are electronic circuits which perform logical functions on one or more inputs to
produce one output. There are seven logic gates. When all the input combinations of a logic gate
are written in a series and their corresponding outputs written along them, then this input/ output
combination is called Truth Table. Various gates and their working is explained here.

AND gate produces an output as 1, when all its inputs are 1; otherwise the output is 0. This gate can
have minimum 2 inputs but output is always one. Its output is 0 when any input is 0.

OR gate produces an output as 1, when any or all its inputs are 1; otherwise the output is 0. This

gate can have minimum 2 inputs but output is always one. Its output is 0 when all input are 0.

NOT gate produces the complement of its input. This gate is also called an INVERTER. It always has
one input and one output. Its output is 0 when input is 1 and output is 1 when input is 0.

NAND gate is actually a series of AND gate with NOT gatelts output is 1 when any or all inputs are 0,

otherwise output is 1.
NOR gate is actually a series of OR gate with NOT gate. Its output is 0 when any or all

inputs are 1, otherwise output is 1.

4. Procedure

1. Connect the trainer kit to ac power supply.

2. Place the IC ON breadboard

3. Connect the inputs of any one logic gate to the logic sources and its output to the logic
indicator.

4. Apply various input combinations and observe output for each one.

Verify the truth table for each input/ output combination.

6. Repeat the process for all other logic gates.

bl
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7. Switch off the ac power supply.

5. Observations

S.No Switch 1 condition | Switch 2 condition | LED status for
(for Alinput) (for b input) output

1 Off Off Glow

2 Off On Glow

3 On Off Glow

4 On on Does not glow

Interpretation of above Observations in terms of logic values.

S.NO A INPUT B OUTPUT
INPUT

1 0 0 1

2 0 1 1

3 1 0 1

4 1 1 0

NOR GATE

S.No Switch 1 condition | Switch 2 condition | LED status for
(for Ainput) (for b input) output

1 Off Off Glow

2 Off On Does not glow

3 On Off Does not glow

4 On on Does not glow

Interpretation of above Observations in terms of logic values.

S.NO AINPUT | BINPUT OUTPUT
1 0 0 1
2 0 1 0
3 1 0 0
4 1 1 1
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AND GATE

S.No

Switch 1 condition

(for Ainput)

Switch 2 condition

(for b input)

LED status for

output

1 Off Off Does not glow
2 Off On Does not glow
3 On Off Does not glow
4 On on glow
Interpretation of above Observations in terms of logic values.
S.NO | A B INPUT OUTPUT
INPUT
1 0 0 0
2 0 1 0
3 1 0 0
4 1 1 1
OR GATE
S.No Switch 1 condition | Switch 2 condition | LED status for
(for Ainput) (for b input) output
1 Off Off glow
2 Off On glow
3 On Off glow
4 On on Does not glow

Interpretation of above Observations in terms of logic values.

S.NO A INPUT | BINPUT | OUTPUT
1 0 0 1
2 0 1 1
3 1 0 1
4 1 1 0
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NOT GATE

S.No Switch 1 condition | LED status for
(for Ainput) output

1 Off glow

4 On Does not glow

Interpretation of above Observations in terms of logic values.

S.NO | AINPUT | OUTPUT
1 0 1
2 1 0
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EXPERIMENTAL METHODOLOGY 4.2(a)

REALISATION OF AND, OR, NOT GATES USING 2 INPUT NAND GATES

1. Description:

o

2. Circuit diagram:

A
B

NOT (inverter)

Figure: NOT gate using NAND gate

AND

Figure: AND gate using NAND gate
A—p }— Af
' =A+8B

OR

Figure: OR gate using NAND gate

The setup for this experiment requires IC 7400 and Digital logic trainer Kit.

IC 7400 is a DIP 14-Pin Quad 2-input NAND gate IC.

We can use any one of the multiple gates available inan IC.

Digital logic trainer kit provides logic input switches for applying logic inputs and
logic output LED indicators for observing output logic.

REALISATION OF AND,OR and NOT GATES USING 2 INPUT NAND GATES
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Pin diagram:

NAND 7400 IC:
Vee
14 13 12

—

Y=A.B
D) AB[Y
011
[ [ 101
110

I T

1 2 3 4 5 7

GND

3. Theory:

NAND gate is actually a combination of two logic gates: AND gate followed by NOT gate. So its

output is complement of the output of an AND gate.

This

gate can have minimum two

inputs,

output is

always

one.

By using only

NAND gates, we can realize all logic functions: AND, OR, NOT, X-OR, X-NOR, NOR. So this gate is also
called universal gate.

4. Procedure:

o0

5. Observations:

Make the connections as shown in the circuit diagram.
Feed the logic signal from the logic input switches.

Observe the logic outputs on the logic level LED indicators.
Observe the output for all possible input combinations.
Verify the corresponding truth table.

AND Gate:
S.No Switch 1 Switch 2 LED Status Interpretation of Readings in terms of
condition (For | condition (For (For Output) logic values
Ainput) B input) A B Y
input input Output
1 OFF OFF Doesn’t Glow 0 0 0
2 OFF ON Doesn’t Glow 0 1 0
3 ON OFF Doesn’t Glow 1 0 0
4 ON ON Glow 1 1 1
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OR Gate:

S.No Switch 1 Switch 2 LED Status Interpretation of Readings in terms of
condition (For | condition (For (For Output) logic values
Ainput) B input) A B Y
input input Output
1 OFF OFF Doesn’t Glow 0 0 0
2 OFF ON Glow 0 1 1
3 ON OFF Glow 1 0 1
4 ON ON Glow 1 1 1
NOT Gate:
S.No Switch 1 LED Status Interpretation of Readings
condition (For | (For Output) | interms of logic values
Ainput) A Y
input Output
1 OFF Glow 0 1
2 ON Doesn’t Glow 1 0
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4.2(b) EXPERIMENTAL METHODOLOGY  4.2(b) REALIZATION OF AND, OR, NOT USING 2 INPUT NOR GATE

REALIZATION OF AND, OR, NOT USING 2 INPUT NOR GATE

1. Description

The setup for this experiment requires the following Equipment

Name Specifications No Purpose
Digital Logic Trainer 1 Toinsert IC
NOR Gate IC 7402 DIP 14 PIN Quad 2-input IC 1 To realize basic gates
Patch cords As per need | To make connections
Single Strand wires As per need | To make connections

2. Circuit Diagram

Realization of NOT, AND, OR using NOR Gates

NOT Gate

AND Gate

OR Gate
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Pin Diagram of IC 7402

anNo

ouput gate 1 [1 | o U Rz Ig\}%‘é?ng
input gate 1 2] 13] output gate 4

~ input gate 1 ? % input gate 4

E E P-j: Input gate = 7402 Input gate
E\I_é EI output gate 2 | 4 11} input gate 4
E &E input gate 2 5| 10| output gate 3
= input gate 2 6 9 | input gate 3

(=] =]

E\I_é EI ov [7] 8] input gate 3

3. Theory

The basic logic gates AND, OR and NOT can be combined to realize any other logic
circuit. The NOR gate is a derived gate and is special since it is
considered a universal gate. It isa NOT OR gate and the logic symbol is the OR gate
with an invert bubble on its output.

©)

Like the AND and OR gates the NOR gate can more than two inputs. The universality of
the NOR gate means any Boolean expression may be implemented with all NOR gates
without the use of any other logic type gate.

To realize NOT Gate using NOR Gate both the inputs have been shorted since NOT Gate
has only one input. When binary HIGH signal (1) is given at the input, binary LOW (0) is
the output and vice-versa.

To realize OR Gate using NOR Gate, the output of NOR Gate is connected to NOT Gate.
To realize AND Gate using NOR Gate, the inputs are complemented using 2 NOR gates
and their outputs are given as inputs to the other NOR gate.
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4. Procedure

1. Make the connections as shown in circuit diagram.

2. Feed the logic signal from the logic input switches.

3. Observe the logic outputs on the logic level LED indicators.
4. Observe the output for all possible input combinations.

5. Verify the corresponding truth table.

5. Truth Tables

NOT GATE:
INPUT OUTPUT
A Y=A
0 1
1 0
AND GATE:
INPUTS OUTPUT
A B Y
0 0 0
0 1 0
1 0 0
1 1 1
OR GATE:
INPUTS OUTPUT
A B Y
0 0 0
0 1 1
1 0 1
1 1 1

6. Precautions:

Disconnect all the Equipment from Mains before giving connections
Ensure Correct 1Cs were chosen.

ICs are to be inserted with great care.

Loose connections should be avoided

Power supply for ICs should be 5V DC.

Before turning ON the power to the trainer review the wiring for errors.

S A
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3.2(c) METHODOLOGY EX-OR GATE USING NAND AND NOR GATES
EX-OR GATE USING NAND AND NOR GATES

1. Description
I.  The set up this experiment requires a 7400 IC,7402 1C, Digital trainer kit

ii.  IC’s are available in laboratory and by using these IC’S we can verify the truth
tables

2. Circuit diagram

A A Tyt
B ((AB)'B)'

Fig:1 EX-OR GATE USING NAND GATES

(A+{A+B)"Y

A AGOB
B (A+B)’

(B+{A+B)"Y

Fig:2 EX-OR GATE USING NOR GATES

PIN DIAGRAM:
NAND 7400 IC:
Vee
14 13 1I2 11 10 9 8
1
D AB[Y
) o 0]1
0 1]1
r_ r__ 1 01
1 110
T
1 pd 3 4 5 G 7
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NOR 7402 IC:

- Vee

1*4 13 12 11 10 9 8

Y=A+B

I—ll—ir:::-n:::ld,.
= =11
oD |

=1 gy

GND

3. Theory

1.

The NAND or NOR Gates can be used to develop any one of the logic gates. It means
that one can use only NAND Gates or only NOR Gates to realize any basic gates.
Hence these two gates are called as universal gates.
The NOT-AND operation is known as NAND operation. If all inputs are 1 then
output produced is 0. NAND gate is inverted AND gate.
Y =(A.BY
The NOT- OR operation is known as NOR operation. If all the inputs are 0 then the
O/P is 1. NOR gate is inverted OR gate. Y = (A+B)’
The NOR gate has two or more input signals but only one output signal.
An EX-OR Gate is a gate with two or more inputs and one output. The output is a
logic 1 only when there are odd number of 1’s at the input.

Y=AB+AB’

4. Procedure

1. Take the digital trainer kit and insert the 74001C at appropriate position.
Connect pin no 14 to Ve and pin no 7 to ground.

Connect the circuit diagram as shown in figure

Switch on the trainer Kit,

Apply various input combinations and observe output for each one.
Verify the truth table of EX-OR gate.

Insert the 7402 IC at appropriate position.

Connect pin no 14 to Ve and pin no 7 to ground.

. Connect the circuit diagram as shown in figure

10. Switch on the trainer Kit,

11. Apply various input combinations and observe output for each one.
12. Verify the truth table of EX-OR gate.

©ooN A WD
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5. Precautions

1.

2
3.
4.
5
6

o ~

=
=
[ 3]
-2
'S
o
al
o
=
e

S S

IC should not be reversed.

Make the connections according to the IC pin diagram.

The connections should be tight.

The VCC and ground should be applied carefully at the specified pins only.
Before making changes in the circuit turn off or disconnect the power.
When hooking up a circuit, connect to the power source last, while power is
off.

Always keep your work area should be dry.

Insert ICs in the middle of bread board as shown below carefully to avoid
short circuits between IC pins.

\ 18 0/ VMtas

_y3_L+|g—|2—5_L*S+T2
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4.3 EXPERIMENTAL METHODOLOGY HALF ADDER AND FULL ADDER

HALF ADDER AND FULL ADDER
Description:

1. The setup for this experiment requires the following equipment:

SNo. | Name No. | Purpose
1 Digital IC Trainer Kit 1 To provide inputs, outputs, bread board,
supply, ground, etc
2 IC 7408 (AND Gate) 1 Provides Four two input AND gates
3 IC 7432 (OR Gate) 1 Provides Four two input OR gates
4 IC 7486 (EX-OR Gate) 1 Provides Four two input EX-OR gates
5 Patch  Chords/Connecting For giving connections
Wires

Circuit diagram:

Half adder : Full adder:

A-e T\

B S
A ® g Cr
B i

Cout
C

Theory:

1. A Half adder can add two bits at a time.

2. Its outputs are SUM and CARRY.

3. For two bit addition- SUM will be 1, if only one input is 1(X-OR operation).

4. CARRY will be one, when both inputs are 1 (AND operation).

5. So, by using one AND gate and one X-OR gate, a half adder circuit can be constructed.
SUM = AB’' + A'B

CARRY = AB
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6. A full adder is a combinational circuit that performs the arithmetic sum of three inputs and
gives two outputs.

7. A full adder is useful to add three bits at a time but a half adder cannot do so.

8. In full adder sum output will be taken from X-OR Gate, carry output will be taken from OR
Gate.

Procedure:

1. Connect the trainer kit to ac power supply.

2. Connect logic sources to the inputs of the adder.

3. Connect output from SUM and CARRY to logic indicators.
4. Apply various input combinations to the adder.

5. Observe the SUM and CARRY outputs, verify the truth table for each input/ output
combination.

6. Switch off the ac power supply.

Truth tables:

Half adder : full adder:
Input Output
A B Cin Sum Carry
0 0 0 0 0
Input Output 2 2 1 = 0
0 1 0 1 (0]
A B Sum Carry
0 1 1 0 1
0 0 0 0 —— = - =
0 1 1 0 T o : o 1
1 0 1 0 i 1 0 0 1
1 1 0 1 1 1 1 1 1
PRECAUTIONS :

e Disconnect all the equipment from mains before making connections.
e Connect the circuit as per circuit diagram.

e Loose connections should be avoided.

e Get the connections checked by the concerned staff member.

e Give required supply voltage to the circuit.
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4.4 EXPERIMENTAL METHODOLOGY 4.4 4-Bit MAGNITUDE COMPARATOR

4-Bit MAGNITUDE COMPARATOR (IC 7485)

4.7.1 DESCRIPTION:

The setup for this experiment requires the following equipment

NAME SPECIFICATIONS/ NO PURPOSE
RANGE
Comparator IC 7485 1 To compare 4-Bit numbers
Minimum of 10 logic To connect the circuit on kit as per
inputs and 3 logic circuit
IC trainer kit P g 1
outputs, power supply
0-5vV
. As per
Patch cards Different colors need | To make the connections
4.7.2 CIRCUIT DIAGRAM:
DATA INPUTS

Voc A3 B2 A2 A1 Bi A0 BO

I16 15 14 13 12 1 10 9

A3 B2 A2 A1 B1 AQ

1 es 7485 8o H

A<BA=BA>BA>BA=B A<B
N iN iN OuT OUT OuUT

1 2 3 4 5 5 7 8

B3 A<BA=BA>BA>BA=BA<B GND
DATA -~ N ,

INPUT ¢ ASCADE INPUTS OUTPUTS
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4.7.3 THEORY:

A digital comparator or magnitude comparator is a hardware electronic device that takes

two numbers as input in binary form and determines whether one number is greater than, less
than or equal to the other number.

The 4-bit magnitude comparators perform comparison of straight binary or BCD codes. The two 4-
bit numbers are A=A3A2A1A0 and B3B2B1B0 where A3 and B3 are the most significant bits.
Three fully-decoded decisions about two, 4-bit words (A, B) are made and are externally available at
three outputs, one each for equality (A=B), greater than (A>B) and less than (A<B).

The 4-bit comparator is mostly available in IC form and common type of this IC is 7485.
These devices are fully expandable to any number of bits without external gates. Words of greater
length may be compared by connecting comparators in cascade. The A > B, A < B, and A = B outputs of a
stage handling less-significant bits are connected to the corresponding inputs of the next stage handling

more-significant bits. The stage handling the least significant bits must have a high-level voltage applied
to the A =B input.

4.7.4 PROCEDURE:

Connections are made as per pin diagram

Connect Vcc and ground pins of IC at 5V and ground points respectively
Connect the inputs A0 BO A1B1 A2 B2 A3 B3 to the concerned inputs
Connect the outputs to LEDs

Switch ON the power supply

Apply inputs and observe the outputs by supporting of truth table

ok wnE

4.7.4 OBSERVATIONS:

Comparing inputs Cascading inputs Outputs
As, B3y A, By, A, B, Ao By A>BA<BA=B A>B A<B A=B
As> By X X X X X X 1 v 0
Ay < By X X X x X X 0 1 0
Ag=By A;>B, X X X X X 1 0 0
Ag=By A; <B, X X % X X 0 1 0
AS-BS A:—‘Bz A’ <B‘ x X X X 0 1 0
Ag=By Ay=B, A, =B, Ay>B, X X X 1 o 0
AS_BS Az-Bz A’-B‘ A°<B° X X X 0 J | 0
Aa-Ba A, = B, Ay = B, Ay, == B, 1 0 0 1 0 0
AS_BS A’—Bz 41-81 Ao-Bo 0 l 0 0 l 0
AS-BS Az—Bz A‘-B’ A0=BO X X 1 0 0 1
43-83 A’BBz A‘HB! Ao_Bo 1 1 0 0 0 0
Ay=By, Ay =B, A, =B, Ay=2B, 0o o o0 1 1 0
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4.7.5 PRECAUTIONS:

arwnE

Ensure that pin 16 and 3 connected to supply(5V)
Ensure pin 8, 2 and 4 connected to ground

Avoid loose connections

While connect the circuit on board power should be off
Power should be off before change the connections
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4.5 EXPERIMENTAL METHODOLOGY

Description:

MULTIPLEXER

MULTIPLEXER

1. The experiment setup requires Digital trainer board and Multiplexer IC 74153.

2. Digital Trainer is a general-purpose digital experiment board equipped with Breadboard, Logic Level
Inputs, and LEDs for output indication, built-in fixed 5V DC power supply and clock sections.

3. Inputs can be applied to by changing the position (logic level) of switches.

4. Truth table can be verified by varying possible inputs and observing the illuminated output LEDs.

Circuit Diagram:

:
DATALP |D1 ——3
D2 ——

D3 —

Truth table:

41
MUY

:

DATA QIP
I >

-

31 s0
DATA SELECT

[

B

(¥

1
e
Aip | 5 |
4

Bip |

74153

leo

GHND

Enable

Data Input Lines

Selection
Lines

Output

o
>

-
>
-
>

w
>

w
]
o

N
>

X|X|X|X|X|X|FR|O|X

X[ X|X | X | |O|X|X|[X
X[ X|P|O|X|X|X|X|[X

RO |IX|X|X|X|X|X|[X

R|RPr|IRPRRPRIOO|OC|O|X
R |RP|IOO(Rr|Rr|O|O|X

ROk O | O|R|O|O
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Theory:

1. The multiplexer, shortened to “MUX" or “MPX”, is a combinational logic circuit
designed to switch one of several input lines through to a single common output line by
the application of a control signal.

2. Multiplexers are also known as data selectors because they can “select” each input data
line.

3. The selection of each input line in a multiplexer is controlled by an additional set of
inputs called Select lines.

4. A multiplexer has an even number of 2" data input lines where n is number of “select”
inputs

Procedure:

1. Fix the IC on the bread board.

2. Make connection according to the circuit.

3. Connect select lines and data input lines to toggle switches (either channel A or B).
4. Connect +5V (V) supply at pin no 16 & GND at pin no 8.

5. Apply various combinations of input according to truth table.

6. For all input combinations observe the outputs and verify with the truth table.
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4.6 EXPERIMENTAL METHODOLOGY BCD TO 7 SEGMENT DECODER 7448 IC

BCD TO SEVEN SEGMENT DECODER USING IC 7448
1. DESCRIPTION:
1. The set up for this experiment requires digital trainer kit along with bread board.
2.1C 7448 is used.

3. Common anode seven segment display is used.

2. CIRCUIT DIAGRAM:

IC Mg I
. B, 1, -
[ ] —
Zna | i o — b |_ | |
wilzh | | ¢ | € L i
) | _ |
W - —d :
Y [ !
—a BRED b = |
¥ [ ] i

3. THEORY:

A Digital Decoder IC, is a device which converts one digital format into another and one of the
most commonly used devices for doing this is called the Binary Coded Decimal (BCD) to 7-
Segment Display Decoder.

Typically 7 segment decoder consist of seven individual colored LED’s (called the segments),
within one single display package. In order to produce the required numbers or HEX characters
from 0 to 9 and A to F respectively, on the display the correct combination of LED segments
need to be illuminated and BCD to 7-segment Display Decoders such as the 74L548 do just
that.

A standard 7-segment LED display generally has 8 input connections, one for each LED segment
and one that acts as a common terminal or connection for all the internal display segments.
Some single displays have also have an additional input pin to display a decimal point in their
lower right or left hand corner.
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In electronics there are two important types of 7-segment LED digital display.

e 1. THE COMMON CATHODE DISPLAY (CCD)—In the common cathode display, all the
cathode connections of the LED’s are joined together to logic “0” or ground. The
individual segments are illuminated by application of a “HIGH”, logic “1” signal to the
individual Anode terminals.

e 2. THE COMMON ANODE DISPLAY (CAD)—In the common anode display, all the anode
connections of the LED’s are joined together to logic “1” and the individual segments are
illuminated by connecting the individual Cathode terminals to a “LOW”, logic “0” signal.

+
a o—pi :' 1 a o’: =1
b 0—>|"' 1 b Q'TJTq—-
C e H,"’ 4 o .Y'H -~
de » de g
e &—}%—}a e &'T’q*—
fe b{: f o |d
R ] g o fe
Common Common
Cathode Anode

4. PROCEDURE:
1. Connect 5V and ground to their indicated position on digital trainer kit.
2. Connect BCD inputs A, B, C, D to the pin of IC 74LS48 as shown in logic diagram
3. Connect +5V to Pins 3, 4, 5 of IC 74L548.
4. Connect pins 13-a, 12-b, 11-c, 10-d, 9-e, 15-f, 14-g of common anode display respectively.
4. Switch on the power supply.
5. Observe decimal output on common anode display given on the experiment board.

5. OBSERVATIONS:

4.7(a) Experimental Methodology IC 74138 Decoder
BCD Inputs Segment Outputs Display

A B C D a b c d e f g

0 0 0 0 1 1 1 1 1 1 0 0
0 0 0 1 0 1 1 0 1 0 0 1
0 0 1 0 1 1 0 1 1 0 1 2
0 0 1 1 1 1 1 1 0 0 1 3
0 1 0 0 0 1 1 0 0 1 1 4
0 1 0 1 1 0 1 1 0 1 1 5
0 1 1 0 0 0 1 1 1 1 1 6
0 1 1 1 1 1 1 0 0 0 0 7
1 0 0 0 1 1 1 1 1 1 1 8
1 0 0 1 1 1 1 0 0 1 1 9
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4.7(a) Experimental Methodology

1. Description:

IC 74138 Decoder

VERIFY THE TRUTH TABLE OF 74138 DECODER IC

The setup for this experiment requires the following equipments

1. This experiment requires IC trainer kit, and counter IC.

2. IC numberis 74138.

3. Learn the pin description of integrated circuit.

4. Always inputs are given in the form of 0’s and 1’s

2. Theory:

The 74138 circuit is designed to be used in high-performance memory-decoding or data-routing
applications requiring very short propagation delay times. In high-performance memory systems, this
decoder can be used to minimize the effects of system decoding. When employed with high-speed
memories utilizing a fast enable circuit, the delay times of this decoder and the enable time of the
memory are usually less than the typical access time of the memory. This means that the effective
system delay introduced by the decoder is negligible.

ENABLE
INPUTS

SELECT :
INPUTS

{G2A

{4)

(15) 9

0

)

¢

14
{ )Y1

T

(13} v2

5
G2B()

{1

1

1
{12} va

¥

(2)

11
: )Y4

¥

L0 Y5

i

(3)

(9)

Y6

—\_.-
|L_F
{>o—¢
o
Do

RUIRUIRUIRIIR

;

{7)

Y7

~

! DATA
OQUTPUTS

SBTET-AP




3. Pin diagram:

DM74LS138
DATA OUTPUTS
Vee YO Y1 v2 Y3 Y4 Y5 Y6
I16 |15 |14 |13 |12 In ||o 9
fo-

. 2 3 I 4 | 5 6 | 7 ] 8
A e C G2A G2B G1 Y7 GND
X — SN ——’  QUTPUT

SELECT ENABLE

The decoder accepts three binary weighted inputs (A, B, C) and when enabled provides eight mutually
exclusive active LOW Outputs (Yo—Y7). The 74LS138 features three Enable inputs, two active LOW (G2a,
Gzg) and one active HIGH (G1). All outputs will be HIGH unless Gza and G2 are LOW and G; is HIGH.

As shown in table first three rows the enable pins needed to be connected appropriately or irrespective
Of input lines all outputs will be high. After connecting the enable pins as shown in circuit diagram you
Can use the input line to get the output.

4. Procedure:

1. Connections are made as per the logic circuits.

2. Connect Vccand GND (ground) pins of ICs at +5V and ground points of IC Trainer Kit respectively.
3. Connect inputs A, B, C on the IC trainer kit.

4. Connect enable inputs G1, G2A, G2B on the IC trainer kit.

5. Connect the outputs Yo, Y1, Y2, Y3, Y4, Y5, Y6, and Y7 to output LEDs.

6. Switch ON the power supply.

7. Apply G; is logic High and G,a and Gz are logic low

8. Apply different combination of inputs and observe the outputs.

9. Hence, verify the truth table.
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5. Truth table:

Inputs
Enable Select R,
G1(G2 (Note1)([C|B|A|YO|Y1|Y2|Y3|Y4|Y5(Y6|Y7
X H X|IX|IX|H|H|H|H|{H|H|H]|H
L X X|IXIX|H|H|H|H|H|H|[H|H
H 1 L{ILIL|IL|H|H|H|H|H|H]|H
H L LILIHIH|L|H|H|H|H|H]|H
H L LIHILIH|H|L|H|H|H|H]|H
H L LIHHH|H|H|H|L|H|H|H]|H
H L HILILIH|H|H|H|L|H|H]|H
H L HILIHHH|{H|H|H]|H|L|[H|H
H L HIHILIH|H|H|H|H|H|L]|H
H L HIHHHIH|H|H|[H|H|H|H|L

Here we have used a single device so the connections of G2A, as well as G2B pins, are connected to
GND followed by linking G1-to-VCC for activating the chip. Here three buttons signify three i/p lines for
this device. For a better understanding of this concept, let us understand the following truth table. In
the above tabular form, the H-HIGH, L-LOW and X- don’t care. The enable pins G1, G2A, and G2B, where
G2=G2A + G2B.In the above tabular form, the first rows namely G1, G2 are the enable pins required to
be connected correctly otherwise irrespective of all i/p, as well as o/p lines, will be high. Once the

enable pins are connected, then the input line can be connected for getting the output.

Applications: Decoder used applications are

1. Line decoders

2. Servers

3. Digital systems

4. Line De-multiplexing
5. Telecom circuits

5. Memory circuits
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Precautions:

1. Ensure the correct IC..

2. Ensure that IC 74138 Pin 14 connected to power supply..
3. Ensure that IC 74138 Pin 7 connected to ground.

4. Connect the circuit as per circuit diagram.

5. Loose connections should be avoided.

6. Get the connections checked by the concerned staff member.
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4.7(b) EXPERIMENTAL METHODOLOGY

4.11 ENCODER USING IC 74148

Function of Encoder using IC 74148

1. Description

I.  The set up for this experiment requires a 74148 IC, Digital logic trainer kit

ii. IC’s are available in laboratory and by using these IC’S we can verify the truth

tables

2. Circuit diagram/Pin diagram

) —0
1—0
I—90
3—q
$—q
§—C0
§ m—(
| 7—¢
Enable Input

(Active Low) ===(

Octal Inputs
(Active Low)

74148

D——-1

D———p |Binary Outputs
(Active Low)

P C

PGS
Gray Outputs
D EO | (Active Low)

a. Circuit diagram

4 le:]VCC
5042 151 EO
- 6[]3 w 1410GS .
704 2 13§33
EIl}s © 1232
A2[]6 1
A137 1000
GND L[]8 911 A0
b. Pin diagram
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3. Theory
1. An encoder is a combinational digital logic circuit.
2. A digital encoder has commonly called as a binary encoder.
3. It accepts an active level on one of its input represents a digit (decimal or octal) and
converts into a coded output (binary or BCD).
4. These encoders is used as a code converters.
5. Encoder has a 2"inputs and n outputs.
4. Procedure
20. Take the digital trainer kit and insert the 74148I1C at appropriate position.
21. Connect pin no 16 to vec and pin no 8 to ground.
22. Connect the circuit diagram as shown in figure.
23. Switch on the trainer Kit.
24. The octal inputs are given at the corresponding pins.
25. The outputs are verified at the corresponding output pins.
5. Truth table for Encoder:

INPUTS OUTPUTS
El 0 1 2 3 4 5 6 7 A2 | Al AO
H X X X X X X X X H H H
L H H H H H H H H H H H
L X X X X X X X L L L L
L X X X X X X L H L L H
L X X X X X L H H L H L
L X X X X L H H H L H H
L X X X L H H H H H L L
L X X L H H H H H H L H
L X L H H H H H H H H L
L L H H H H H H H H H H

6. Precautions:
1. Ensure that pin 14 connected to supply.
2. Ensure that pin 7 connected to ground.
3. All connections should be made properly.

4. |C should not be reversed.

(3]

. Power supply should not exceed 5V.

6. Never work on a circuit while power is applied.

~N

. Always keep your work area should be dry.
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4.8(a) Experimental Methodology Clocked SR Flip Flop

CLOCKED RS FLIP FLOP

1. Description

The set up of this experiment requires a 7400 IC, Digital trainer kit

The digital trainer Kit consists of bread board, power supply, toggle switches,
LED’s, Pulses.

Observing the pin description of IC’s.

2. Circuit diagram

o— |
S

Ol

>
s |

Fig:1 Clocked RS flip-flop using NAND gates

Vee B4 Al Yé4 83 a3 Y3

o

14 13 12

gy
all

ﬁ

2 '3 4 5 § |7

Al 1 Y1 A2 B2 Y2 GND

Fig: 2 pin diagram of IC 7400
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3.

Truth table of RS Flip-flop:

INPUTS OUTPUT STATE
CLK S R Q Q
X 0 0 NC NC NO CHANGE
4 0 1 0 1 RESET
$ 1 0 1 0 SET
1 1 - - FORBIDDEN

Theory

1. There are two inputs to the flip-flop defined as R and S.

2. When inputs R =0 and S = 0 then O/P remains unchanged.

3. When inputs R =0 and S = 1 the flip-flop is switches to the stable state where O/P is
1i.e. SET.

4. The input condition is R =1 and S = 0 the flip-flop is switched to the stable state
where output is 0 i.e. RESET.

5. The input condition isR =1 and S = 1 the flip-flop is switched to the stable state
where output is FORBIDDEN

Procedure

1. Take the digital trainer kit and insert the 74001C at appropriate position.

2. Connect pin 14 to V¢ and pin 7 to ground.

3. Connect the circuit diagram as shown in figure

4. Give the clock input from pulser.

5. Switch on the trainer Kit,

6. Apply various input combinations and observe output for each one.

Verify the truth table of RS Flip-flop.

INPUTS OUTPUT STATE
CLK S R Q | Q
X 0 0 NC NC NO CHANGE
4 0 1 1 RESET
4 1 0 1 0 SET
! 1 1 - - FORBIDDEN

Precautions:

1) Make the connections according to the IC pin diagram.

2) The connections should be tight.

3) The Vcc and ground should be applied carefully at the specified pin only.

4) Before making changes in a circuit, turn off or disconnect the power first.

5) When hooking up a circuit, connect to the power source last, while power is off.
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4.8(b) EXPERIMENTAL METHODOLOGY JK FLIP FLOP

J KFLIP FLOP USING IC 7476
1. Description:
1. The setup for this experiment requires IC 7476 and Digital logic trainer Kit.

2. 1C 7476 is a DIP 16-Pin Dual J_K flip flop with Preset and clear.
3. Digital logic trainer kit provides logic input switches for applying logic inputs and
logic output LED indicators for observing output logic.
2. Circuit diagram:

7476

10 1@ GND 2k 20 28 2J

16 1% 14 13 12 1 0
L i | - - ——
& 2
CLR PR
K G J Q
—OPCK —Op CK
ml Q K (]
PR CLR
T . S
1 Py 1
1 2 3 ) $ | ? @

Vee 2CK 2PR V4
CLR

1 PR 1 14
CLR

1CK

a) J K Flip flop

Symbol:

Clr

b) symbol
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3. Theory:

1.
2.

IC 7476 is a Dual JK flip flop.

This simple JK flip Flop is the most widely used of all the flip-flop designs and is
considered to be a universal flip-flop circuit.

When both J and K are 0, the clock pulse has no effect on the output and the output of
the flip-flop is the same as its previous value.

When J=0, K=1, Therefore Q becomes 0. This condition will reset the flip-flop. This
represents the RESET state of Flip-flop.

When J=1, K=0, Therefore Q becomes 1. This condition will set the flip-flop. This
represents the SET state of Flip-flop.

when both the J and the K inputs are at logic level “1” at the same time, and the clock
input is pulsed “HIGH?”, the circuit will “toggle” from its SET state to a RESET state,
or visa-versa. This results in the JK flip flop acting more like a T-type toggle flip-flop
when both terminals are “HIGH”.

4. Procedure:

1.

arow

Make the connections as shown in circuit diagram.

Feed the logic signal from the logic input switches.
Observe the logic outputs on the logic level LED indicators.
Observe the output for all possible input combinations.
Verify the corresponding truth table.

5. Truth table of Negative edge triggered JK flip-flop

INPUTS
mug!n Asynchronous Synchronous ouTRUTS
PS CLR CLK J K Q a

Asynchronous set 0 1 X X X 1 0
Asynchronous reset 1 0 X X X 0 1
Prohibited 0 0 X X X 1 1
Hold 1 1 ' 0 0 No change
Reset 1 1 ¥ ] 1 0 1
Set 1 1 V 1 0 1 0
Toggle 1 1 t 1 1 Opposite state

0 =LOW

1 = HIGH

X = Irelevant

4 = HIGH-10-LOW clock transition

(€)
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4.8(c) EXPERIMENTAL METHODOLOGY D AND T FLIP FLOPS

D and T flip flops using IC 7476

1. Description:

1.

o k> w

The setup for this experiment requires IC 7404, IC 7476 and Digital logic trainer Kit.
IC 7404 is a DIP 14-PIN NOT gate IC which provides Hex inverting gates.

We can use any one of the Hex inverting gates.

IC 7476 is a DIP 16-Pin Dual J_K flip flop with Preset and clear.

Digital logic trainer kit provides logic input switches for applying logic inputs and
logic output LED indicators for observing output logic.

2. Circuit diagram:

CLK

3 2

CP (1K —>C P

D Flip flop T Flip flop

3. Theory:

1.
2.

© oo N

10.
11.
12.

IC 7476 is a Dual JK flip flop.

By connecting D input to J input and inverting of D input to K input of JK flip flop,
we get D flip flop operation.

By connecting T input to both J and K inputs of JK flip flop, we get T flip flop
operation.

The D flip-flop is widely used. It is also known as a "data’ or ""delay"* flip-flop.
The D flip-flop captures the value of the D-input at a definite portion of the clock
cycle (such as the rising edge of the clock). That captured value becomes the Q
output. At other times, the output Q does not change.

The D flip-flop can be viewed as a memory cell.

Most D-type flip-flops in ICs have the capability to be forced to the set or reset state.
These flip-flops are very useful, as they form the basis for shift registers.

If the T input is high, the T flip-flop changes state (*'toggles'") whenever the clock
input is strobed.

If the T input is low, the flip-flop holds the previous value.

When T is held high, the toggle flip-flop divides the clock frequency by two.

This "divide by" feature has application in various types of digital counters.
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4. Procedure:
Make the connections as shown in circuit diagram.

Feed the logic signal from the logic input switches.
Observe the logic outputs on the logic level LED indicators.
Observe the output for all possible input combinations.
Verify the corresponding truth table.

ok e

5. Observations:

S.No Clock input Switch condition LED 1 Status LED 2 Status
(For D input) (For Q Output) (For- o Output)
1 0 X Q e
2 ™ OFF Doesn’t Glow Glow
3 ™ ON Glow Doesn’t Glow

Interpretation of above Observations in terms of logic values.

S.No Clock input D Q )
input Output Output
1 0 X Q .Q
2 T 0 0 1
3 T 1 1 0
S.No Clock input Switch condition LED 1 Status LED 2 Status
(For T input) (For Q Output) (For- o) Output)
1 0 X No change No change
2 T OFF No change No change
3 ™ ON Toggles Toggles
Interpretation of above Observations in terms of logic values.
S.No Clock input T Q s
input Output Output
1 0 X Q 9
2 D 0 Q o
3 D 1 o Q
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4.9 EXPERIMENTAL METHADOLOGY 4.9 RIPPLE COUNTER USING JK FLIPFLOP

RIPPLE COUNTER USING JK FLIPFLOP
1. Description:

A. This experiment requires IC trainer kit, and counter IC.
B. IC numberis 7476.

C. Learnthe pin description of integrated circuit.

D. itis used to count the 16 values(Oto 15).

2. Pin diagram of 7476 IC:

cLock1 ] 1e 140 N
RESET1 [ 2 13 [0 at
Kil 3 12 1 a1
Vee [ 4 11 [1 GND
cLockz2 [l s 10 [ K2
RESET2 [] 6 9] Q2
g2l 7 sl Qz
3. LOGIC DIAGRAM and WAVEFORMS:
Sy

®)
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Theory:

A counter is a sequential circuit that counts in a cyclic sequence. It is essentially a register that

goes through a predetermined sequence of states upon the application of input pulses. There are two

types of counters — Synchronous Counter & Asynchronous Counter.

Synchronous Counter:

In a synchronous counter, the input pulses are applied to all clock pulse inputs of all flip  flops

simultaneously (directly). Synchronous counter is also known as parallel sequential circuit.

Asynchronous Counter:

In an asynchronous counter, the flip flop output transition serves as a source for triggering other flip
flops. In other words, the clock pulse inputs of all flip flops, except the first, are triggered not by the
incoming pulses, but rather by the transition that occurs in previous_flip flop’s output.Asynchronous

counter is also known as serial sequential circuit.

Procedure :

1. Connections are made as per the logic circuit.

2. Connect V and GND (ground) pins of ICs at +5V and ground points of IC Trainer Kit respectively.
3. Connect clock input (CLK) to clock pulse on the IC trainer kit.

4. Connect the outputs Qg, Q;, Q2,Q3 . to output LEDs.

5. Switch ON the power supply.

6. Apply logic 1 to JK inputs of four flipflops.

8. Apply clock pulse one by one and observe the outputs.

9. Hence, verify the truth table.

10. Obtain the wave forms.
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Truth table:
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4.10 EXPERIMENT METHODOLOGY 4.10 DECADE COUNTER

DECADE COUNTER
1. Description:
Name Specifications No Purpose
Digital IC trainer kit Power supply 230V 50Hz 1 To verify the function of 7490
as decade and modulus
counter
IC 7490 Supply voltage 5V 1 To verify the function of 7490
as decade and modulus
counter
Connecting wires As per need To make connections
2. Circuit diagram:
Vec=pin 5 Qa ? Qh: 1'312
GMD = piﬂ 10 @ i@ ‘ i{jj}
ClKs (D T
J a J — J Qe J Q[ L K Q-
m CLK CLK CLK CLK
CLK,
K K K —I HJ T
i | | I
S% @ Reszet
S S; @7
Ry R
7490 Decade Counter:

BCD Coded O utput

A B C

+5y *
|i 1 2] 9] BI
| ClKs Q. Qp Qg
LA

v — wlclk, /4L590 Qs
] T .

o
L

Ry R GND 5y 3
2 3| 10 gl 7
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7490 Divide-by-2 Counter:

:_I-'-EU |_fINI2 |
1 1
aly 741590 J_|—F, L
. Q _ JIN
_?]NT"‘ CLK, 2 E Out = -5
Clks Ry Rz GND 5 5
1 2] 3 10 6l 7
74LS90 Divide-by-5 Counter:
+5Y .
E‘W I- Tmed -|
[ 4 cycles 1
M 741590 — L
fm — CLEs o ETE Out = %

ClKa Rt Rz GND 51 52
14| 21 31 10 g 7

3. Theory::

The 74LS90 integrated circuit is basically a MOD-10 decade counter that produces a BCD output code.
The 74LS90 consists of four master-slave JK flip-flops internally connected to provide a MOD-2 (count-
to-2) counter and a MOD-5 (count-to-5) counter. The 74LS90 has one independent toggle JK flip-flop
driven by the CLK A input and three toggle JK flip-flops that form an asynchronous counter driven by
the CLK B input as shown.

74LS90 counter consists of a divide-by-2 counter and a divide-by-5 counter within the same package.
Then we can use either counter to produce a divide-by-2 frequency counter only, a divide-by-5
frequency counter only or the two together to produce our desired divide-by-10 BCD counter.

With the four flip-flops making up the divide-by-5 counter section disabled, if a clock signal is applied to
input pin 14 (CLKA) and the output taken from pin 12 (QA), we can produce a standard divide-by-2
binary counter for use in frequency dividing circuits as shown.

To produce a standard divide-by-5 counter, we can disable the first flip-flop above, and apply the clock

input signal directly to pin 1 (CLKB) with the output signal being taken from pin 11 (QD) as shown.
4. Procedure:

1. Place the IC 7490 on the breadboard.

2. Connect V.. and GND (ground) pins of ICs to +5V and ground points of IC Trainer Kit respectively.

3. Connect the clock input (CLK) to clock pulse on the IC trainer kit.
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4. Connect the outputs Qa Qg Qc Qp to output LEDs.

5. Switch on the power supply.

6. When connected to logic 1, the Reset inputs R1 and R2 reset the counter back to zero, 0 (0000).

7. When the Set inputs S1 and S2 are connected to logic 1, they Set the counter to maximum or 9 (1001)
regardless of the actual count number or position.

8. Count operation starts when atleast one of the reset inputs and atleast one of the set inputs is

connected to logic 0

9. A single stage BCD counter such as the 74LS90 counts from decimal 0 to decimal 9 and is therefore

capable of counting up to a maximum of nine pulses

9. Verify the truth table for all the states of a decade counter.

5. Observations

Count Truthtable:

Inputs Outputs
Ry R2 S Sz Qo Qc Qs Qa
H H L X L L L L
H H X L L L L L
X X H H H L L H
X L X L COUNT
L X L X COUNT
L X X L COUNT
X L L X COUNT
Count sequence:
COUNT Qp Qc Qs Qa
0 0 0 0 0
1 0 0 0 1
2 0 0 1 0
3 0 0 1 1
4 0 1 0 0
5 0 1 0 1
6 0 1 1 0
7 0 1 1 1
8 1 0 0 0
9 1 0 0 1
10 0 0 0 0
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6. Timing Diagrams

1 2 3 4 5 6 7 8 9% 10 11 12 13 14 15 16

u?} 1 r 1 1 1 1 1 1 (sb)
| I | B
| | | | | |
QB | | i 1
|
ac | 1
|
|
QD ! 1 msh)
| Reset Pulse
CLR|
I

0000 0001 OG0 001 0100 0401 0110 @111 1000 1001 | 0000 0001 OO 001 0100 G4 0110
Count O 1 2 I 4 ] & 7 8 9 1] 1 2 3 4 5 6
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4.11 EXPERIMENTAL METHODOLOGY
UP/DOWN COUNTER

1. Description

UP/DOWN COUNTER

NAME

Specifications/Range

No Purpose

Digital IC trainer

Equipped with Breadboard,

1 To conduct

kit Logic Level Inputs, LEDs for experiment on it
output indication, built-
in fixed 5V DC power supply
and clock sections
IC 74193 5V DC Supply 1 4 bit binary up/down
counter
Patch chords As per | To make connections
needed
Connecting Wires As per | To make connections
needed
2. Circuit Diagram:
v g o 3

U

ar- g
le;LD

3. Pin Diagram &Pin Description:

C

[

e

—
€61vL

16| Ve
15| Dy
14| MR
13| TCD
12| TCU
11 |PL
10| D9
gD,

Figure: Pin Diagram of IC 74193

SBTET-AP




d)

a)
b)
c)
d)

Pin Description:

Pin Symbol Description
1 D4 data input
2 Q4 counter output
3 Qg counter output
4 CPD count down clock input {low-to-high, edge-triggered)
5 CPU count up clock input {low-to-high, edge-triggered)
6 o)) counter output
7 Qs counter output
8 GND ground
9 D4 data input
10 D5 data input
11 PL parallel load input (active low)
12 TCU terminal count up (carry) output (active low)
13 TCD terminal count down (borrow) output (active low)
14 MR asynchronous master reset (active high)
15 Dy data input
16 Ve supply voltage

Theory:

A counter is a circuit consisting of a number of Flip Flop and gates working together to
count the number of clock pulses applied to its input.

Such counters are used in digital clocks, frequency counters, digital voltmeters, digital
computers, and numerous other applications. The basic binary counter is probably the
simplest to construct and form the basis for more advanced types of counters.

The 74193 is a synchronous up-down 4-bit binary counter. It has a master reset (MR),
and it can be reset to any desired count with the parallel load inputs. Basically, it
functions like any binary counter, except that is has two clock inputs, one for UP
counting, and the other for DOWN counting.

Placing the clock on UP will cause the counter to count UP, and placing the clock on
DOWN will cause the counter to count DOWN. Note that the clock should be connected
to either UP or DOWN, but not both and the unused inputs should be held HIGH.

Procedure:

Locate IC 74193 on the trainer board.

Make connections as in the circuit diagram.

Take MR input to logic-1 and return it to Logic-0, this clears the counter.

Select appropriate mode (UP or DOWN) by connecting clock pulse to the corresponding
pin.

Apply individual pulses and observe the change of states of a counter.

Take the readings.
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6. Observations

Count-UP Mode:

Qo

Q1

Q2

Clock | Q3

pulse

10
11
12
13
14
15

Count-Down mode:

SBTET-AP

Qo

Q1

Q2

Clock | Q3

pulse

10
11
12
13
14
15




4.12 EXPERIMENTAL METHODOLOGY 4.12 SHIFT REGISTER

SHIFT REGISTER
4.18.1. DESCRIPTION:

The setup for this experiment requires the following equipment

Name Specifications/ Range No Purpose

Shift Register IC 7495 1 For shift operation

Minimum of 10 logic
To connect input and output to IC

Digital trainer kit inputs and 3 logic 1
outputs
Patch cards Different colors 15

To connect input and output to IC

4.18.2. CIRCUIT DIAGRAM:

PIN DIAGRAM of 1C 7495:

OoOuUTPUTS CLOCK 2

CLOCK 1 L-SHIFT
Voo L= s Qc Qp R-SHIFT (LOAD)

|14 13 12 11 1w |e |s
Qa Qg ©Qc GCp v i

CK1 CcK2

SERIAL INPUT

A B C D  MODE
| }
1 2 a 4 S 6 I 7
SERIAL A B c D MODE GND
INPUT CONTROL
INPUTS

4.18.3. THEORY:

Shift registers are a type of sequential logic circuit, mainly for storage of digital data. The 7495 IC

is a 4-Bit Shift Register with serial and parallel synchronous operating modes. The serial shift right and

parallel load are activated by separate clock inputs which are selected by a mode control input. The data

is transferred from the serial or parallel inputs to the Q outputs synchronous with the HIGH to LOW

transition of the appropriate clock input.

The Serial In Serial Out (SISO) shift register accepts data serially —that is, one bit at a timeon a

single line. It produces the stored information on its output also in serial form.
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The Serial In Parallel Out (SIPO) shift register accepts data serially — that is, one bit at atime on a
single line. It produces the stored information on its output in parallel form.

The Parallel In Serial Out (PISO) shift register accepts data in parallel. It produces the stored
information on its output also in serial form.

The Parallel In Parallel Out (PIPO) shift register accepts data in parallel. It produces the stored
information on its output in parallel form.

4.18.4. PROCEDURE:

4.18.4.1 Serial In Serial Out (SISO):

Senal 1 1
%
) Sl e ] Clock | Serial p | QA [QB [Qc| oD
o5 A ac _
i - gt [ 1 do=0 0 X | x
oz ¢C 2 di=1 1o | x| x
S0 7405 "
Clock /P 9 s el L 0 X
g JCLK 1 4 a3=1 | 1|11 |o=a
Ne o—E bk wvee Hdwee s =
Mode(lu!):s T 5 X X | 1|1 |1=di
| 6 X X | x| 1 |1=d2
5 7 X X | X | X |1=d3
Circuit diagram: Truth Table:

1. Connections are made as per circuit diagram.

2. Keep the mode control in logic 0

3. Load the shift register with 4 bits of data one by one serially.

4. At the end of 4th clock pulse the first data ‘d0’ appears at QD.

5. Apply another clock pulse; the second data ‘d1’ appears at QD and so on.
6. Thus the data applied serially at the input comes out serially at QD

4.18.4.2 Serial In Parallel Out (SIPO):

Sedl oldsol oAl
a8
ok a ac H Clock | Serial #/p | QA | QB [ QC | QD
sl Qo
ot ¢ 1 o |o|x]|x]x
0 7405 2 ! 1 [o|x|x
Clock I/P 2
O—2bCLKI 0
N o—Edcie  wvee Hdwvee ? 1 Sk .
i 2 4 ! 11 [1]o0
Mode (v ®—| MODE Gnol
Circuit diagram ' Truth Table
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1. Connections are made as per circuit diagram.
2. Keep the mode control in logic 0
3. Apply the data at serial input.
4. Apply one clock pulse at clock 1 observe this data at QA.
5. Apply the next data at serial input.
6. Apply one clock pulse at clock 2, observe that the data on QA will shift to QB and the
new data applied will appear at QA.
7. Repeat steps 2 and 3 till all the 4 bits data appear at the output of shift register.

4.18.4.3 Parallel In

Serial Out (PISO):

NC

Parallel
I¥P Data

s avw

o

NC O——2—
Clock I/P

.

sOl oA H
0B [
A ac g
B an 5
C
O 7405
b CLK
oLk wvee Hbvee
MODE GND

B
hMode (M)

Circuit diagram:

i

1. Connections are made as per circuit diagram.

2. Apply the desired 4 bit data at A, B, Cand D.

3. Keeping the mode control M=1 apply one clock pulse. The data applied at
A, B, Cand D will appear at QA, QB, QC and QD respectively.

4. Now mode control M=0. Apply clock pulses one by one and observe the
Data coming out serially at QD

4.18.4.4 Parallel In Parallel Out (PIPO):

Circuit diagram:

NColdsm  oald
2 0B I
Parallel o3 A Qc
o Qo
VP Data g c
D 7405
NC O—3—bCLKI
Clock 1P PCLKZ AVEC
6 |

|||——-'~'

Mode | Clock | Parallel i/p Parallel o/p
AIB|IC|D|QA|QB|QC|QD
1 1 110111 1 0 1 1
0 2 XIX|X[X] X 1 0 1
0 3 XIX[X|X| X | X 1 0
0 4 XIX[X|X| X | X | X 1
Truth Table
Truth Table
Clock | Parallel i/p Parallel o/p
AIB|C|D|QA|QB|QC|QD
1 11011 |1] 1 0 1 1

L 1dvee
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1. Connections are made as per circuit diagram.

2. Apply the 4 bit data at A, B, Cand D.

3. Apply one clock pulse at Clock 2 (Note: Mode control M=1).

4. The 4 bit data at A, B, C and D appears at QA, QB, QC and QD respectively.

4.18.5. OBSERVATIONS:

1. Shift registers hold the data in their memory which is moved or “shifted” to their
required positions on each clock pulse.

2. Each clock pulse shifts the contents of the register one bit position to either the left
or the right.

3. The data bits can be loaded one bit at a time in a series input (SI) configuration or be
loaded simultaneously in a parallel configuration (PI).

4. Data may be removed from the register one bit at a time for a series output (SO) or
removed all at the same time from a parallel output (PO).

5. One application of shift registers is in the conversion of data between serial and
parallel, or parallel to serial.

6. Shift registers are identified individually as SIPO, SISO, PISO, PIPO, or as a Universal
Shift Register with all the functions combined within a single device.
4.18.6 PRECAUSTIONS

e The circuit should be off before change the connections.

e While making connections main voltage should be kept switched off.

e After completing the experiment switch off the supply to apparatus.
e Digital lab kits should be handled with utmost care.
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4.13(a) METHODOLOGY SIMULATION OF AND, OR, NOT & EX-OR GATES USING NAND GATES

SIMULATION OF AND,OR ,NOT and | Experimental methodology

EXOR GATES USING NAND GATES

SIMULATION OF AND, OR, NOT and EXOR GATES USING NAND GATES USING PSPICE

Description:

8.

(0]

C

. This experiment requires personal computer with Windows OS and ORCAD PSPICE 9.2 software

package.

. ORCAD PSPICE is Analog and Digital circuit simulation software

. PSPICE contains both analog and digital circuit component library
. The required components for an analog/digital circuit can be picked from the library
. The circuit can be built by wiring the selected components, analog or digital sources
Circuit simulation can be done by applying required inputs. Then, the resulting outputs can be
observed
. AND, OR & NOT gates are basic gates with one or two inputs and one output. Can construct these
gates by using universal gates (NAND&NOR).
EX-OR gate produces an output as lat its inputs is odd, otherwise output is 0.t has two inputs and
ne output.
ircuit diagram:

B

AND

A—4 _})—A’

NOT (inverter)
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' =A+8HB

B'—r Br
OR
A—o 2 (A(AB)")'
B—= ((AB)'B)'
X-OR
Theory:

1. NAND gate is usually a combination of two logic gates. AND gate followed by NOT gate.
2. It’s output is complement of the output of an AND gate.
3. can construct any gates using NAND and NOR gates.
4. so these gates are called as universal gates.
5. Demorgan’s Theorem: (AB)'=A"+B’
(A+B)'=A".B’
Procedure:

Switch ON the Computer, which is installed with ORCAD Pspice 9.2

2. After logging into the computer, go to the Start Menu and go to: Start Menu->All Programs-

>0RCAD_Pspice9.2->Capture
3. Once Capture is up, start a new project going to File->New->Project...

The project dialogue box should appears. From the dialog box
-Select “Analog or Mixed A/D” for your project type.

-Give Name to the Project: AND gate
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-Change the LOCATION of the saved project to required folder.

10.

11.
12.

13.

14.

15.
16.

17.

18.

After selecting “OK” to the above dialog box the box below comes up. Make sure you select “Create
a blank project” before clicking OK.
You should be seeing a blank grid. On the right hand side of the grid, there are a lot of buttons. To

place a certain part, select the button shaped like this: 3’
After selecting the “Add Library...” button, Add the following libraries:

sourcstm.olb
eval.olb

Select the Eval library. This will have all of the logic gates you need. Select the “7400” part

After selecting “OK” in the above dialog box, you return to the schematic grid. When you left click
your mouse, you now place the NAND part twice. To return to a normal cursor right-click the mouse
and select “End mode”.

Just as you added the 7400 (NAND) part as shown in the circuit diagram for AND gate.

Now we must select and label one port for the output of NAND gate, Name it as Y. To add a port

select the button on the right that looks like this EI.

Select the port called “PORTLEFT-L” and place it and name them as Y.

To rename the port, double-click the name “PORTLEFT-L” to get a dialog box as shown below.
Change the name to “Y”.

To add inputs, select the “place part” button on the right hand side as you did when you added the
NAND part. When you get the place part dialog box, make sure the SOURCESTM library is selected.
Select the “DigStim1” part.

This part will serve as your input. Therefore, place two of them as shown below:

Rename the inputs to be A, B.

Now we want to make sure that our sources will cover all possible input values. Since there are two
inputs, that means we have 272 = 4 input combinations. We can ensure that we cover all
combinations of inputs. First select the part A go to Edit->PSpice Stimulus and apply time period as
4s and ON time as 2s.

Repeat the above step for Part B, apply time period as 8s and ON time as 4s, apply time period as 16s
and ON time as 8s.
Now wire the circuit as per the circuit diagram shown in the description
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19. You are now ready to simulate the circuit. To do this select PSpice -> New Simulation Profile
20. Apply simulation run time as 16s and ADD traces of A, B, Y then the following output is obtained
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OR realization using NAND circuit
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Realization of EXOR using NAND gates

SBTET-AP




(B Bread Coplle e

E] File Edit View Place Macro Popice Accessones Opbons Window Help

ofel@| &) o |mle] of o FormeT 7 RIS A) e A B |
[ = e B e e s e v
T T T T T T 5 T e
A Il I-u |
- 3
Y i
A 1
3
R 1S Tl
\_'.’"/ U‘w i -'_:-1
i
|

|
i
k|

o (o] Lo |

Lo

10 fterns sebected Scale=100% =

{58 SCHEMATICL vor gate - Pipice AVD e fen-or qate SCHEMIATIC 7or ot (ecive | N e e

B Fie Edie Wiew Simulation Irace Plat Tasks Window Hein B8 =18 ®|
B @E M3 [SCHEMATIC wor gt || »
REWMG Ml S|k o+

AiOUT
BamUT
v

F= I ]

[

Readng and checking circul i
ot nand chesked, ra s

Cak:ulafing bins peint fon Transierk Aachei
Bias pairy calouated

Timnviznt dnalyss

Tizruiant &naksis frished

Sinudatian compks

End= 18

Time= 16 100% WENNNNNNNN

Result:

The output waveforms obtained in the Pspice simulation is exactly following the truth table of basic
gates and EX-OR gate. Hence the logic gates and EX-OR circuit is simulated in Pspice and observed the

circuit behavior.
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4.13(b) EXPERIMENTAL METHODOLOGY SIMULATION OF AND, OR, NOT and EXOR USING NOR GATE

SIMULATION OF AND, OR, NOT and EXOR USING NOR GATE

1. Description

The setup for this experiment requires the following Equipment

Name Specifications No Purpose
PC with Windows OS 1 Toinsert IC
ORCAD Pspice 9.2 DIP 14 PIN Quad 2-input IC 1 To realize basic gates

software package

2. Circuit Diagram

Realization of NOT, AND, OR using NOR Gates

NOT Gate

AND Gate

OR Gate

TWO INPUT ¥NOR GATE LISING NOR GATE

A

(& +B)'

(A+BY

=l
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3. Theory

NOR Gate is called Universal Gate because we can realize any basic gates using NOR Gate.

To realize NOT Gate using NOR Gate both the inputs has been shorted since NOT Gate has only one
input. When binary high signal i.e.1 is given at the input, binary low i.e.0 is the output and vice-versa.

To realize OR Gate using NOR Gate, NOR Gate is connected to NOT Gate.

To realize AND Gate using NOR Gate, the inputs are complemented using 2 NOR gates and their
outputs are given as inputs to the other NOR gate.

4. Procedure

1.
2.

3.

Switch ON the Computer, which is installed with ORCAD Pspice 9.2

After logging into the computer, go to the Start Menu and go to: Start Menu->All Programs-
>ORCAD_Pspice9.2->Capture

Once Capture is up, starts a new project going to File->New->Project...

The project dialogue box should appears from the dialog box

-Select “Analog or Mixed A/D” for your project type.

-Give Name to the Project: Basic gates using NOR

-Change the LOCATION of the saved project to required folder.

4.

9.

After selecting “OK” to the above dialog box make sure you select “Create a blank project”
before clicking OK.
You should be seeing a blank grid. On the right hand side of the grid, there are a lot of

buttons. To place a certain part, select the button shaped like this: E_I
After selecting the “Add Library...” button, Add the following libraries:

sourcstm.olb
eval.olb

Select the EVAL library. This will have all of the logic gates you need. Select the “7402”
part for NOR gate
After selecting “OK” in the above dialog box, you return to the schematic grid. When you
left click your mouse, you now place the NOR part for required number of times. For
example to realize OR gate using NOR, place NOR gate twice. To return to a normal cursor
right-click the mouse and select “End mode”.

Now we must select and label output port for the output of OR gate Y. To add a port select

the button on the right that looks like this E].

10. Select the port called “PORTLEFT-L” and place it and name as Y.
11. To rename the port, double-click the name “PORTLEFT-L” to get a dialog box as shown

below. Change the name to “Y™.
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12. To add inputs, select the “place part” button on the right hand side as you did when you
added the NOR part. When you get the place part dialog box, make sure the SOURCESTM
library is selected. Select the “DigStim1” part.

13. This part will serve as your input. Therefore, place two of them

14. Rename the inputs to be A, B

15. Now we want to make sure that our sources will cover all possible input values. Since there
are two inputs, that means we have 2°2= 4 input combinations. We can ensure that we
cover all combinations of inputs. First select the part A go to Edit->PSpice Stimulus and
apply time period as 4s and ON time as 2

16. Repeat the above step for Part B, apply time period as 8s and ON time as 4s, then finally
select part C, apply time period as 16s and ON time as 8s.

Biclal &) b lele <] F e e BT E G R S
- = el 2] siwlas v ]y
. .

=

lemantation = A
s 31 _AnA

>
8|7 alalls ] e H ]

imglemantation = B

[ e S 5

18. You are now ready to simulate the circuit. To do this select PSpice -> New Simulation
Profile

19. Apply simulation run time as 16s and ADD traces of A,B,Y then the following output is
obtained
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20. Repeat the same steps to realize NOT, AND and EXOR gates as per the corresponding
circuit diagrams

5. Truth Tables

OR GATE
INPUTS OUTPUT
A B Y
0 0 0
0 1 1
1 0 1
1 1 1
AND GATE
INPUTS OUTPUT
A B Y
0 0 0
0 1 0
1 0 1
1 1 1
NOT GATE
INPUT OUTPUT
A Y=A
0 1
1 0
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6. Result:

The output waveforms obtained in the Pspice simulation is exactly following the truth tables of NOT,

AND, OR and EXOR gates using NOR gate. Hence the gates are simulated in Pspice and observed the

circuit behavior.
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4.14(a) EXPERIMENTAL MEHODOLOGY

HALF ADDER SIMULATION USING PSPICE

‘ SIMULATION OF HALF ADDER

Experimental methodology

Description:

SIMULATION OF HALF ADDER USING PSPICE

1. This experiment requires personal computer with Windows OS and ORCAD Pspice 9.2 software

package.

2. ORCAD Pspice is Analog and Digital circuit simulation software.

3. Pspice contains both analog and digital circuit component library.

4. The required components for an analog/digital circuit can be picked from the library.

5. The circuit can be built by wiring the selected components, analog or digital sources .

6. Circuit simulation can be done by applying required inputs. Then, the resulting outputs can be

observed.

7. Half adder is a combinational circuit with two binary inputs (A & B) and two

binary outputs.

Circuit diagram:

Half adder :
A *
B
Theory:

1. A half adder can add two bits at a time.

2. It’s outputs are SUM and CARRY.

3. For two bit addition- SUM will be 1, if only one input is 1(EX-OR operation).

4. CARRY will be one, when both inputs are 1 (AND operation).

5. So, by using one AND gate and one X-OR gate, a half adder circuit can be constructed.

SUM = AB' + A'B

CARRY = AB
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Procedure:

1. Switch ON the Computer, which is installed with ORCAD Pspice 9.2

2. After logging into the computer, go to the Start Menu and go to: Start Menu->All Programs-

>ORCAD_Pspice9.2->Capture
3. Once Capture is up, start a new project going to File->New->Project...

G
i[Fie] View Edt
o Mew . Breject..

Open L] Design

[T] e CieS T
WHOL Fiie

Ted Fie

Prink., Cirlp

Import Deagn..,

Espan Deign,

1 pliopj

2 racll. e

3 radll - SCHEMATICE- rad
4 noid.op

Esit

Sesaon Log

The project dialogue box should appear as below.
-Select “Analog or Mixed A/D” for your project type.
-Give Name to the Project: Half_Adder

-Change the LOCATION of the saved project to required folder.

( New Project MW
Mame LI
Half_Adder Cancel
| [(Bed |

-~ Create a Mew Project Using Help |

i
;-E%@ (+ Analog or Miked A0
Tip for New Users

E (" PC Board Wizard Create a new Analog or
Mixed A/D project. The
new project may be blank

| L . -
y\;b " Programmable Logiz Wizard or copied from an existing
- ]

template.
" Schematic

Location

C:\Program FileghOrcadLite Browse... I
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4. After selecting “OK” to the above dialog box the box below comes up. Make sure you select

“Create a blank project” before clicking OK.

-

Create PSpice Project

" Create based upan an existing project

Ih'ialarch'ical.npi

+ Createa blank project

5. You should be seeing a blank grid. On the right hand side of the grid, there are a lot of

buttons. To place a certain part, select the button shaped like this: ﬁl

E File: Edit View Place Macro PSpice Accessories Options Window Help
Dl 8 &= ] 2z o] BR[| Q@ vt
I =1 el (2] 2leslLlo [V ] 1 [ wls]|
| 5 I < I z I

| A

0 items selected [Scale=100% X=6.50 Y=4.70 &

6. When you select the “place tool” button as above, you should get the following dialogue

box as shown below. Select the “Add Library...” button.
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Place Part . } x|

Part:

Pait List:

Cancel

Ui

Libraries:

Design Cache

- Graphic

& tdoral
£ Convert

Type:

- Packaging-
Parts per Pka: 1

Farty I v I

£ Add ibram...

..... SNt S

RBemove Library -

Part Search...

Filter...

Helpr

il

7. After selecting the “Add Library...” button, you should get a selection list that looks like
the one below. Add the following libraries:
sourcstm.olb
eval.olb
r Browse File ﬂ1
Look in: i |, PSpice ;l - e B~
Mame Date modified Type
8| abm 10/4/1999 7:12 PM OrCAD Captur
E, analog 4/21,/2000 2:25 PM OrCAD Captur
B analog_p 4/21/2000 2:25 PM - OrCAD Captur
B breakout 4/21/2000 2:25 PM OrCAD Captur
E| eval 12/11/15998 5:50 PM OrCAD Captur
E, source 5/8/2000 12:40 PM OrCAD Captur
|8 sourcstm 10/4/1999 7:20 PM OrCAD Captur
B special 5/3/2000 3:02 PM OrCAD Captur
| I | 3
File name: | Open
Fles oftype:  [Capture Library("clb) =l S
[™ Open as read-only

8. Select the Eval library.
part as shown below

This will have all of the logic gates you need. Select the “7486”
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Part:
|?4BE

Part List:
7473 - Add Library...
7474 ;
7475 Remowe Library
7476 -
477 Fart Search...
7482 i
74834 -
7485

i
__|_7_4qn,a_\, —C:\PRDGRAM FILES\ORCADLITENC
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ARM
ANALOG
AMal0G_P
BREAKOUT

U 1
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LINEDRIVERRECEIVER .
MECHANICAL Fart [ -]

MICROCONTROLLER TR o e
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Cancel

kL

U?A

i » |

9. After selecting “OK” in the above dialog box, you return to the schematic grid. When you
left click your mouse, you now place the XOR part. To return to a normal cursor right-click

t}le mouse and select “End mode”.

& ' ion - [/ - P,

T

Dield) 5| 3l=le) 2lo] Fwe =] Blas)a] vl

' o] al=lr ] 2leelLlef [V o] 1w
1 3 T 3

H

[l

l|elolOf«| 2 |%]4 o]0 ]|~ + ||| ] 2

uza L=
g fie | \_4 End Mode
3 ) _// | Mimror Horizontally

438

Mirrar Vertically
Rotate
Edit Properties...

Azcend Hierarchy

ZoomIn
Zoom Out = i
Go Tow
N
B
[« | i
[0 items selected Scale=100%6  X=2.40 Y=050 A
= ——————— ——

10. Just as you added the 7486 (XOR) part, add an 7408 (AND) part and place as shown below.
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@ File Edit View Place Macro PSpice Accessories Options Window Help
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[ =1 ale=lr (2] pleel £l [V ] 1| wls |

3 T i I 3 |

A%

=
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[ 1

7483 J..

A

o ]
2 | oz
[ ]

|9 34

[ | _’1;]

1 item selected [Scale=100%  X=0 ¥=0 o

11. Now we must select and label two ports for the outputs of half adder, SUM and CARRY. To
add a port select the button on the right that looks like this EI.

12. Select the port called “PORTLEFT-L” and place as shown below:
( Place Hierarchical Port ﬂ1

Symbol:
|FORTLEFT-L

Cancel

FORTEOTH-L/CAPSTH -
PORTHOTH A/CAPEY Bl Library.
PORTLEFT-L/CAPS M |l

FORTLEFT-R/CAPSYM B IPoRmErTL W e L
PORTNO-L/CAPSYM  +

Help

il

EH... E n Cache Name

iF'DF!TLEFT-L

13. To rename the port, double-click the name “PORTLEFT-L” to get a dialog box as shown
below. Change the name to “SUM”.
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Mame: Mame:

Walue: JSUM| Change... ] ze Default]

Dlizplay Format-
: - Colar

Dot ]

-~ Rotation

I|Le |

14. To rename the port, double-click the name “PORTLEFT-L” to get a dialog box as shown
below. Change the name to “SUM”.

15. Repeat steps 10 to 13 to add a port for CARRY

16. To add inputs, select the “place part” button on the right hand side as you did when you
added the XOR and AND part. When you get the place part dialog box, make sure the
SOURCESTM library is selected. Select the “DigStim1” part.

x|
|D|gSt|m1
‘ Cancel I
Part List:
T T
DigStim16
DX e R
DigStim32
DigStim4 Part Search... I
DigStima
ISTIM i I
LA Filter....
Help |
Libraries: ~ Graphic
Design Cache {* Normal
DIG_PRIM i
e
_PaCkaging mpkmertgton =
Parts per Pka: 1 P
Fart: I 'l
Type: Homogeneous g
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17. This part will serve as your input. Therefore, place four of them as shown below:

oL e e o e - = - 1 Pt S LT —
| I I = 5 et O I
DSTMI U = I~
§ E E eS| 1 = iy i
DsTM2  Implementation =2 - (5. sumM o
B 1
T486 5
| Implementation = i
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18. Rename the inputs to be A, B as you did in step 14

[ Orcad Capture - -
E File Edit View Place Macro Accessories Options Window Help

o|slal &| &[@E o)

EEIE

| =l w=l=r 2] £
‘ Mew Eolumn...l Apply l Display...! [ielete F'roperty! Filker buy: |< Current properties » :_! Help !
| Implementation | Impler ion Path | Impler ion Type | [IOMODEL | Name | Part Reference| PCB Footprint| Power Pins Vizible
1 SCHEMATICA : PAGE1 : DSTM1 . PSpice Stimulus. 05T . 100137 A r

19. Now we want to make sure that our sources will cover all possible input values. Since
there are two inputs, that means we have 2”2 = 4 input combinations. We can ensure that
we cover all combinations of inputs as follows. First select the part A as shown below
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20.  While the part is still selected go to Edit->PSpice Stimulus

You should get a box as seen below. Make sure you name the stimulus whatever the part is named (in

this case A). Make the input a “Clock” and click “OK”".

Name: IM

x|

—&nalog
" EXP [esponential]

" PULSE

' PWwL [piecewise linear)
" SEFM (single-frequency FM]
" SIN (sinusoidal)

~ Digital

" Bus 'w‘idth:l

Initial Yalue: |

Z

[ ok | cancel |
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21. Upon clicking OK, you get a dialog box as shown below. Select “Specify by Period and on
time”. For this input, you should make the period 2*4 = 16 s and the on time half of the
period (8 s) as shown below. Click “OK”.

Close out of the “Stimulus Editor”.

Save the changes and click “Yes” when asked if you want to update the schematic
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22. Similarly Configure the input B with period :16 and ON time: 8

23. Now we need to wire the circuit together. To do this select the “wire” button on the right

hand side that looks like this: il

24. When you left click, your mouse lays down wire. Notice that when you connect two parts,
both ends of the wire are a bright red dot. Wire the circuit as shown below. Right Click and

select “End Wire” to return your mouse to a normal cursor.
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25. You are now ready to simulate the circuit. To do this select PSpice -> New Simulation

Profile
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26. You will get a dialog box as seen below. Give your simulation profile a name, inherit from

“None” and click “Create”
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27. You should then get a dialog box as seen below. If you have set up your inputs correctly
above, the only thing you need to do is change the “Run to time:” of the simulation to the

largest period you se1t up \(\En this example — 16s).

| v W ) i

-
Simulation Settings - HAL . ﬁ
General  Analysis ]Indude Flles] Liblariesi Stimulus ] Options] Data Collection ] Frobe Wlndnw!
Analysis type:
|Time TR 1T|an5ierrt}_:_j Fiur o binne: 164 zeconds [TSTOR]
Ot Stark zaving data after: ]EI zeconds

 Selfings — Tranzsient options -

[IMante Carloorst Casze M awirum step size: zeconds
[_|Parametric Sweep i L ) . . )
[Tempersture (Sweep) [ Skip the initial transient bias point calculation [SEIPBP]

[15ave Bias Point

[ILoad Bias Poirt Dutput File Options. ..

28. Click OK on the above dialog box. You should now be ready to run your simulation. Do so

by clicking the I_’- button.

29. After the simulation has completed you should get an empty black box as shown below. We

want to look at our inputs compared to our output. To do so, we select “Trace->Add

Trace...”
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30. The “Add Trace...” dialog box is seen below. We can only add one trace at a time. For
now, select “A:OUT” and click “OK”.

Simulation Output ¥ ariables Functions or Macroz
# Digital Operators and Constants LI
B:OUT .
CARRY I Mg *
NOD412 Y Digial ;
NOo447 [ 7%
SUM &
[HRFES B |
[NRFiN:] "
U1y i it
Li2a:8, 0
Lz2aB [T Naisa v ‘0
L2ay q
®_U2a.8 BUF = A F
%1128 B BUF v Aliaz Names b
®_2aC = i bt
ORTEG W Subcircuit Modes >
1E wariables listed

Full List

TraceExplession:" QK. | Cancel| Help |

SBTET-AP




31. Repeat steps 28 and 29 in the following order: B:OUT SUM ,CARRY

After doing so, your graph should look like below. If it does, you have completed the Half adder exercise

successfully. Now observe the results and tally with the truth table

LS U B | of

Truth tables:

Half adder:
Input Output
A B Sum Carry
0 0 0 0
0 1 1 0
1 0 1 0
1 1 0 1
Result:

The waveforms obtained in the Pspice simulation is exactly following the truth table of Half adder.

Hence the half adder circuit is simulated in Pspice and observed the circuit behavior.



4.14(b) EXPERIMENTAL METHODOLOGY FULL ADDER SIMULATION USING PSPICE

SIMULATION OF FULL ADDER Experimental methodology

SIMULATION OF FULL ADDER USING PSPICE

Description:

1. This experiment requires personal computer with Windows OS and ORCAD Pspice 9.2 software
package.

2. ORCAD Pspice is an Analog/Digital circuit simulation software

3. Pspice contains both analog and digital circuit component library

4. The required components for an analog/digital circuit can be picked from the library
5. The circuit can be built by wiring the selected components, analog or digital sources

6. Circuit simulation can be done by applying required inputs. Then, the resulting outputs can be
observed

7. Full adder is a combinational circuit with three binary inputs (A, B &C) and two

binary outputs.

Circuit diagram: Truth table of Full adder:
Full adder :
Input Output
A X\ A B Cin Sum Carry
0 0 0 0 0
B S
0 0 1 ! 0
Cin 0 1 0 1 0
il 0 1 1 0 1
bl 1 0 0 1 0
Cout [ 1 0 1 0 1
1 1 0 0 1
1 1 1 1 1




Theory:

=

w

A full adder can add three bits at a time.

A full adder is a combinational circuit that forms the arithmetic sum of input; it consists of
three inputs and two outputs.

A full adder is useful to add three bits at a time but a half adder cannot do so.

In full adder sum output will be taken from X-OR Gate, carry output will be taken from OR
Gate.

Procedure:

1.
2.

3.

Switch ON the Computer, which is installed with ORCAD Pspice 9.2

After logging into the computer, go to the Start Menu and go to: Start Menu->All Programs-
>ORCAD_Pspice9.2->Capture

Once Capture is up, start a new project going to File->New->Project...

The project dialogue box should appears. From the dialog box

-Select “Analog or Mixed A/D” for your project type.

-Give Name to the Project: Full_Adder

-Change the LOCATION of the saved project to required folder.

4.

5.

After selecting “OK” to the above dialog box the box below comes up. Make sure you select
“Create a blank project” before clicking OK.
You should be seeing a blank grid. On the right hand side of the grid, there are a lot of

buttons. To place a certain part, select the button shaped like this: E]

6. After selecting the “Add Library...” button, Add the following libraries:

9.

sourcstm.olb
eval.olb

Select the Eval library. This will have all of the logic gates you need. Select the “7486” part
After selecting “OK” in the above dialog box, you return to the schematic grid. When you
left click your mouse, you now place the XOR part twice. To return to a normal cursor right-
click the mouse and select “End mode”.

Just as you added the 7486 (XOR) part, add two 7408 (AND) parts and one OR gate part.

10. Now we must select and label two ports for the outputs of half adder, SUM and CARRY. To

add a port select the button on the right that looks like this EI.



11. Select the port called “PORTLEFT-L” and place twice and name them as SUM and
CARRY repectively.

12. To rename the port, double-click the name “PORTLEFT-L” to get a dialog box as shown
below. Change the name to “SUM”.

13. To add inputs, select the “place part” button on the right hand side as you did when you
added the XOR and AND part. When you get the place part dialog box, make sure the
SOURCESTM library is selected. Select the “DigStim1” part.

14. This part will serve as your input. Therefore, place three of them as shown below:

15. Rename the inputsto be A, B and C

16. Now we want to make sure that our sources will cover all possible input values. Since there
are two inputs, that means we have 273 = 8 input combinations. We can ensure that we
cover all combinations of inputs as follows. First select the part A go to Edit->PSpice
Stimulus and apply time period as 4s and ON time as 2,

17. Repeat the above step for Part B, apply time period as 8s and ON time as 4s, then finally
select part C, apply time period as 16s and ON time as 8s.

18. Now wire the circuit as per the full adder circuit diagram shown in the description
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19. You are now ready to simulate the circuit. To do this select PSpice -> New Simulation
Profile

20. Apply simulation run time as 16s and ADD traces of A.B,C,SUM,CARRY, then the
following output is obtained
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Result:

The output waveforms obtained in the Pspice simulation is exactly following the truth table of Full

adder. Hence the Full adder circuit is simulated in Pspice and observed the circuit behavior.




4.15 EXPERIMENTAL METHODOLOGY

Description:

SIMULATION OF MULTIPLEXER

SIMULATION OF MULTIPLEXER USING PSPICE

1. This experiment requires personal computer with Windows OS and ORCAD Pspice 9.2 software

package.

2. ORCAD Pspice is Analod and Digital circuit simulation software

3. Pspice contains both analog and digital circuit component library

4. The required components for an analog/digital circuit can be picked from the library

5. The circuit can be built by wiring the selected components, analog or digital sources

6. Circuit simulation can be done by applying required inputs. Then, the resulting outputs can be

observed

7. Digital Multiplexer is a combinational circuit with 2" inputs (data lines), n Selection lines and one

output.

Circuit diagram:
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Theory:

1. The multiplexer, shortened to “MUX” or “MPX”, is a combinational logic circuit
designed to switch one of several input lines through to a single common output line
by the application of a control signal.

2. Multiplexers are also known as data selectors because they can “select” each input
data line.

3. The selection of each input line in a multiplexer is controlled by an additional set of
inputs called Select lines.

4. A multiplexer has an even number of 2" data input lines where n is number of
“select” inputs

Procedure:

1. Switch ON the Computer, which is installed with ORCAD Pspice 9.2
2. After logging into the computer, go to the Start Menu and go to: Start Menu->All Programs-
>ORCAD_Pspice9.2->Capture
3. Once Capture is up, start a new project going to File->New->Project...
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The project dialogue box should appear as below.
-Select “Analog or Mixed A/D” for your project type.
-Give Name to the Project: Multiplexer

-Change the LOCATION of the saved project to required folder.



o |

C:\Program Files\OrcadLite

4. After selecting “OK” to the above dialog box the box below comes up. Make sure you select
“Create a blank project” before clicking OK.

oo |

5. You should be seeing a blank grid. On the right hand side of }@ grid, there are a lot of
buttons. To place a certain part, select the button shaped like this: g
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6. When you select the “place tool” button as above, you should get the following dialogue box
as shown below. Select the “Add Library...” button.

Place Part i3 1 x|

Pat:

Part List:

Cancel
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Remove Library

Part Search...
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Filter....

Help

;

Libraries: - Graphic
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£ Convert

~ Packaging-
Parts per Pka: 1

Party l v. I

Type:




7. After selecting the “Add Library...” button, you should get a selection list that looks like
the one below. Add the following libraries:

sourcstm.olb

eval.olb
Browse File M
Look in: l |, PSpice LI = I::F -
Mame ’ Date modified Type
B abm 10/4/1899 712 PM OrCAD Captur
8| analog 472172000 2:25 PM OrCAD Captur
|®| analog_p 4/21/2000 2:25 PM OrCAD Captur
® breakout 4/21/2000 225 PM  OrCAD Captur
.E. eval 12/11/1998 5:50 PM OrCAD Captur
.!. SOUrCE 5/8/200012:40 PM OrCAD Captur
|8 sourcstm 10/4/1999 7:20 PM OrCAD Captur
.!. special 5/3/2000 3:02 PM CrCAD Captur
< m | 3
File name: I Open
Flles of type:  |Capture Library(".olb) -] Cancel
I™ Open as read-orly

8. Select the Eval library. This will have all of the logic gates you need. Select the “74153” part
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9. After selecting “OK” in the above dialog box, you return to the schematic grid. When you
left click your mouse, you now place the 1C74153 part. To return to a normal cursor right-
click the mouse and select “End mode”.

10. Now we must select and label two ports for the outputs of Multiplexer, Za and Zg. To add a
port select the button on the right that looks like this 2.

11. Select the port called “PORTLEFT-L” and place as shown below:
( Place Hierarchical Port lﬁ1

1 Symbol: 0k
4| |PORTLEFT-L

Cancel

FORTEOTH-L/CAPSYM »
PORTBOTHA/CAPS Th
PORTLEFT.L/CARSYM i

FORTLEFT-R/CAPSTM W lPoRTLEFTL W e L
FORTNOL/CAPSYM  ~

Aidd Library. ..

el

Help

Libraries;

Mame:

]PDHTLEFT-L

12. To rename the port, double-click the name “PORTLEFT-L” to get a dialog box as shown
below. Change the name to “Za”.

13. Repeat steps 11 to 13 to add a port for Zg

14. To add inputs, select the “place part” button on the right hand side as you did when you
added the IC 74153 part. When you get the place part dialog box, make sure the
SOURCESTM library is selected. Select the “DigStim1” part).(

X
=
IDlgStim1

Cancel I
e e
DigStim16
DigStim2 RBemove Library |
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i
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15. This part will serve as your input. Therefore, place 12 of them(Four A channel inputs , Four
B Channel inputs, Enable input for A channel, enable input for B channel and Selection
lines S; and So).

16. Rename the data lines to be I13A, 12A, I11A, 10A, And I13B, 12B, 11B, 10B and selection
inputs as S1,S0 and enable inputs as EA and EB.

ﬁ Oread Capture - lite
bl File Edit View Place
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1| m SCHEMATICY : PAGET : DSTM1 PSpice Stimulus 05T 100137 A r

17. Now we want to make sure that our sources will cover all possible input values. Since there are
two inputs(Selection lines), that means we have 272 = 4 combinations. We can ensure that we
cover all combinations of inputs as follows. First select the part 1A3

18.  While the part is still selected go to Edit->PSpice Stimulus
You should get a box. Make sure you name the stimulus whatever the part is named (in this case 1A3).
Make the input a “Clock” and click “OK”.
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" EXP [exponential]

" PULSE

' PwL [piecewise linear)
" SEFM (single-frequency FM]
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19. Upon clicking OK, you get a dialog box as shown below. Select “Specify by Period and on
time”. For this input, you should make the period 2”4 = 16 s and the on time half of the
period (8 s) as shown below. Click “OK”.

Close out of the “Stimulus Editor”.

Save the changes and click “Yes” when asked if you want to update the schematic
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20. Similarly Configure the 1A2,1A1,1A0 with period :16 and ON time: 8

21. Configure S1 with period :4 and ON time: 2

22. Configure So with period :2 and ON time: 1

23. You are now ready to simulate the circuit. To do this select PSpice -> New Simulation Profile

24. You will get a dialog box as seen below. Give your simulation profile a name Multiplexer,

inherit from “None” and click “Create”
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25. You should then get a dialog box as seen below. If you have set up your inputs correctly
above, the only thing you need to do is change the “Run to time:” of the simulation to the

largest period you se1t up\(\in this example — 16s).

| rvr WY ) i
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Simulation Settings - HAL . ﬁ
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Analysis type:
Riur b time: 164 zeconds [TSTOF]

Start zaving data after; ]EI zeconds
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[ 1Parametric Sweep
[ Temperature {Sweep)
["15ave Bias Poirt

[ClLoad Bias Foint Output File Options...

26. Click OK on the above dialog box. You should now be ready to run your simulation. Do so
by clicking the ’T button.

27. After the simulation has completed you should get an empty black box as shown below. We
want to look at our inputs compared to our output. To do so, we select “Trace->Add

Trace...”
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28. The “Add Trace...” dialog box is seen below. We can only add one trace at a time. For
now, select “S1:0UT” and click “OK”.
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29. Repeat steps 26 and 27 in the following order: So:0UT, Za

After doing so, your graph should look like below. If it does, you have completed the Multiplexer
exercise successfully. Now observe the results and tally with the truth table
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Truth tables:

4:1 Multiplexer :

Enable Data Input Lines Selfection Output
Lines
EA loa [N [ (% S, S, Z,
1 X X X X X X 0
0 0 X X X 0 0 0
0 1 X X X 0 0 1
0 X 0 X X 0 1 0
0 X 1 X X 0 1 1
0 X X 0 X 1 0 0
0 X X 1 X 1 0 1
0 X X X 0 1 1 0
0 X X X 1 1 1 1

Result:

The waveforms obtained in the Pspice simulation is exactly following the truth table of Multiplexer.

Hence the Multiplexer circuit is simulated in Pspice and observed the circuit behavior.



UNIT TEST -l
Model Question Paper (C-20)
EC-308, Digital Electronics Lab

TIME: 3 hours Total Marks: 60M

Instructions: (1) any one full question of the following shall be allotted to the students on lottery

1(a)

(b)

(c)

2 (a)

basis.
(2) All the questions are competency based and are for assessing the candidate’s
psychomotor skills

(3) Underpinning Knowledge shall be assessed through Viva-Voice for 6 Marks.

Identify the IC numbers of all Logic gates, logic input section, Logic output
section, clock section, power supply section and breadboard sections of universal
digital trainer Kit

Identify the equivalent gate for AND-invert Gate and OR-invert Gate.

In a given IC how many NOT gates present.

When one input of AND gate is connected to 1 and another input is connected to

the clock, state the output?
(9M)  (cO1)

Make the circuit connection to realize the function of AND gate and OR gate in
logic trainer Kit.
Make circuit connection to realize the function of NAND gate and NOR gate in

logic trainer Kit.
(15M) (CO1)

Make the circuit connection for NAND, NOR and EX-OR gates using basic gates
on logic trainer kit and verify their truth tables.

(30M)  (CO1)

Identify the IC numbers of all Logic gates, logic input section, Logic output
section, clock section, power supply section and breadboard sections of universal
digital trainer Kit.

Show the output of NAND gate, when only one input is given to the both the
inputs of NAND gate.

Make the circuit connection for NOT gate using NOR Gate.
(9M)  (cO1)



(b)

(c)

3(a)

(b)

(c)

4 (a)

(b)

(c)

5(a)

Making connections for universal gates on logic trainer Kits.
(15M) (CO1)

Make the circuit connection for EX-OR Gate using NOR & NAND on logic
trainer Kits and verify its truth tables
Make the circuit connection for NOR & NAND on logic trainer kits and verify its

truth tables
(30M)  (co1)

Identify the IC numbers of Logic gates required to design HA and FA on
logic trainer Kit.
Identify the logic input section, Logic output section, clock section, power

supply section and breadboard sections on logic trainer Kit.
(OM)  (CO2)

Make circuit connection for half adder using NAND gates.

Make circuit connection for half adder using NOR gates.
(15M)  (CO2)

Make the connection of full adder circuit with two half adder and one OR gate
on logic trainer kit and verify its truth table.

Is it possible to design Full adder circuit with alternative 1Cs? Justify?
(30M)  (CO2)

] Identify the major sections in trainer board and record the IC Nos

1. Mention number of outputs in 4 bit magnitude comparator.
(OM)  (CO2)

Make connections of 4-bit magnitude comparator using IC 7485

Give the truth table of 4-bit magnitude comparator
(15M)  (CO2)

Make the connection of 4-bit magnitude comparator using logic gates on logic

trainer Kkits and verify its truth table.
(30M)  (CO2)

Identify multiplexer section in the trainer board.

Mention the IC numbers of 4x1 and 8x1 multiplexers.
(OM)  (CO2)



(b)

1. Make the connections of 4x1 multiplexer using IC 74153.
1. if selection line pins (S1 and So) are connected in opposite direction, what
happens justify?

(15M) (CO2)
(c)

1. Make the connection of 4x1 multiplexer circuit and Verify the truth table.

1. What happens at the output (Zg) if we give data lines to A channel and enable
pin low in 1C74153.

(30M)  (CO2)

6 (a)
1. Identify BCD to Seven segment decoder sections in the trainer board
. Mention the ic number of BCD to Seven segment decoder.
(OM)  (CO2)
(b)
I.  Make connection of BCD to seven segment decoder using IC 7448.
1. Write the truth table of BCD to seven segment decoder,
(15M)  (CO2)
(c)
1. Verify the output by replacing 7448 with another IC.
I.Conduct the necessary exercise and state which diodes in seven
segment display are ON, when display 7 is shown as output?
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(30M)  (CO2)
7(a)

I.  Identify the major sections in a digital trainer Kit
I1.  Identify the pin no. of enable inputs in the IC 74148
I1l1.  Identify various pins in IC 74138



(b)

(c)
l.

(M)

Make the connections of encoder using 1C 74148
Make the connections of decoder using 1C 74138
Verify the truth tables of encoder
Verify the truth tables of decoder

(15M)

Given a readily made circuit to verify truth table of IC 74138 Decoder.
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Design a 3 to 8 Decoder, by change IC 74138 to IC 741567
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UNIT TEST -l
Model Question Paper (C-20)
EC-308, Digital Electronics Lab
TIME: 3 hours Total Marks: 60M

Instructions: (1) any one full question of the following shall be allotted to the students on lottery
basis.

(2) All the questions are competency based and are for assessing the candidate’s
psychomotor skills

(3) Underpinning Knowledge shall be assessed through Viva-Voice for 6 Marks.

1(a)
I Identify SR, JK, T and D flip flop sections on the Digital trainer Kit
1. Identify clear, preset and clock sections on the Digital trainer Kit
(9M)  (CO3)
(b)
1. Draw the pin configuration of 1C 7400.
. Make connections of SR flip-flop as per the circuit diagram
m.  Make connections of JK flip-flop as per the circuit diagram
Iv.  What is the purpose of dual JK flip flop IC 7476
(15M)  (CO3)
(c)
I.  Perform an exercise to find out the output for SR clocked flip flop
when the values S=0 and R=1, are given.
. Perform an exercise to find out the output for SR clocked flip flop
with negative edgetriggered clock of 1 H; is given to the circuit.
m.  Make the connection for JK flip-flop using SR Flip flop and
verify its truth table
Iv.  Make the connection for T flip-flop using JK Flip flop and verify
its truth table
(30M)  (CO3)
2 (a)
I.  ldentifying decade, up/down and ripple counters sections in the trainer Kit.
I1.  Identify the IC number used for ripple counter?
9M) (CO3)
(b)

I.  Make the circuit connection of 4-bit ripple counter with negative edge clock
pulse.

Il.  Why do we use reset or clear signal when you get output state 1010 in
designing BCD ripple counter?



(c)

3(a)

(b)

(c)

4 (a)

(b)

(c)

5(a)

(b)

(15M) (CO3)

Connect the logic circuit for 4-bit ripple counter and get the output 1110 by

applying pulse input.

Connect the logic circuit for decade counter by using 7476 1C and AND GATE.
(30M)  (CO3)

I.  Identifying different counter sections in the trainer Kit.
I.  Identify the IC number used for decade counter.

[1l.  Identify the pin numbers for clock, Vcc, reset of IC 7490.

(9M)  (CO3)

I.  Make the circuit connection for decade counter using IC 7490.
(15M) (CO3)

I.  Construct mod-5 counter using IC 7490 and verify the number of output stage.
I.  Construct mod-9 counter using IC 7490 and verify the number of output stage.

1. Verify the functioning of IC 7490 as decade counter.

(30M)  (CO3)

I.  ldentify different counter sections in the trainer board.
I.  Mention the IC number used for UP/DOWN counter.
9M) (CO3)

I. Identify the pin numbers of UP/DOWN, ripple and enable signals of IC 7419.
I. Make the connections of UP/DOWN counter as per the circuit diagram.
(15M) (CO3)

Verify the counting process in 4-bit UP/DOWN counter for UP & DOWN
counting.
Make the circuit connection of modulus-13 down counter and obtain the output
waveforms.

(30M)  (CO3)

Identify the pin numbers for mode control inputs, serial data input and parallel
data input in IC 7495.

(OM)  (CO3)

Make the circuit connection for shift left operation using 7495 IC.
(15M) (CO3)



(c)

6(a)

(b)

(c)

7 (a)

(b)

Make the circuit connection to operate in Parallel in Parallel out
(PIPO) mode using I1C 7495 and verify the process.

Make the circuit connection to operate in Serial in Serial out
(PIPO) mode using I1C 7495 and verify the process.

(30M)  (CO3)

Identify Menu Bar and various tabs under it when software is opened.

How do you create a project and save it in appropriate location in PC?

Identify the various symbols which are used to design circuit in PSpice software.
(OM) (CO4)

How can you apply clock signals set Time period & on time for a signal in
PSpice.
How can you perform simulation of the designed circuits using ORCAD Pspice.
How can you customise label names for all the inputs/outputs of logic gates?
How can you edit the logic diagram when it is required in Pspice?

(15M)  (CO4)

Simulate AND,OR and NOT Gate using universal gates in Pspice software.
Simulate EX-OR gate using universal gates in Pspice software.
(30M) (CO4)

Identify Menu Bar and various tabs under it when software is opened.
How to give ground and Vcc connection for circuit in Pspice.
Identify different files created and saved when we use pspice software for an
application.
(OM) (CO4)

Generate logic diagram for half adder using NAND gates on blank grid in Pspice.
Generate logic diagram for half adder using NOR gates on blank grid in Pspice.
(15M) (CO4)

Simulate half adder circuit using Pspice and show the input/output timing
diagram.
Simulate Full adder circuit using Pspice and show the input/output timing
diagram.

(30M)  (CO4)



8(a)

(b)

Show how to create an input files in Pspice.
Identify different tool bars in Pspice.
When should we use PSpice professional VVersion?
9M) (CO4)

Generate logic diagram for 8x1 multiplexer using 4x1 multiplexer in Pspice.
Generate logic diagram for 8x1 multiplexer using 2x 1 multiplexer in Pspice.

(15M)  (CO4)

Simulate 8x1 Multiplexter circuit using Pspice and show the input/output timing
diagram.
(30M)  (CO4)



Model Question Paper (C-20)
End Exam
EC-308, Digital Electronics Lab
TIME: 3 hours Total Marks: 60M

Instructions: (1) any one full question of the following shall be allotted to the students on lottery
basis.
(2) All the questions are competency based and are for assessing the candidate’s
psychomotor skills
(3) Underpinning Knowledge shall be assessed through Viva-Voice for 6 Marks.

1. A) Identify logic input section, Logic output section, clock section, power supply
section and  breadboard sections of universal digital trainer

(OM)  (COY)
B) Using the Universal trainer, make circuit connections to realize the function of
AND gate using NOR gates

(15M)  (CO1)
C) Simulate Half Adder circuit using Pspice and show the input/output timing
diagrams
(30M)  (CO4)
2. A) Draw the symbols of two input AND, OR, NOT, NAND, NOR gates and Identify
the corresponding TTL digital ICs used in the lab
(OM)  (COY)
B) Connect four bit magnitude comparator and verify its functionality (15M)  (CO2)

C) Given the full adder circuit connected on the Universal trainer, apply various
input combinations and note down the outputs. Then verify the truth table of full

adder
(30M)  (CO2)

3. A) Draw the Circuit diagram of RS Flip flop using NAND gates. How can you

convert it into JK flip flop
(OM)  (CO3)

B) Connect the circuit of Decade counter using IC 7490 and verify its working on logic
outputs (15M)  (CO3)

C) Given the mod-16 counter (ripple) connected on the universal trainer, demonstrate
the conversion of the counter into mod-10 counter

(30M)  (CO3)
4. A) Verify the truth tables of two input AND, OR, NOT gates

(OM)  (CO1)
B) Realize the functionality of EX-OR gate using only NAND gates (15M)  (co1)
C) With the given JK flip flop circuit, construct D-Flip flop and T-Flip flop and
verify their truth tables

(30M)  (CO3)

5. A) Draw the circuit symbols of level triggered JK Flip flop, Positive edge triggered
JK flip flop and negative edge triggered JK flip flop

(9M)  (CO3)
B) Realize the functionality of EX-OR gate using basic gates (15M)  (co1)
C) Simulate full adder circuit using Pspice

(30M)  (CO4)



6.

7.

8.

A) Demonstrate the steps to place NAND gate onto work space in PSpice (OMm)
(CO4)

B) Construct BCD to seven segment decoder circuits using 7448 IC (15M)  (CcOo2)

C) From the given 4-bit magnitude comparator circuit readily connected, verify its

function
(30M)  (CO2)

A) Troubleshoot the half adder circuit if the following truth table is observed (o9m)

(CO2)

A | B | SUM | CARRY
0(0]0 0
011 0
101 0
111 1

B) Demonstrate the steps to apply Pspice stimulus to the NOT gate in PSpice (15M)  (CO4)
C) Construct shift register using IC 7495 and demonstrate the shifting of data when

clock input is applied
(30M)  (CO3)

A) Troubleshoot the JK flipflop circuit if it is working like T-flipflop
(OM)  (CO3)

B) Construct up/down counter using IC 74190 (15sM)  (CO3)

C) Simulate 4-bit magnitude comparator using 1C7485 in Pspice and demonstrate its

functionality
(30M)  (CO4)
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